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1 Introduction to Kerio Operator
Kerio Operator is a VoIP based phone system that provides enterprise-class voice and video communication capabilities
for small and mid-sized businesses globally. Easy to administer and flexible to deploy, as a software appliance, a virtual
machine, a hardware appliance, or a cloud solution.

Kerio Operator brings support for high-quality codecs, such as Opus for voice and H.264 for video.

The automatic provisioning feature brings fast setup for various phone systems, such as Cisco, Grandstream, Polycom and
Snomphones.

Its advanced security technologies keep telephone hackers out, prevent misuse and ensure the privacy of your users and
those they call. Kerio Operator continually monitors for anomalous behavior, detects and prevents break-in attempts and
supports call encryption.

Kerio Operator also includes various call handling features which are used on a daily basis, such as auto attendant scripts,
advanced call forwarding, call pickup, Busy Lamp Field (BLF), and many more.

You can stay in control of all your Kerio Operator appliances through Kerio’s centralized web interface - MyKerio.

This help system includes technical information about how to deploy, use, configure and troubleshoot Kerio Operator.

Futher reading:

Getting started with Kerio Operator

Logging into Kerio Operator Administration

http://www.kerio.com/mykerio
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2Getting started
Want to try out Kerio Operator? This topic provides a quick list of actions to help you set it up.

1 Prepare external connectivity
Kerio Operator requires connectivity with a telecommunications service provider (TSP) or an Internet telephony service
provider (ITSP) to make and receive external calls. Refer to the supported phone cards and tested SIP providers on the Kerio
website.

2 Install Kerio Operator
You can install Kerio Operator as a hardware, software, or virtual appliance. All installation types use a built-in operating system
that you manage through the web administration. Refer to the technical specifications for the requirements of each option. For
more information, refer to Installing Kerio Operator (page 9).

3 Access the Kerio Operator interface
You can administer Kerio Operator directly on the network using a web browser by opening a secure connection to the IP
address or hostname of your server. For more information, refer to Logging into Kerio Operator Administration (page 19).

4 Activate Kerio Operator
When launching the web administration interface for the first time, run through the configuration wizard to activate essential
settings. For more information, refer to Configuration wizard (page 19).

5 Configure Kerio Operator on the network
To communicate on the network, assign network parameters to Kerio Operator from Configuration > Network. Configurable
items include NAT, domain name server address for resolving names, IP address, gateway, and subnet for routing to the Internet
and local networks.

6 Add extensions and user accounts
To manage calls, you need to create extensions and assign them to your users and phones.
Create user accounts and assign extensions to them.

Connect to a telephone service provider
Telephone service using PRI/BRI, POTS, or Euro-ISDN require physical infrastructure and a hardware interface with specific
configuration for each type of service. For more information, refer to Configuring standard phone interfaces (page 271).
Telephone service using a SIP provider requires Internet access. Kerio Operator uses a virtual SIP interface to connect to the SIP
provider. For more information, refer to Connecting to VoIP service providers (page 25).

Deploy user phones
You can manually provision phones through a software interface, or Kerio Operator can automatically provision phones. Click
here for a list of phones supporting automatic provisioning with Kerio Operator. For more information, refer to Configuring
automatic phone provisioning (page 171).
You can also use Kerio Operator Softphone app with mobile device or Kerio Phone for desktop operating systems.
You can also use third-party softphones with Kerio Operator. For more information go to http://go.gfi.com/?pageid=operator_
help#cshid=924

2.1 System requirements for Kerio Operator
You can find detailed and always up-to-date system requirements for Kerio Operator on our website:

Kerio Operator System Requirements

http://www.kerio.com/support/kerio-operator#techspecs
http://www.kerio.com/support/kerio-operator#sip
http://www.kerio.com/support/kerio-operator#techspecs
http://www.kerio.com/support/kerio-operator#techspecs-tab3
http://go.gfi.com/?pageid=operator_help#cshid=1320
http://go.gfi.com/?pageid=operator_help#cshid=1963
http://go.gfi.com/?pageid=operator_help#cshid=924
http://go.gfi.com/?pageid=operator_help#cshid=924
http://www.kerio.com/support/kerio-operator#techspecs
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2.2 Installing Kerio Operator

2.2.1 Product Editions

Edition Description

Software
Appliance

Kerio Operator Software Appliance is an all-in-one package of Kerio Operator which also includes a special operating
system.
Designed to be installed on a computer without an operating system, this edition is distributed as an installation disc.
Software Appliance cannot be installed on a computer with another operating system and it does not allow to install
other applications. For more information, refer to Kerio Operator Software Appliance (page 9).

VMware
Virtual
Appliance

A virtual appliance designed for use in VMware products.
VMware Virtual Appliance is a Software Appliance edition pre-installed on a virtual host for VMware. The virtual
appliance is distributed as OVF and VMX. For more information, refer to Kerio Operator VMware Appliance (page 9).

Kerio
Operator
Box

Hardware device ready for network connection. There are two types which differ in performance. For more inform-
ation, refer to Kerio Operator Box (page 10).

2.2.2 Kerio Operator Software Appliance

For Kerio Operator system requirements, refer to the Kerio Operator product pages.

You obtain Kerio Operator as a standard ISO image which you need to burn on a CD. Boot from this CD and install the
Kerio Operator operating system. The Kerio Operator application is also installed during the process.

How to connect Kerio Operator Software Appliance to network

After booting the system, a console with the IP address for Kerio Operator is displayed.

If you use a DHCP service on your network, Kerio Operator will be assigned an IP address automatically and will connect
to the network. If you do not use or do not wish to use DHCP for Kerio Operator, you have to set the IP address manually.

The current network configuration is displayed (and can be changed) in the Kerio Operator console in section
Network Configuration. To set a static network address:

1. Select the Assign static IP address option in the console menu.

2. In the network interface on which the PBX should communicate, select the Assign static IP address
option and enter the IP address, subnet mask and IP addresses of gateway and DNS server.

If you know the DNS name of the PBX, you can connect to it and configure it viaweb interface.

IMPORTANT

Immediately after you connect Kerio Operator to the network, we recommend to read topic concerning the
securitymeasures. Meeting security principles for Kerio Operator operation is extremely important. If the PBX is not
protected by a firewall and supporting security rules, your internal telephone extension can be misused which may
result in unexpected financial costs.

2.2.3 Kerio Operator VMware Appliance

For supported VMware product versions, check http://www.kerio.com/operator/requirements/

Use an installation package in accordance with the type of your VMware product:

http://www.kerio.com/operator/technical-specifications
http://www.kerio.com/operator/technical-specifications
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For products VMware Server, Workstation, Player and Fusion, download the compressed VMX distribution file
(*.zip), unpack it and open the file with extension .vmx.

You can import a virtual appliance directly to VMware ESX/ESXi from the URL of the OVF file — for example:
http://www.kerio.com/operator/download/vmware-ovf.

VMware ESX/ESXi automatically downloads the OVF configuration file and a corresponding disk image (.vmdk).

If you import virtual appliance in the OVF format, bear the following specifics in mind:

In the imported virtual appliance, time synchronization between the host and the virtual appliance is disabled.
However, Kerio Operator features a proprietary mechanism for synchronization of time with public Internet time servers.
Therefore, it is not necessary to enable synchronization with the host.

Tasks for shutdown or restart of the virtual machine will be set to default values after the import. These values can be
set to hard shutdown or hard reset. However, this may cause a loss of data on the virtual appliance. Kerio Operator
VMware Virtual Appliance supports so called Soft Power Operations which allow to shut down or restart hosted oper-
ating system properly. Therefore, it is recommended to set shutdown or restart of the hosted operating system as the
value.

Formore information, refer to How to connect Kerio Operator Software Appliance to network (page 9).

2.2.4 Kerio Operator Box

For currently supported Kerio Operator Box configurations, refer to the Kerio Operator product pages.

For detailed information on connecting the device into the network, see the Kerio Operator Box 1000/3000 Series and
Kerio Operator Box V300 installation guides.

How to connect to the hardware box from the network

Upon the first start, the appliance has a static IP address set to10.10.10.1 on ethernet port 1. There are twoways to
change the configuration:

In the console — use an Ethernet cable to connect to the console. In the console menu, select the NetworkCon-
figuration option and change the configuration.

In the administration interface in section System. To connect to Kerio Operator, set the following TCP/IP para-
meters on your computer:

a. IP address:10.10.10.2

b. Subnet mask:255.255.255.0

To shut down the appliance:

1. Connect to Kerio Operator via the console and select the Shutdown command.

2. Kerio Operator series 1000 will shut down. Kerio Operator series 3000 will stop the server, however, the physical appli-
ance stays switched on. Wait until you are not able to connect to Kerio Operator via Kerio Operator administration and
turn the appliance off using the pwrbutton on the appliance.

2.3 Hardware appliances
This section describes deployment and configuration for hardware appliances.

2.3.1 Kerio Operator Box V300 11

http://www.kerio.com/operator/download/vmware-ovf
http://www.kerio.com/operator/technical-specifications
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2.3.2 Kerio Operator Box 1000/3000 Series 12

2.3.3 Setting Up Kerio Operator Box 1220 and 3230 14

2.3.4 Connecting to Kerio hardware appliances with a serial console 14

2.3.1 Kerio Operator BoxV300

Learn how to safely install and implement Kerio Operator Box V series PBX appliances.

General Safety Instructions

During installation follow these security instructions:

The appliance should be placed on a flat surface.

Do not attempt to open or disassemble the appliance for any reason.

Strictly follow the installation instructions.

Do not place the appliance near a heat source.

Place the appliance in a ventilated space, making sure that the appliance fans and vents are unobstructed at all
times.

Do not expose the appliance to liquids of any kind. In the event of liquid intrusion, unplug the appliance imme-
diately.

Verify that the voltage and frequency of the power socket matches the values printed on the power adapter before
plugging in the appliance. Use only the power adapter supplied with the appliance.

Do not place any items on top of the power cable; keep the power cable away fromwalkways or other areas where it
could pose a tripping hazard.

Appliance Description

Kerio Operator Box V300 is a Sub-1U table mountable appliance.

Feature Description

Serial port Used for connecting to a console with a serial cable

USB ports Input for USB devices

Ethernet network ports Used for connecting to the Internet and the LAN with an Ethernet cable

Kerio Operator Box Installation and Configuration

Once a suitable place has been located for the appliance and it has been plugged into a power outlet according to the
safety instructions, it is time to connect it to the network and configure settings.

1. Connect Ethernet port number 1 to the network using an Ethernet cable.
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NOTE
Alternatively, you can use port number 2 which includes a DHCP client.

2. Turn on the appliance.

3. On the computer youwant to use for the Kerio Operator configuration, set IPaddress to10.10.10.2 and Subnet
mask to255.255.255.0. Setting the default gateway and DNS servers is not necessary for the Kerio Operator con-
figuration.

4. The Kerio Operator PBX is configured through the KerioWeb Administration interface. Open a web browser and con-
nect to the Kerio Control Administration web interface using the https://10.10.10.1/adminURL.

5. Ignore the SSL certificate warning.

6. Follow the instructions provided by the wizard and configure the appliance.

NOTE

For troubleshooting purposes, you can use the serial port to connect the console to the device. Formore
information, refer to Connecting to Kerio hardware appliances with a serial console (page 14).

Additional Information

For further assistance with configuration please refer to additional documentation at:

https://manuals.gfi.com/en/kerio/operator/content/home.htm

For online and community based support resources please visit:

http://www.kerio.com/support

2.3.2 Kerio Operator Box1000/3000Series

Learn how to safely install and implement Kerio Operator Box 1000 and 3000 Series PBX appliances.

General Safety Instructions

During installation follow these security instructions:

The appliance should be placed on a flat surface or securely mounted horizontally in rack enclosure.

Do not attempt to open or disassemble the appliance for any reason.

Strictly follow the installation instructions (see section 4).

Do not place the appliance near a heat source.

Place the appliance in a ventilated space, making sure that the appliance fans and vents are unobstructed at all
times.

Do not expose the appliance to liquids of any kind. In the event of liquid intrusion, unplug the appliance imme-
diately.

Verify that the voltage and frequency of the power socket matches the values printed on the power adapter before
plugging in the appliance. Use only the power adapter supplied with the appliance.

Do not place any items on top of the power cable; keep the power cable away fromwalkways or other areas where it
could pose a tripping hazard.

https://manuals.gfi.com/en/kerio/operator/content/home.htm
http://www.kerio.com/support


KerioOperator 2Getting started |13

Device Description

Kerio Operator Box types:

Kerio Operator 1000 Series — Sub 1U table mountable appliance (see figure 1).

Kerio Operator 3000 Series — 1U rack mountable appliance (see figure 2).

Screenshot 1: Figure 1 Kerio Operator Box 1220

Screenshot 2: Figure 2 Kerio Operator Box 3230

Feature Description

Serial port Used for connecting to a console with a serial cable

USB ports Input for USB devices

Ethernet network ports Used for connecting to the Internet and the LAN with an Ethernet cable

Kerio Operator Box Installation and Configuration

Once a suitable place has been located for the appliance and it has been plugged into a power outlet according to the
safety instructions, it is time to connect it to the network and configure settings.

1. Connect Ethernet port number 1 to the network using an Ethernet cable.

NOTE
Alternatively, you can use port number 2 which includes a DHCP client.

2. Power the device with the power switch. For 3000 series, the power switch is located in the rear of the device.

3. On the computer youwant to use for the Kerio Operator configuration, set IPaddress to10.10.10.2 and Subnet
mask to255.255.255.0. Setting the default gateway and DNS servers is not necessary for the Kerio Operator con-
figuration.

4. The Kerio Operator PBX is configured through the KerioWeb Administration interface. Open a web browser and con-
nect to the Kerio Control Administration web interface using the https://10.10.10.1/adminURL.

5. Ignore the SSL certificate warning.

6. Follow the instructions provided by the wizard and configure the appliance.
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NOTE
Alternatively, you can use the serial port to connect the console to the device. After the server starts, you can get
information about the actual network configuration or you can use the console to restart or turn off the appliance.
Set your terminal application in the following mode: 9600, 8, N, 1.

Additional Information

For further assistance with configuration please refer to additional documentation at:

https://manuals.gfi.com/en/kerio/operator/content/home.htm

For online and community based support resources please visit:

http://www.kerio.com/support

2.3.3 Setting Up Kerio Operator Box1220 and 3230

There are two Kerio Operator Box models available:

Kerio OperatorBox1220 - A small desktop appliance featuring six Gigabit Ethernet ports.

Kerio OperatorBox3230 - A 1U rack-mount appliance featuring eight Gigabit Ethernet ports.

WARNING
Kerio Operator Box 3230 is intended primarily for server rooms due to noisy performance.

Formore information, refer to Kerio Operator Box 1000/3000 Series (page 12).

2.3.4 Connecting to Kerio hardware applianceswith a serial console

Connecting to the Kerio Control hardware appliance through a serial console can help you in the following cases:

Broken network access to the hardware appliance due to configuration mistakes or network hardware issues (both
from the box and network switch sides)

Direct access to the Linux shell

You need to see the boot sequence from the hardware appliance

Access to BIOS

Setting a communication through a serial console

The connection uses these settings:

Speed: 9600

Data bits: 8

Stop bit: 1

Parity: none

Flow control: none

Accessing BIOS

The connection uses these settings:

https://manuals.gfi.com/en/kerio/operator/content/home.htm
http://www.kerio.com/support
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Speed: 115200

Data bits: 8

Stop bit: 1

Parity: none

Flow control: none

Use the instructions for your operating system to create these settings:

Windows

To connect to the hardware appliance, you need a special application such as PuTTY or RealTerm. Here are the steps for
RealTerm:

1. Install RealTerm on your computer.

2. Attach the serial cable to the hardware appliance and to your PC.

3. Run RealTerm.

4. On the Display tab, selectANSI.

5. Click the Port tab and make the following selections there:

Baud: 9600

Parity: None

Data Bits: 8

Stop Bits: 1

Hardware Flow Control: None

6. Click Change.

Before logging on to your hardware device, click Clear.
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Now, you can log in to your hardware device as root. Use the admin password for verification.

Linux

To connect to the hardware appliance, you need a special terminal software such as minicom. Here are the steps for
minicom:

1. Install the minicom application.

2. Type the following command at the shell prompt:$minicom -s

3. In the menu, select Serial port setup.
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4. Type A.

5. In the A section, type the interface: TTYS0. If you use an USB-to-serial adapter, selectUSB instead.

6. Press Enter.

7. Type E.

8. In the E section, type CQ.C: 9600 baud, Q: 8 bits, parity: none, stop bit: 1.

9. Press Enter.

10. Type F and set it toNo.

11. Press Enter to save the configuration.



KerioOperator 2Getting started |18

12. Return to the main menu.

13. Select Exit.

Now, you can log in to your hardware device as root. Use the admin password for verification.

OS X

To connect to the hardware appliance, you need:

USB to Serial adapter with the FTDI chipset directly supported by OS X.

Special terminal software such as CoolTerm.

Here are the steps for CoolTerm:

1. Put the serial cable to the hardware appliance and also to your Mac with the USB to Serial adapter.

2. Open CoolTerm.

3. In the Serial Port section, select the USB adapter as port.

4. Baudrate: 9600.

5. Data Bits: 8.

6. Parity: none.
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7. Stop Bits: 1.

8. Flow Control: no selection.

9. Click Connect.

Now you can log in to your hardware device as root. Use the admin password for verification.

2.4 Logging into Kerio Operator Administration
We recommend to use the supported browsers to connect to Kerio Operator Administration. For the list of the browsers,
refer to the Kerio Operator product pages.

Kerio Operator Administration is currently localized into several languages. Select yours in the top right corner of the
interface. The default language is set according to your browser language settings.

2.4.1How to login

Before you login for the first time, make sure you have:

DNS name of the server with Kerio Operator.

Supported browser

To login, enter the DNS name of the computer with Kerio Operator:kerio.operator.name/admin

Administration runs solely via the HTTPS protocol on port 4021. The address is automatically redirected to:
https://kerio.operator.name:4021/admin

NOTE
If the PBX is located behind firewall, HTTPS on port 4021 must be enabled.

If the URL is entered correctly, your browser displays a warning about a SSL certificate. After the installation, Kerio
Operator creates a certificate which is not signed by a trusted certificate authority — it is a self-signed certificate (for
more information, read topic about the SSL certificates). Since you know the certificate can be trusted, you can add the
security exception and continue to a login page.

Configuration wizard

When you connect to the PBX for the first time, a configuration wizard to do the necessary configuration. Here are those
settings:

1. Set the configuration wizard language.

2. Accept the Kerio Operator license agreement.

3. Set a password for the administration account (be sure to remember the password, you will need it to login to the
PBX).

NOTE
This admin password is synchronized with password of user root in the operating systemwhere Kerio Operator is
installed (Kerio OS).

4. Set the time zone of Kerio Operator (requires a restart of the PBX).

5. Set the PBX language for communication with you and other users (warnings, auto attendant scripts, voicemail, etc.).

http://www.kerio.com/operator/technical-specifications
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6. Configure the first extension number. If you use phone provisioning, extensions will be created automatically begin-
ning with the number you enter here.

After successful configuration, the login page is displayed. Enter the username and password you created earlier.

To change the password, use the following steps:

1. Login to Kerio Operator using the HTTPS protocol (e.g.https://operator.company.com/admin)

2. Open the Configuration > Users section.

3. In the user list, select the administrator account you are logged in with and double-click on it.

4. Change the password on tab General.

2.5 Licenses and registrations
You can register the product from the welcome page of the administration interface which is displayed after each login.

WARNING
If Kerio Operator is protected by a firewall, it is necessary to allow outgoing HTTPS traffic for Kerio Operator at port
443. Unless HTTPS traffic is allowed, Kerio Operator cannot use the port to connect to the Kerio Technologies
registration server.

When installed, the product can be registered as trial or as a full version.

2.5.1Why should you register the trial version?

The trial version is intended to allow the customer to become familiar with the product's features and configuration.
Once you register the trial version, you will be provided free Kerio Technologies technical support during the entire trial
period (up to 30 days).
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The trial version can be registered by clicking Becomea registered trial user from the Dashboard (see the screenshot
above). In the dialog box that appears, set the following parameters:

1. Enter security code (CAPTCHA) from the image.

2. Enter information about your company and agree with the privacy policy terms.

3. Choose how many computers do you have in your company and how you learned of Kerio Operator.

Now, a special identification code called Trial ID gets generated. This ID is later required for contacting the technical
support. After a successful registration, Trial ID can be found in the license information in the administration interface.

NOTE
Once you purchase the product, your Trial ID will become your license number (it will not change).

2.5.2 Registering full version

If your trial version is registered, the license key (licence.key file) is automatically imported to your product within
24 hours from your purchase. The Trial ID you entered in your product upon registration will be activated as a standard
license number.

If you haven’t registered your trial version:

1. Open the administration interface.

2. Click Registerproduct with a purchased license numberon Dashboard.

3. In the first step of the registration, enter the license number and enter the security code from the image.

NOTE
The code is not case-sensitive.

4. Click Next tomake Kerio Operator establish a connection to the registration server and check validity of the number
entered. If the number is invalid, the registration cannot be completed.

5. Type the registration information about the company the product is registered to.

6. Kerio Operator connects to the registration server, checks whether the data inserted is correct and downloads auto-
matically the license key (digital certificate).

7. Click Finish to close the wizard.
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Manual import the license key

If you need to import a license key manually (for example from a backup), use the following steps:

1. Prepare the license key.

2. Log in to Kerio Operator administration.

3. Click Install license on Dashboard.

4. In the Install License dialog, click Browse.

5. In the Open dialog, find the file .key with the license key and click Open.

6. In the Install License dialog, click OK.

7. Check the result in the License tile on Dashboard.

Kerio Operator installs the licence key.

2.5.3 Registering via a web browser

You can also register Kerio Operator via web browser.

1. Go to https://secure.kerio.com/reg/

2. Register using your purchased license number.

3. By registering, you will receive a license key which must be imported to Kerio Operator.

NOTE
The trial version of Kerio Operator cannot be registered via the website.

2.5.4How do I apply renewals or add-ons tomy Kerio product?

When you purchase renewals or add-ons for a Kerio Product, License changes are applied automatically by the product
within 24 hours.

You can also force an immediate update from the administration dashboard using the update registration info" link in
the LicenseDetails tile.

2.6 Upgrading Kerio Operator
Choose your current Kerio Operator version for notes and instructions on how to upgrade to the latest version while
retaining all settings:

Kerio Operator 1.2.0 and newer

Kerio Operator 1.1.3 and older

2.6.1Manually uploading a binary image file

This procedure might be useful for the following situations:

downgrade of Kerio Operator

upgrade to a custom version (e.g. beta version)

If you have an upgrade image file, you can upload it manually:

https://secure.kerio.com/reg
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1. In the administration interface, go to section AdvancedOptions> tabUpdate Checker.

2. Click the Uploadbinary image button.

3. Select the upgrade image file (kerio-Operator-upgrade.img).

4. Click the Open button. Wait for uploading the file.

5. Click the Upgrade button. Wait for the upgrade and restart of Kerio Operator.

When the restart is finished, your Kerio Operator is up-to-date.

2.6.2Upgrading from versions 1.2.0 and newer

Learn how to upgrade Kerio Operator to the latest version while retaining all settings.

Important notes when upgrading

An active and valid Software Maintenance is required to upgrade to new versions of Kerio Operator and its com-
ponents as soon as they are available.

Backup the Kerio Operator configuration before upgrade. Formore information, refer to Saving Kerio Operator
configuration to MyKerio (page 144).

Check that the server meets the latest system and hardware requirements.

Kerio Operator requires restarts during upgrade. Perform the upgrade when there is no traffic on the server or when
it is least impacting on the business operation.

Upgrade procedure

1. From the administration console, go toAdvancedOptions> Update Checker.

2. Select the Periodicallycheckfornew versionsoption, so Kerio Operator checks for new updates every 24 hours.

3. If you want to download new versions automatically, selectDownload new versionsautomatically. If you want to
get also beta versions of the product, select Checkalso forbeta versions.

4. Click Apply.

5. When Kerio Operator finds a new version, click Upgrade to install it. Click Yes to confirm.

6. Kerio Operator then upgrades to the latest version and restarts automatically when done.

2.6.3Upgrading from versions 1.1.3 and older

Learn how to upgrade Kerio Operator to the latest version while retaining all settings.

Important notes when upgrading

An active and valid Software Maintenance is required to upgrade to new versions of Kerio Operator and its com-
ponents as soon as they are available.

Backup the Kerio Operator configuration before upgrade. Formore information, refer to Saving Kerio Operator
configuration to MyKerio (page 144).

Check that the server meets the latest system and hardware requirements.

Kerio Operator requires restarts during upgrade. Perform the upgrade when there is no traffic on the server or when
it is least impacting on the business operation.
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Upgrade procedure

1. Increase the file upload limit so Kerio Operator can be upgraded to a newer version. To do this, from the admin-
istration console, go toAdvancedOptionsand set the maximum value in the Maximumwebserverupload file size
field.

2. Restart Kerio Operator.

3. Download Kerio Operator 1.2.0.

4. Go toAdvancedOptions> Update Checker, click the Uploadbinary image button, select the upgrade image file,
wait until the file is uploaded and click Upgrade.

5. After Kerio Operator is restarted, go toAdvancedOptions>Update Checker, select the Periodicallycheckfornew
versionsoption, and click Apply.

6. After Kerio Operator finds the latest version, click Upgrade, and click Yes to confirm the action. When the upgrade pro-
cess is done, Kerio Operator restarts automatically.

2.7 Provider setup
This section helps you connect to various SIP providers.

2.7.1 Connecting to VoIP service providers 25

2.7.2 Displaying the caller number when transferring and redirecting calls 31

2.7.3 Configuring Kerio Operator with NexVortex 32

2.7.4 Connecting Kerio Operator to CenturyLink 35

2.7.5 Connecting Kerio Operator to Deutsche Telekom 37

2.7.6 Connecting Kerio Operator to Easybell 38

2.7.7 Connecting Kerio Operator to Net2Phone 40

2.7.8 Connecting Kerio Operator to NEXCONetworks 41

2.7.9 Connecting Kerio Operator to QSC 44

2.7.10 Connecting Kerio Operator to Sipgate.co.uk 46

2.7.11 Connecting Kerio Operator to Sipgate Deutschland 47

2.7.12 Connecting Kerio Operator to SIP.US and SIPTRUNK.COM 49

2.7.13 Connecting Kerio Operator to TelePacific 52

2.7.14 Connecting Kerio Operator to Teliax 55

2.7.15 Connecting Kerio Operator to Vitelity 58

2.7.16 How to configure Kerio Operator to connect to 802.cz 62

2.7.17 How to configure Kerio Operator to connect to ActiveNetwork 63

2.7.18 How to configure Kerio Operator to connect to Bandwidth.com 64

2.7.19 How to configure Kerio Operator to connect to Breezz (NL) 66

2.7.20 How to configure Kerio Operator to connect to DevopSys 67

http://download.kerio.com/dwn/operator/operator-1.2.0-4438/kerio-operator-upgrade-1.2.0-4438.img
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2.7.21 How to configure Kerio Operator to connect to Exetel 68

2.7.22 How to configure Kerio Operator to connect to fayn.cz 69

2.7.23 How to configure Kerio Operator to connect to ha-vel.cz 71

2.7.24 How to configure Kerio Operator to connect to isphone 73

2.7.25 How to configure Kerio Operator to connect toMegapath 73

2.7.26 How to configure Kerio Operator to connect toMultiVoice 74

2.7.27 How to configure Kerio Operator to connect to netphone.cz 75

2.7.28 How to configure Kerio Operator to connect to OrbTalk 76

2.7.29 How to configure Kerio Operator to connect to plusTEL in Denmark 77

2.7.30 How to configure Kerio Operator to connect to sipgate.com 79

2.7.31 How to configure Kerio Operator to connect to Telephonic Canada 80

2.7.32 How to configure Kerio Operator to connect to Voicepulse.com 81

2.7.33 How to configure Kerio Operator to connect to VOIP-Unlimited 83

2.7.34 How to configure Kerio Operator to connect to VoipVoice 83

2.7.35 How to configure Kerio Operator to connect to Xphone.cz 84

2.7.36 How to connect Kerio Operator to Skype Connect 86

2.7.1 Connecting to VoIP service providers

NOTE
This information is designed for Kerio Operator 2.4 and newer.s

You can connect Kerio Operator either to your VoIP service provider's SIP server or to a standard phone network. This
topic discusses about connecting to a VoIP service provider.

Prerequisites

Before you configure an interface, you need the following information:

Telephone number (or numbers) from your SIP provider.

Domain/hostname of SIP server.

Username and password for authentication.

At least one internal extension defined in Kerio Operator — preferably the extension of an employee who redirects
the calls.

Adding an interface

To configure an interface, youmust first configure call routing. Once you configure incoming call routing, a configuration
wizard configures outgoing call routing automatically.
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1. In the administration interface, go toConfiguration > Call Routing and click Add SIP interface. This displays the con-
figuration wizard.

2. Key in a name for the interface (for example, the provider's name). The name must not contain spaces or special char-
acters and must be unique.

3. SelectNew provider. The configuration differs for settings with one number or multiple numbers and for a SIP trunk
with an interval of phone numbers.

One ormultiple phone numbers

1. If you acquire one or multiple phone numbers from your provider, key in the numbers in the New provider> With
external number field. You can:

Separate individual numbers with commas (for example,555450, 555451, 555452, and so on).

Key in a range using a dash (for example,555450-555459).

2. Click Next.

3. Select an extension that receives all calls from the provider.

4. Optionally, in the Prefix to dial out field, key in a prefix for outgoing calls and click Next. Kerio Operator uses this pre-
fix to route calls to your provider's SIP server. This prefix can be the same for other providers. Formore information, refer
to Working with prefixes for outgoing calls (page 203).

5. Key in the domain name or the IP address acquired from your provider and if the server requires authentication, also
key in the username and password.

6. Select Required to register (the majority of providers require registration to a SIP server) and click Next.

7. Verify the information in the Summary section. If you need to add more information from your provider (for example,
outbound proxy, inbound proxy, registrar, and so on), select the Edit detailsof the created interface option. Formore
information, refer to Configuring additional SIP details (page 27).

8. Click Finish.

9. Optionally, double-click the interface and enable the Send keep-alive requestsevery20 secondsoption.

WARNING
If your SIP provider does not send keep-alive packets, or your firewall or router has short and unchangeable NAT
timeout for UDP connections, use this option to keep the UDP session open.

10. Click OK to save your changes.

11. Create a rewriting rule to correctly map numbers to internal user extensions. Formore information, refer to Map-
ping external and internal numbers (page 197).
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Interval of numbers

1. If you acquire a SIP trunk with an interval of phone numbers from your provider, key in x in place of the digits that
vary (for example,555xxx).

2. Click Next.

3. Select the extension on which youwant Kerio Operator to redirect all calls to unassigned (unused) extensions.

4. Optionally, in the Prefix to dial out field, key in a prefix for outgoing calls. Kerio Operator uses the prefix to route calls
to your provider's SIP server. This prefix can be the same for other providers. Formore information, refer to Working
with prefixes for outgoing calls (page 203).

5. Click Next.

6. Key in the domain name or the IP address acquired from your provider. If the server requires authentication, also key
in the username and password.

7. Select the Required to registeroption if the provider requires registration. With large number intervals, some pro-
viders do not require registration. Instead they use the IP address of your Kerio Operator. The address must be static and
the provider needs to know about any changes that may occur.

8. Verify the information in the Summary section. If you need to add more information from your provider (for example,
outbound proxy, inbound proxy, registrar, and so on), select the Edit SIPdetailsof created interface option. Formore
information, refer to Configuring additional SIP details (page 27).

9. Click Finish.

10. Create a rewriting rule to correctly map numbers to internal user extensions. Formore information, refer to Map-
ping external and internal numbers (page 197).

Configuring additional SIP details

To set additional settings in your interface for incoming and outgoing calls:

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls,
select a SIP interface and click Edit.

2. On the SIPDetails tab, you can:

Key in addresses to outbound proxy, inbound proxy and registrar (Kerio Operator uses domain by default).

Change the transport protocol.

Change the DTMF method.

Key in an authentication username (Kerio Operator uses the SIP username by default).

Change outgoing headers.

3. Click OK to save your changes.
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Configuring DTMF method

NOTE
This functionality exists since Kerio Operator 2.4.

For some SIP providers, the default configuration of DTMF detection,Auto (RFC2833 / In-band), does not work. You
must find out the correct method from your SIP provider and configure it manually, as follows:

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Select a SIP interface and click Edit.

3. Go to the SIPDetails tab.

4. Select the correctDTMFmethod.

5. Click OK.
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Configuring outgoing headers

NOTE
This functionality exists since Kerio Operator 2.4.

For some providers, youmust add additional configuration to the SIP headers as provided to you by them.

To configure outgoing headers:

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Select a SIP interface and click Edit.

3. Go to the SIPDetails tab.

4. Enable the outgoing header (see the list of supported headers below).

5. Double-click in the Value column and key in the header content (see the list of supported variables below).

6. Click OK.

Kerio Operator supports these headers:

From number

P-Preferred-Identity

P-Asserted-Identity

Remote-Party-ID

Diversion

To edit headers, use these variables:
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EXTERNAL_NUMBER shows the external number after number rewriting

ORIGINAL_NUMBER shows the number of the caller

REQUEST_URI requests the information from the header of the forwarded call

DIVERSION_REASON sends the reason of the call forwarding

DOMAIN shows the domain of the interface

Reading the Caller ID from outgoing headers

NOTE
This functionality exists since Kerio Operator 2.4.4.

If your provider does not send the information about calling or called numbers in default headers (From for calling
number and Request-Line for called numbers), you can configure Kerio Operator to read this information from different
headers (for example, P-Asserted-Identity):

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Select a SIP interface and click Edit.

3. Go to the SIPDetails tab.

4. For the fields Read calling number from and Read called number from, select a new header.

5. Click OK to save your settings.

Displaying the caller's number when transferring and redirecting calls

For more information, refer to Displaying the caller number when transferring and redirecting calls (page 31).

Resolving domain names of SIP providers

Your SIP providers may change their IP address for your registration without prior notice. To avoid inaccessibility,
configure Kerio Operator to periodically resolve domain names and renew the registration:

1. In the administration interface, go toCall Routing > Interfacesand routing of incoming calls.

2. Select a SIP interface and click Edit.

3. Go to the SIPDetails tab.

4. Select the Periodicallyresolve domain namesoption.

5. Click OK.

Kerio Operator now periodically resolves domain names of your SIP provider and renews your registration whenever the
IP address changes.

Mapping of numbers

For more information, refer to Mapping external and internal numbers (page 197).
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2.7.2Displaying the caller numberwhen transferring and redirecting calls

Kerio Operator enables users to transfer or redirect their calls to another number or device. By default, the other device
displays the number assigned to the extension fromwhich the call is forwarded instead of the caller's number.

To solve this issue, enable additional outgoing headers to send the information about the call in them. Ask your provider
which outgoing header to use.

Kerio Operator uses the diversion header by default.

NOTE
If your device can read this information, youmight see, for example, a different icon or both numbers on your
display.

NOTE
This configuration does not affect internal calls.

Configuring the diversion header

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Select a SIP interface and click Edit.

3. Go to the SIPDetails tab.

4. Under the Miscellaneous section, open the drop down list and selectDiversion RFC5806. Kerio Operator auto-
matically changes values in the From and Diversion headers.

5. Click OK.

Formore information, refer to Configuring outgoing headers (page 29).

Example

In this example:

Meg Regret has the external number 377-338-9010.

John Smith has external number 555-1111, which belongs to internal extension 11.

John configures call forwarding to his cell phone number 555-8888.

John wants to be able to return forwarded calls directly.

The SIP provider uses a diversion header.

After Meg dials 555-1111:
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1. The SIP provider sends the call to Kerio Operator and the call reaches extension 11.

2. Kerio Operator redirects the call to555-8888.

3. John Smith calls Meg Regret back. With the diversion header enabled, the call goes directly to Meg Regret. With the
diversion header disabled, the call goes back to John's internal extension.

The difference is that, although the call takes the exact same path to the device, the diversion header allows John to
read and see the caller's number, and dial back directly to that number.

2.7.3 Configuring Kerio Operatorwith NexVortex

You can configure Kerio Operator to send and receive calls using a SIP trunk fromNexVortex.

Prerequisites

Before starting this procedure, you should have:

The telephone number or numbers assigned to you by NexVortex. Each number will include the international coun-
try code without + at the beginning. For example,14085555555.

Your SIP (PROXY) login credentials provided during the nexVortex account activation.

If you have a firewall, make sure the SIP and RTP ports are properly routed to Kerio Operator. Formore information,
refer to Securing Kerio Operator (page 255).

http://www.nexvortex.com/
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Configuration

1. Log in to the administration interface of Kerio Operator.

2. Go to the Call Routing screen

3. Click Add a SIP Interface....”

4. Enter an interface name (e.g. "nexvortex”) and your external number or numbers.

5. Choose the extension to receive incoming calls

6. Specify the hostname (nexvortex.com) along with your Username and Password. Enable Required to register.
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7. On the last page of the wizard, enable Edit detailsof the created interface.

8. In the SIP Details dialog configure the following:

Outbound proxy:nexvortex.com

Inbound proxy:px3.nexvortex.com,px5.nexvortex.com,px7.nexvortex.com

Registrar:nexvortex.com

DTMFmethod:RFC 2833

Leave all other options with the default settings.
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2.7.4 Connecting Kerio Operator to CenturyLink

NOTE
This topic is meant only for the CenturyLink IQ® SIP Trunk offer. CenturyLink supports only G.729 and G.711 U-law
codecs.

Prerequisites

To connect your Kerio Operator to the CenturyLink provider, you need the following information:

Your telephone numbers from CenturyLink. CenturyLink provides two types of numbers:
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TrunkPilot Number, which is used as a SIP username.

Trunk or range of external numbers, which are used for managing calls.

The SIP username (TrunkPilot Number) and password (TrunkGroup SIPPassword).

The domain of CenturyLink (voip.centurylink.com).

The outbound and inbound proxies of CenturyLink (CenturyLinkSBC IPv4Address/Subnet Mask).

The registrar of CenturyLink (CenturyLinkSBC IPv4Address/Subnet Mask).

The authentication username (TrunkGroup SIP ID).

Configuration

1. In the administration interface of Kerio Operator, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.

3. Key in a name for the interface.

4. In the With external number field, key in the trunk or range of numbers and click Next.

5. Select an extension to which youwant Kerio Operator to redirect all calls to unassigned extensions.

6. (Optional) In the Prefix to dial out field, key in a prefix for outgoing calls.

7. Click Next.

8. In the Domain (IPaddress/hostname) field, key in voip.centurylink.com.

9. In the Username field, key in your TrunkPilot Number.

10. In the Password field, key in your TrunkGroup SIPPassword.

11. Select the Required to registeroption and click Next.

12. Select Edit detailson the created interface and click Finish.

After you finish the configuration, the Edit External Interface (SIP) dialog box opens:

1. In the Proxiesand Registar section, key in your CenturyLinkSBC IPv4Address/Subnet Mask intoOutboundproxy,
Inboundproxy, and Registrar fields.

2. Go to the Miscellaneous section.

3. In the Authentication username field, key in your TrunkGroup SIP ID.

4. In the Read called number from field, select "To"header.

5. In the Outgoing headers table: Double-click the value for Fromnumberand key in ORIGINAL_NUMBER.

6. Enable the header.

7. Double-click the value for P-Asserted-Identityand key in <sip:Trunk_Pilot_Num-
ber@voip.centurylink.com>, where Trunk_Pilot_Number represents the number used for the SIP
username.

8. Click OK.
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2.7.5 Connecting Kerio Operator to Deutsche Telekom

Prerequisites

To connect your Kerio Operator to Deutsche Telekom, you need the following information:

Your telephone numbers fromDeutsche Telekom

The SIP username and the SIP password

The domain of Deutsche Telekom. For example,tel.t-online.de.

Configuration

1. In the administration interface of Kerio Operator, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.

3. Key in a name for the interface.

4. In the With external number field, key in your numbers.

NOTE
If you have multiple numbers fromDeutsche Telekom, write individual numbers separated by a comma (for
example,555 5501, 555 5502, 555 5503, 555 5504) or use a dash to define the range of
numbers (for example,555 5501—555 5504).
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5. Click Next.

6. Select an extension that receives all calls from the provider by default.

7. Optionally, In the Prefix to dial out field, you can key in a prefix for outgoing calls.

8. Click Next.

9. In the Domain (IPaddress/hostname) field, key in tel.t-online.de.

10. Key in the username and password.

11. Select the Required to registeroption.

12. Click Next.

13. Select the Edit detailsof the created interface option and click Finish.

After you finish the configuration wizard, the Edit External Interface (SIP) dialog box opens:

1. In the Proxiesand Registrar section, enable the Periodicallyresolve domain namesoption.

2. Click OK.

2.7.6 Connecting Kerio Operator to Easybell

Prerequisites

To connect your Kerio Operator to Easybell, you need the following information:
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Your telephone numbers from Easybell.

The SIP username and password.

The domain of Easybell (sip.easybell.de).

Configuration

1. In the administration interface of Kerio Operator, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.

3. Key in a name for the interface.

4. In the With external number field, key in the range of your numbers.

5. Click Next.

6. Select the extension to which youwant Kerio Operator to redirect all calls to unassigned (unused) extensions.

7. Optionally, in the Prefix to dial out field, you can key in a prefix for outgoing calls.

8. Click Next.

9. In the Domain (IPaddress/hostname) field, key in sip.easybell.de.

10. Key in the username and password.

11. Select the Required to registeroption.

12. Click Next.

13. Verify the information in the Summary section and click Finish.

14. Double-click the created outgoing route for this interface.

15. In the Calling number (Caller ID) section, selectMapextensions to external numbersbased on the incoming
routing table and click OK.
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2.7.7 Connecting Kerio Operator to Net2Phone

Learn how to configure Kerio Operator with a SIP Trunk to Net2Phone.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

Before you start the configuration, you need the following information:

The telephone number or numbers assigned to you by Net2Phone. Each number will include the US international
country code (without + at the beginning). For example,14085555555.

Your SIP (PROXY) login credentials provided during the Net2Phone account activation.

Configuration

1. In the administration interface, go toConfiguration > Call Routing.

2. Click Add SIP Interface.

3. In the first screen, key in an interface name (for example,Net2Phone), selectNew providerand key in your tele-
phone number. For example,14085555555. In case of multiple numbers, use comma separation as noted in the dia-
log.

4. Click Next.

5. Choose the extension to receive incoming calls and key in a prefix that will be used for external calls (for example,9).

6. Click Next.

7. In the Domain (IPaddress/hostname) field, specify the hostname and credentials as provided by Net2Phone
(ippbx.net2phone.com).

8. Check Require to register.

Check the settings by dialing an external phone number.
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2.7.8 Connecting Kerio Operator to NEXCO Networks

NOTE

This information is designed for Kerio Operator 2.3.5 and older. Formore information, refer to Connecting to VoIP
service providers (page 25).

You can configure a SIP trunk with NEXCO Networks for dialing to the public telephone network. This topic describes
the necessary configuration in Kerio Operator.

Prerequisites

After setting up an account with NEXCONetworks, you should be given the following information from the provider:

The telephone number (or numbers) assigned to you.

Trunk # (sometimes referred to as User Name or User ID).

Password

Server IP or Domain. For example,media1.nexconetworks.net.

This information is required in the configuration as described below.

Configuration

1. Log in to the web administration interface of Kerio Operator.

2. Go toConfiguration > Call Routing.

3. Click Add a SIP Interface.

4. Enter an interface name (e.g. "NEXCO”).

5. Choose New providerand enter your telephone number (youmay need to add a 1 at the beginning of the tele-
phone number). Use a comma to separate multiple phone numbers.

6. Click Next.

7. Choose the extension to receive incoming calls.

8. Enter a dial out prefix if necessary.

9. Click Next.

10. Specify the hostname provided by NEXCONetworks (media1.nexconetworks.net) and the default port 5060.

11. Specify the Username (Trunk #) and Password (Password) values as provided by NEXCONetworks.

12. Enable User IDdiffers from the telephonenumberand enter your NEXCONetworks Trunk # (the same number
that is in the Username field).

13. Enable the option Registerwith registrar.

14. Click Finish.

15. In order to transmit the correct CallerID information on outbound calls youmust edit the interface that you’ve just cre-
ated by doing the following:

Select the interface you just created (e.g. NEXCO) and click Edit.

Click the Advanced tab.

http://nexconetworks.com/
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Check the box Use SIPuser ID in REGISTERrequest only.

Click OK to save.
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2.7.9 Connecting Kerio Operator to QSC

Prerequisites

To connect your Kerio Operator to QSC, you need the following information:

Your telephone numbers fromQSC.

The SIP username and the SIP password.

The domain of QSC (sip.qsc.de).

Configuration

1. In the administration interface of Kerio Operator, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.
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3. Key in a name for the interface.

4. In the With external number field, key in the range of your numbers.

5. Click Next.

6. Select the extension to which youwant Kerio Operator to redirect all calls to unassigned (unused) extensions.

7. Optionally, in the Prefix to dial out field, you can key in a prefix for outgoing calls.

8. Click Next.

9. In the Domain (IPaddress/hostname) field, key in sip.qsc.de.

10. Key in the username and password.

11. Select the Required to registeroption.

12. Click Next.

13. Select the Edit detailsof the created interface option and click Finish.

After you finish the configuration wizard, the Edit External Interface (SIP) dialog box opens:

1. Go to SIPDetails> Miscellaneous.

2. In the Read called number from field, select the "To"headeroption.

3. Click OK.
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2.7.10Connecting Kerio Operator to Sipgate.co.uk

Prerequisites

To connect your Kerio Operator to Sipgate.co.uk, you need the following information:

Your phone numbers from Sipgate.co.uk

WARNING
In the Sipgate.co.uk account, Sipgate.co.uk displays numbers in the UK format. When you configure the numbers in
Kerio Operator, you need to change the prefix 0 to a prefix 44.
For example, if you have numbers 056 0001 2345 and 056 0001 2346 from Sipgate.co.uk. When you
configure the SIP interface in Kerio Operator, you change the prefix and key in numbers 4456 0001 2345 and
4456 0001 2346.

The SIP-ID of your SIP account. For example,123456t0.

The SIP password of your SIP account.

The Registry/Proxy address of your account. For example,sipconnect.sipgate.co.uk.

Configuration

In the administration interface of Kerio Operator:

1. Go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Click Add SIP Interface.

3. Key in a name for the interface.

4. In the With external number field, key in your numbers with changed prefixes. Formore information, refer to Pre-
requisites (page 46)..

5. Click Next.

6. Select the extension that receives all calls from the provider.

7. Optionally, in the Prefix to dial out field, you can key in a prefix for outgoing calls.

8. Click Next.

9. In the Domain (IPaddress/hostname) field, key in sipconnect.sipgate.co.uk.

10. Key in the username (123456t0) and the password.

11. Select the Required to registeroption and click Next.
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12. Select the Edit detailsof the created interface option and click Finish.

Kerio Operator finishes the configuration wizard and the Edit External Interface (SIP) dialog box opens:

1. Go to the Outgoing headers table.

2. In the Fromnumber field, key in your SIP-ID (123456t0)

3. Optionally, select P-Preferred Identityand do not change the default value. If you have more than one phone num-
ber from Sipgate.co.uk, use this option to display the external numbers configured in Kerio Operator for your outgoing
calls instead of the FallbackCaller IDnumber configured in your Sipgate account.

4. Click OK.

You can now make some test calls to verify the connection to Sipgate.co.uk.

2.7.11Connecting Kerio Operator to Sipgate Deutschland

Prerequisites

To connect your Kerio Operator to Sipgate Deutschland, you need the following information:

Your telephone numbers from Sipgate Deutschland.
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NOTE
You need to add the country code 49 to the external number.

The SIP username and the SIP password.

The domain of Sipgate Deutschland (sipconnect.sipgate.de).

Configuration

1. In the administration interface of Kerio Operator, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.

3. Key in a name for the interface.

4. In the With external number field, key in the range of your numbers.

5. Click Next.

6. Select the extension to which youwant Kerio Operator to redirect all calls to unassigned (unused) extensions.

7. Optionally, in the Prefix to dial out field, you can key in a prefix for outgoing calls.

8. Click Next.

9. In the Domain (IPaddress/hostname) field, key in sipconnect.sipgate.de.

10. Key in the username and password.

11. Select the Required to registeroption.

12. Click Next.

13. Select the Edit detailsof the created interface option and click Finish.

After you finish the configuration wizard, the Edit External Interface (SIP) dialog box opens:
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1. Go to SIPDetails> Miscellaneous> Outgoing headers.

2. In the Fromnumberheader, key in your SIP username.

3. Select the P-Preferred-Identityheader and click OK.

2.7.12Connecting Kerio Operator to SIP.US and SIPTRUNK.COM

You can configure a SIP trunk with SIP.US or SIPTRUNK.COM for dialing to the public telephone network. This topic
describes the necessary configuration in Kerio Operator.

Prerequisites

Accounts you setup in SIP.US or SIPTRUNK.COM include the following information (available in the SIP.US or
SIPTRUNK.COM control panel) which is required during the configuration with Kerio Operator:

The telephone number or numbers assigned to you.

Trunk #

Password

Configuration

1. Log in to the web administration interface of Kerio Operator.

2. Go toConfiguration > Call Routing.

3. Click Add a SIP Interface.

4. Assign an interface name.

5. Choose New providerand enter your telephone number (use a comma to separate multiple phone numbers).

6. Click Next.

http://sip.us/
http://siptrunk.com/
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7. Choose the extension to receive incoming calls.

8. Enter a dial out prefix if necessary.

9. Click Next.

10. Specify the domain (gw.sip.us for SIP.US) or (gw.siptrunk.com for SIPTRUNK.COM)

11. Specify the Username (Trunk #) and Password (Password) values.
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12. Enable Required to register.

13. Click Next.

14. Review your settings and click Finish.
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2.7.13Connecting Kerio Operator to TelePacific

You can configure a SIP trunk with Telepacific for dialing to the public telephone network. This topic describes the
necessary configuration in Kerio Operator.

Prerequisites

Tomaximize call quality, TelePacific installs a customer-premises equipment (CPE) router at your physical location. It is
necessary to properly design your network to support this type of configuration.

Kerio Operator requires at least two network interfaces. One interface connects directly to the CPE router, and the
other interface connects to your local area network. The diagram below illustrates the basic structure.
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Configuring TCP/IP parameters in Kerio Operator

Configure the interface connecting to the CPE Router with a private IP address that you assign manually (e.g.,
192.168.10.11/24). Do not assign a gateway to this interface. Configure the interface connecting to your local network
with a static, or dynamic IP address that your DHCP server assigns to Kerio Operator. Use this interface to connect to the
internet via the local area network.
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1. Log in to the administration interface

2. Go toConfiguration > Network

3. Edit the interface connecting to the CPE router and assign the TCP/IP parameters for this private network

4. Edit the interface connecting to the local network and verify that the TCP/IP parameters are valid for the local area
network

5. Click Apply

Configuration

1. Log in to the administration interface and go toConfiguration > Call Routing

2. Click Add a SIP Interface and enter an interface name (e.g. "Telepacific”)

3. Choose New providerand enter your telephone number (use a comma to separate multiple phone numbers)

4. Click Next

5. Choose the extension to receive incoming calls and leave the dial out prefix empty

6. Click Next.

7. Specify the IP address of the CPE Router (e.g., 192.168.12.1) and do not change the default port

8. Uncheck Required to registerand leave the Username and Password fields empty

9. Click Next and Finish
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2.7.14Connecting Kerio Operator to Teliax

You can configure a SIP trunk with Teliax for dialing to the public telephone network. This topic describes the necessary
configuration in Kerio Operator. Formore information, refer to Connecting to VoIP service providers (page 25).

Prerequisites

Teliax requires information about the IP address of your Kerio Operator instance in order to ensure a secure connection.

After setting up an account with Teliax, you should be given the following information from the provider, which is
required in this configuration:

Server (IP or Domain such as test.ivy.teliax.com)

Login ID

Password

DID/Telephone Number

Channels (not needed for Operator configuration)

Configuration

1. Log in to the web administration interface of Kerio Operator.

2. Go toConfiguration > Call Routing.

3. Click Add a SIP Interface.

4. Enter an interface name. For example,Teliax.

5. Choose New providerand enter your telephone number (youmay need to add a 1 at the beginning of the tele-
phone number). Use a comma to separate multiple phone numbers.

6. Click Next.

https://teliax.com/
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7. Choose the extension to receive incoming calls.

8. Enter a dial out prefix if necessary.

9. Click Next.

10. Specify the hostname (Server) provided by Teliax (test.ivy.teliax.com) and the default port 5060.

11. Specify the Username (Login) and Password values as provided by Teliax.

12. Enable User IDdiffers from the telephonenumberand enter your Teliax User ID (the same number that is in the
Username field).

13. Enable the option Registerwith registrar.

14. Click Finish.

15. In order to transmit the correct CallerID information on outbound calls youmust edit the interface that you’ve just cre-
ated by doing the following:

Select the interface you just created (e.g. Teliax) and click Edit.

Click the Advanced tab.

Check the box Use SIPuser ID in REGISTERrequest only.

Click OK to save.
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2.7.15Connecting Kerio Operator to Vitelity

NOTE
This information is designed for Kerio Operator 2.3.5 and older.

You can configure a SIP trunk with Vitelity for dialing to the public telephone network. This topic describes the
necessary configuration in Kerio Operator. For more information refer to Connecting to VoIP service providers.

Prerequisites

After setting up an account with Vitelity, you should be given the following information from the provider:

Service: Vitelity LLC VoIP

Username:*<your_user_name>

http://vitelity.com/
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Password:*<your_password>

Balance:$<account_balance>

The username and password above are for managing your Vitelity account. They are not used within Kerio Operator for
any reason.

You then need to set up the following on the Vitelity admin console:

A SubAccount (your SIP account).

A DID Number.

The following screenshots serve as a guide:

Screenshot 3: Figure 1 – Vitelity DID NumberConfiguration

Screenshot 4: Figure 2 - Vitelity Sub Account (SIP) Configuration

After all the settings as described above, you need the following information for configuring Kerio Operator:

The telephone number (or numbers) assigned to you.

Login (sometimes referred to as Trunk #, User Name or User ID).

Password
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Register Server (inbound34.vitelity.net).

Outbound Server (outbound.vitelity.net).

Additional information needed for configuration under Support > Generic Sip Support (for example, a different
Register Server:sip34.vitelity.net).

Configuration

1. Log in to the web administration interface of Kerio Operator.

2. Go toConfiguration Call Routing.

3. Click Add SIP Interface.

4. Enter an interface name (e.g. "Vitelity”).

5. Choose New Providerand enter your telephone number (youmay need to add a 1 at the beginning of the tele-
phone number). Use a comma to separate multiple phone numbers.

6. Click Next

7. Choose the extension to receive incoming calls

8. Enter a dial out prefix if necessary.

9. Click Next.

10. Specify the hostname provided by Vitelity under Support > Generic Sip Support (sip34.vitelity.net)
and the default port 5060.

11. Specify the Username (login and password values as you configured on Vitelity’s sub account settings (see Figure 2
above).

12. Enable User IDdiffers from the telephonenumberand enter your Vitelity login (the same string that is in the user-
name field).

13. Enable the option to Registerwith registrar.

14. Click Finish.

15. In order to transmit the correct CallerID information on outbound calls, youmust edit the interface that you created.
Do the following:

Select the interface you just created (e.g. Vitelity) and click Edit.

Click the Advanced tab

Check the box Use SIP user ID in REGISTER request only

Click OK to save
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2.7.16How to configure Kerio Operator to connect to 802.cz

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

You need the following information for this configuration:

Your telephone number. You will have selected this number when you registered with 802.cz. You can also find the
number if you log into your customer account at www.802.cz. The telephone number (in the national format, i.e. 9
digits) is also used as the authentication name.

Your SIP password. You can configure this in your customer account atwww.802.cz.
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Configuration

1. Log in to the administration interface of your Kerio Operator and navigate to the Call Routing screen.

2. Click Add a SIP Interface.

3. In the first screen, enter a description for the interface name (for example, '802.cz'), choose the option New provider
and enter your telephone number in the national format (9 digits). For example, if your telephone number is in the inter-
national format + 420 333 123 456, you would enter 333123456.

4. Click Next.

5. Choose the extension to receive incoming calls and enter the prefix that will be used to dial out (for example, 0. The
usual dial-out prefix in the Czech Republic).

6. Click Next.

7. Enter hlas.802.cz as the Domain (IPaddress/hostname). If you have a nomadic phone number, use
sip.802.cz instead.

8. Enter your telephone number in the national format (9 digits, e.g.333123456) as the Username and enter your SIP
password as the Password.

9. Ensure Required to register is checked and click Next.

10. Verify the information in the Summary section and click Finish.

Your 802.cz connection is now configured. You can now test this, by placing some calls to your telephone number. This
will verify that your SIP connection is working correctly.

2.7.17How to configure Kerio Operator to connect to ActiveNetwork

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Learn how to configure connect Kerio Operator to Active Network using either a SIP truck also known as postpagato
or, using account prepagato.

Prerequisites

Before configuring Kerio Operator, you will require the following information:

Telephone number, as provided by Active Network in the Area Riservata on their website.

User-name of the SIP account.

Password

SIP Domain

The SIP account type - postpagato or prepagato.

If you have a firewall, make sure the SIP and RTP ports are open and properly routed toKerio Operator.

Configuration

This process describes how to connect Kerio Operator to a SIP account with Active Network.
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1. Log in to the administration interface of your Kerio Operatorand navigate to the Call Routing screen.

2. Click Add a SIP Interface.

3. Enter a description for the interface name. For example,activenetwork-prepagato).

4. Choose the option New providerand enter your telephone number.

With the option postpagato, it is necessary have the number 5 in front of the phone number.
For example, 507611878139.

With the option prepagato, the phone number doesn’t have any prefix in front of the number.
For example, 07611763399.

5. Click Next.

6. Choose the extension to receive incoming calls and enter the prefix that will be used to dial out.

7. Click Next.

a. Enter the Domain (IP address/hostname).

For an account prepagato use VOIP.EUTELIA.IT.

For an account postpagato use SIP.TWT.IT.

b. Enter your ActiveNetworkUserName as the username and the SIP-Password as the password.

c. Ensure Required to register is checked.

8. Click Next to continue to the Summary screen.

9. Verify the information and click Finish.

2.7.18How to configure Kerio Operator to connect to Bandwidth.com

Learn how to configure Kerio Operator for use with a SIP trunk from Bandwidth.com.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

NOTE
Bandwidth.com requires that you run your VoIP PBX on a public IP address. Ensure that your Kerio Operator
installation is secure.

Use strong passwords and configure the built-in firewall. Only your own phones and Bandwidth.com’s server should
be allowed to communicate with your Kerio Operator PBX. With Kerio Operator 1.1, use the protection against SIP
password guessing.

Prerequisites

Before starting this procedure, ensure you have:

Your account is configured for E.164 dialing (the international format with + at the beginning). In this topic, we
assume you use E.164 which is the default and also a slightly complex case.

The telephone number assigned to you by Bandwidth.com. For example,+1 234 555 0101.

The IP address of Badwidth.com’s primary gateway. For example,216.82.224.202.
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Configuration

1. Log in to the administration interface of your Kerio Operator and go to the Call Routing screen.

2. Click Add a SIP Interface.

3. Key in the interface name. For example,bandwidth.com.

4. Choose the option New providerand key in your telephone number in the international format with +1 at the
beginning. For example,+12345550101.

5. Click Next.

6. Choose the extension to receive incoming calls and key in the prefix that will be used to dial out. For example,9.

7. Click Next.

8. Key in the IP address (216.82.224.202) of Bandwidth’s primary gateway in the Domain (IPaddress/hostname)
field.

9. Uncheck Require to register, and leave the username and password fields empty. Bandwidth.com uses only IP-
based authentication, so youmust register your IP address with them.

10. Click Next.

11. Verify the information in the Summary section and click Finish to save the configuration of the interface.

You should now be able to receive incoming calls. But we need tomodify the rules for outgoing calls so that outgoing
calls work as well and dialed numbers are rewritten to the E.164 format.

We assume that if the PBX user dials a number with 91 at the beginning, they want to place a domestic call. If the
number starts with 9011, it’s an international call.

Dialing a + on a desktop phone is usually not easy, so we will add the + sign in the rewriting rules instead.

1. Double-click on the rule for outgoing calls to edit it. In our example, the rule is displayed as 9... band-
width.com.
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2. In the edit dialog, change the prefix to91 and go to the Called number section.

3. Set Strip digits from left to 1.

4. In the And add thisprefix field, key in +. Now, if someone dials 914084964500, this number will be modified to
+14084964500. This ensures we dial US-based numbers in the full E.164 format.

5. Click OK to save the change.

6. Click Add… on the Call Routing screen to add a second outgoing rule for prefix 9011.

7. Key in 9011 as the prefix and add the external interface for Bandwidth.com.

8. Under CalledNumbers, set Strip digits from left to4 and setAnd add thisprefix to+. On setting these fields, the
prefix 9011 will be replaced with + and we will thus obtain a correct international E.164 format.

9. Click OK to save the dialog.

Your Bandwidth.com trunk is now configured on Kerio Operator. Try running some test calls.

2.7.19How to configure Kerio Operator to connect to Breezz (NL)

Learn how to configure Kerio Operator to connect to the Dutch provider Breezz.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

Before starting this procedure, ensure you have:

The telephone number assigned to you by Breezz. The number will include the Netherlands’ international country
code (without + at the beginning). For example,31718123456. In the configuration, the phone number is also used
as an authentication name.

The password for your SIP account.
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Configuration

1. Log in to the administration interface of Kerio Operator.

2. Go toAdvancedOptions, tab General and set the SIPUser-Agent string toKerio Operator. Breezz will not let you
register with the AsteriskPBX string.

3. Go to the Call Routing screen.

4. Click Add a SIP Interface.

5. In the first screen, enter the interface name (for example,Breezz-NL), choose the option New providerand enter
your telephone number (31718123456 as per our example).

6. Click Next.

7. Choose the extension to receive incoming calls and enter the prefix that will be used to dial out. For example,9.

8. Click Next.

9. Enter sip.sipnl.net to the Domain (IP address/hostname).

10. Enter your telephone number (31718123456) as the username.

11. Enter your SIP password.

12. Ensure Require to register is checked.

13. Click Next to go to the Summary screen.

14. Verify the information and click Finish.

15. Double-click the interface you have just created to edit the order of codecs.

16. Move G.711A-law and G.711U-law to the top. It is recommended to this because Breezz now supportsG.726 and
the translation fromG.711 toG.726 reduces the audio quality noticeably. If your phones supportG.726 youmay leave
the codec order as it is and use G.726 for the whole call path (phone< > Operator< > Breezz).

You are now ready to place and receive calls.

2.7.20How to configure Kerio Operator to connect to DevopSys

Learn how to configure Kerio Operator to connect to Devopsys using a SIP trunk.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

Before starting this procedure, ensure you have:

Your telephone number.

The Devopsys SIP Domain or IP address.

Username and Password.

If you have a firewall, make sure the SIP and RTP ports are open and properly routed to Kerio Operator.

Youmust have communicated to Devopsys the IP address you are going to use to connect Operator to their services
– If it is behind firewall the IP address of the firewall will be used.
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Configuration

This process describes how to connect Kerio Operator to a SIP account with Devopsys.

1. Log in to the administration interface of your Kerio Operator and navigate to the Call Routing screen.

2. Click Add a SIP Interface.

3. In the first screen:

a. Enter a description for the interface name. For example,Devopsys.

b. Choose the option New providerand enter your telephone number including the international dialing
code. For example 0033 5 87 030300.

4. Click Next.

5. Choose the extension to receive incoming calls, and enter the prefix that will be used to dial out, if you wish to use
one.

6. Click Next.

a. Enter the SIP server in the Domain (IPaddress/hostname).

b. Enter yourDevopsysUserName as the username and the SIP-Password as the password.

c. Ensure Required to register is checked.

7. Click Next to continue to the Summary screen.

8. Verify the information and click Finish.

Your Devopsys connection is now configured.

2.7.21How to configure Kerio Operator to connect to Exetel

Learn how to connect Kerio Operator to a SIP account with Exetel. Exetel can be reached at : http://www.exetel.com.au.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

Before starting this procedure, ensure you have:

The telephone number assigned to you. The phone number will be used as an authentication name as well.

The password for your SIP account.

SIP proxy address ( example Exetel SIP server,sip1.exetel.com.au.

Configuration

1. Log in to the administration interface of Kerio Operator.

2. Go to the Call Routing screen.

3. Click Add a SIP Interface.

4. In the first screen, enter the interface name. For example,Exetel.

5. Choose the option New providerand enter your telephone number.

http://www.exetel.com.au/
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6. Click Next.

7. Choose the extension to receive incoming calls (queue, script, conference or group) and enter the prefix that will be
used to dial out. For example,9.

8. Click Next.

9. EnterDomain (IPaddress/hostname). For example,sip1.exetel.com.au.

10. Enter your telephone number as the username and your SIP password as password.

11. Ensure Required to register is checked.

12. Click Next.

13. Verify the information in the Summary section and click Finish.

You are now ready to place and receive calls.

2.7.22How to configure Kerio Operator to connect to fayn.cz

Learn how to connect Kerio Operator to a SIP account with Fayn. We assume that you already have a Fayn SIP account and
know your SIP credentials.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

If you do not know the credentials, log in to your account atwww.fayn.cz, go to Setup and click View next to your SIP
authentication name.

Before starting this procedure, ensure you have:

Your phone number as provided by fayn.cz.

Your password.

SIP proxy address. Currently,sip.fayn.cz.

All of this information can be found at https://iz.fayn.cz/ after login, under the PřehledMSN menu and the MSN button.

Configuration

1. Log in to the Kerio Operator admin interface, go to the Call Routing section.

2. Click Add a SIP Interface button.

3. Name your new interface and enter your assigned phone number.

4. Click Next.

5. Select the desired internal extension (queue, script, conference or group) and optionally enter an outbound prefix.

6. Click Next.

7. Enter sip.fayn.cz into the Domain (IPaddress/hostname) field.

8. EnterUsername(your assigned phone number) and your password.

http://www.fayn.cz/
https://iz.fayn.cz/
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9. Click Next.

10. Verify the information in the Summary section and click Finish.

11. Open the route configuration again, go to the Codecs tab and correct the supported codecs list tomatch those sup-
ported by Fayn (see your Fayn account for exact information: http://www.fayn.cz/pece-a-podpora/navody-a-
nastaveni/).

http://www.fayn.cz/pece-a-podpora/navody-a-nastaveni/
http://www.fayn.cz/pece-a-podpora/navody-a-nastaveni/
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12. PressOK.

2.7.23How to configure Kerio Operator to connect to ha-vel.cz

Learn how to connect Kerio Operator to a SIP account with ha-vel.cz.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

We assume that you already have a Ha-vel SIP account and know your SIP credentials. (If you do not know the credentials,
login to your account at https://ha-loo.ha-vel.eu/cz/index.php).

Before starting this procedure, ensure you have:

https://ha-loo.ha-vel.eu/cz/index.php
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Your phone number registered with ha-vel.cz. We assume it as 123456789 in our example below.

Your password.

SIP proxy address (currently ustredna.ha-vel.cz).

These details can be found by logging into https://ha-loo.ha-vel.eu/cz/index.php, under Information / Informace and
SIP/IAX Settings / Nastaveni SIP/IAX sections .

Configuration

1. Log in to the Kerio Operator admin interface.

2. Go to the Call Routing section and click Add a SIP Interface.

3. Name your new interface and enter your assigned phone number.

4. Click Next.

5. Select the desired internal extension (queue, script, conference or group) and optionally specify the outbound prefix.

6. Click Next.

7. Enter ustredna.ha-vel.cz into the Domain (IPaddress/hostname) field.

8. Key in the assigned phone number intoUsername field and password into Password field.

9. Click Next.

10. Open route configuration again, go to the Codecs tab and remove unsupported codecs (SpeeX, G.722 and G.726
codecs).

11. Click OK.

https://ha-loo.ha-vel.eu/cz/index.php
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2.7.24How to configure Kerio Operator to connect to isphone

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

Before starting this procedure, ensure you have:

The telephone number assigned to you in E164 format. The phone number will be used as an authentication name
as well.

The password for your SIP account.

SIP proxy address. For example,sip2.isphone.com.au.

Configuration

1. Log in to the administration interface of Kerio Operator.

2. Go to the Call Routing screen.

3. Click Add a SIP Interface.

4. Key in the interface name (for example,isphone).

5. Choose the option New providerand enter your telephone number.

6. Click Next.

7. Choose the extension to receive incoming calls (queue, script, conference or group) and enter the prefix that will be
used to dial out. For example,9.

8. Click Next.

9. Set the Domain (IPaddress/hostname), For example,sip2.isphone.com.au.

10. Enter your telephone number as the username and your SIP password as password.

11. Ensure Required to register is checked.

12. Click Next.

13. Verify the information in the Summary section and click Finish.

You are now ready to place and receive calls.

2.7.25How to configure Kerio Operator to connect toMegapath

NOTE
This information is designed for Kerio Operator 2.3.5 and older. For more information about creating and
configuring a SIP interface in later versions, see Connecting to VoIP service providers.

Learn how to configure Kerio Operator with a Megapath SIP trunk.

Prerequisites

Before starting this procedure, ensure you have:
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Your telephone number(s).

The User-Name of the SIP account.

The password for the SIP account.

The host or IP of the SIP registration server (usually an EdgeMarc device).

Configuration

1. Log in to the administration interface of your Kerio Operator and navigate to the Call Routing screen.

2. Click Add a SIP Interface.

3. Enter a description for the interface name. For example,megapath.

4. Choose the option New providerand enter your telephone number(s). For example,4085555555.

5. Click Next.

6. Choose the extension to receive incoming calls and an optional outgoing prefix.

7. Click Next.

8. Enter the SIP registrar/proxy hostname (e.g.192.168.1.2).

9. Keep the default port number,5060.

10. Enter the username and password values as provided to you by Megapath.

11. Ensure Must registerwith the Registrar is checked.

12. Enable User IDdiffers from the telephonenumber, and specify the same value as your username

13. Click Finish.

14. Edit your newly created SIP interface and from the Advancedmenu enable Use SIPuser ID in REGISTERrequest
onlyoption.

2.7.26How to configure Kerio Operator to connect toMultiVoice

Learn how to configure Kerio Operator to connect toMultiVoice using a SIP trunk.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

Before starting this procedure, ensure you have:

Your telephone number.

The User name and password of the SIP account.

The SIP Domain.

If you have a firewall, make sure the SIP and RTP ports are open and properly routed to Kerio Operator.

Configuration

1. Log in to the administration interface of your Kerio Operator and navigate to the Call Routing screen.

2. Click Add a SIP Interface.
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3. Enter a description for the interface name. For example,MultiVoice.

4. Choose the option New providerand enter your telephone number including the international dialing code. For
example,0039 0171 699757.

5. Click Next.

6. Choose the extension to receive incoming calls, and optionally enter the prefix that will be used to dial out.

7. Click Next.

8. Enter the SIP Domain in Domain (IPaddress/hostname. For example,multivoice.multiwire.net.

9. Enter your MultiVoice User Name as the username and the SIP-Password as the password.

10. Ensure Required to register is checked.

11. Click Next.

12. Verify the information in the Summary section and click Finish.

Your MultiVoice connection is now configured.

2.7.27How to configure Kerio Operator to connect to netphone.cz

Learn how to connect Kerio Operator to a SIP account with Netphone CZ.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

We assume that you already have a Netphone SIP account and know your SIP credentials. If you do not know the
credentials to login to your account on www.netphone.cz, go to Setup and click View next to your SIP authentication
name.

Prerequisites

Before starting this procedure, ensure you have:

Your phone number, as provided by netphone.cz. For example,123456789.

Your password.

SIP proxy address. Currently,sip1.netphone.cz.

These details can be found after logging in to https://admin.netphone.cz/prihlaseni, under Přehled tel. ciselsection
and MSN button.

Configuration

1. Log in to the Kerio Operator admin interface, go to the Call Routing section and click Add a SIP Interface.

2. Name your new interface and enter your assigned phone number on the 1st screen.

3. Click Next.

4. Select the desired internal extension (queue, script, conference or group) and optionally choose an outbound prefix.

5. Click Next.

6. Enter sip1.netphone.cz in the Domain (IPaddress/hostname) field.

7. Key in the Username (assigned phone number) and your Password.

http://www.netphone.cz/
https://admin.netphone.cz/prihlaseni
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8. Click Next.

9. Verify the information in the Summary section and click Finish.

10. Open route configuration and go to the Codecs tab and correct supported codecs list tomatch those supported by
Netphone. See your netphone.cz account, under the Prehled tel. cisel section, click Upravit button and enable Expert
mod to get the list.

11. Click OK.

2.7.28How to configure Kerio Operator to connect to OrbTalk

NOTE
This information is designed for Kerio Operator 2.3.5 and older. For more information about creating and
configuring a SIP interface in later versions, see Connecting to VoIP service providers.

Learn how to configure connect Kerio Operator to OrbTalk using a SIP truck.

Prerequisites

Before starting this procedure, ensure you have:

Your telephone number.

The user-name and password of the SIP account.

The SIP Domain

If you have a firewall, make sure the SIP (UDP 5060 – 5090) and RTP (UDP 6000 – 65535) ports are
open and properly routed to Kerio Operator. Kerio Operator requires that ports UDP 10000 - 19999 internally are
open.
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Configuration

1. Log in to the administration interface of your Kerio Operator and navigate to the Call Routing screen.

2. Click Add a SIP Interface.

3. Enter a description for the interface name. For example,OrbTalk.

4. Choose the option New providerand enter your telephone number. For example,0550935405.

5. Click Next.

6. Choose the extension to receive incoming calls and enter the prefix that will be used to dial out.

7. Click Next.

8. Enter the SIP registrar/proxyhostname.

9. Enter 5060 in the Port Number.

10. Enter your OrbTalk User Name as the authentication name and the SIP-Password as the password. Typically the user-
name will follow the format of IPT-<country code and telephone number>. For example,IPT-
441223202130.

11. Ensure Must registerwith the Registrar is checked.

12. Enable User IDdiffers from the telephonenumber, this will also be your User Name.

13. Click Finish.

Your OrbTalk connection is now configured

2.7.29How to configure Kerio Operator to connect to plusTEL in Denmark

Learn how to connect Kerio Operator to a SIP account with plusTEL.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

We assume that you already have a plusTEL SIP account and know your SIP credentials. (If you do not know the
credentials, contact plusTEL.dk to receive this information.)

Before starting this procedure, ensure you have:

Your SIP authentication name.

Your SIP password.

The SIP registrar/proxy hostname.

Configuration

1. Log in to the administration interface of your Kerio Operatorand go to the Call Routing screen. At least one exten-
sion is needed before creating the SIP Interface.

2. Click Add a SIP Interface.

3. Enter an interface name, choose the option New providerand enter your telephone number.
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4. Click Next.

5. Choose the extension to receive incoming calls on and if you like, enter the prefix that will be used to dial out.

6. Click Next.

7. Enter the Domain (IPaddress/hostname).

8. Enter your SIP username and password.

9. Ensure Required to register is checked.
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10. Click Next.

11. Verify the information in the Summary section and click Finish.

Your connection to plusTEL is now configured.

plusTEL description

plusTEL is a registered VoIP Service Provider in Denmark.

For further information contact:

SIP-Trunk

plusTEL ApS

TEL: +45 35294010

info@plustel.dk

Kerio Distribution

MikroGraf as

TEL: +45 70222101

info@mikrograf.dk

eStation ApS

TEL: +45 35294000

info@estation.dk

2.7.30How to configure Kerio Operator to connect to sipgate.com

Learn how to connect Kerio Operator to a SIP account with sipgate.com.
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NOTE
This information is designed for Kerio Operator 2.3.5 and older. For more information about creating and
configuring a SIP interface in later versions, see Connecting to VoIP service providers.

Prerequisites

Before starting this procedure, ensure you have:

Your telephone number, as provided by Sipgate. To find the number, log in to Sipgate administration interface at
www.sipgate.com and go to Settings.

The SIP-ID of your SIP account. You can locate this in the Sipgate administration interface, click Settings> SIPCre-
dential, the SIP-ID will then be displayed. For example,1234567a0.

The SIP-ID (not the telephone number) is the most important identifier you require in order to connect over SIP. The
SIP-Password for your SIP account. This password is usually of the form1ABCD2.

Configuration

1. Log in to the administration interface of your Kerio Operator and navigate to the Call Routing screen.

2. Click Add a SIP Interface.

3. Enter a description for the interface name. For example,sipgate.com.

4. Choose the option New providerand enter your telephone number. With sipgate, it is not significant whether you
include 1 at the beginning of the number or not.

5. Click Next.

6. Choose the extension to receive incoming calls to and enter the prefix that will be used to dial out. For example,9.

7. Click Next.

8. Enter sipgate.com as the SIP registrar/proxy hostname.

9. Enter your sipgate SIP-ID as the authentication name and the SIP-Password as the password.

10. Ensure Must registerwith the RegistrarorProxy is checked.

11. Check User IDdiffers from the telephonenumberand enter your SIP-ID in the User ID field. This is the part where
Sipgate differs frommost SIP providers who prefer to use the telephone number as the SIP user ID.

12. Click Finish. Your sipgate connection is now configured.

You can now test the configuration by placing some calls to your telephone number. This will verify that your SIP
connection is working correctly.

2.7.31How to configure Kerio Operator to connect to Telephonic Canada

NOTE
This topic is for versions Kerio Operator 2.3.5 and older. For more information about creating and configuring a SIP
interface in later versions, see Connecting to VoIP service providers.

Learn how to configure Kerio Operatorwith a SIP Trunk to Telephonic Canada

http://www.sipgate.com/
http://www.telephonic.ca/
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NOTE

Watch the Configuring Kerio Operator with Telephonic Canada video.

Prerequisites

Before starting this procedure, ensure you have:

The telephone number or numbers assigned to you by Telephonic. Each number will include the Canadian’ inter-
national country code without + at the beginning. For example,17785555555.

If you have a firewall, make sure the SIP and RTP ports are open and properly routed to Operator.

A static IP, as the typical configuration will use IP based registration without requiring authentication.

You have provided Telephonic with your static IP address.

Configuration

1. Log in to the administration interface of Kerio Operator.

2. Go to the Call Routing screen.

3. Click Add a SIP Interface.

4. Enter the interface name. For example,Telephonic.

5. Choose the option New providerand enter your telephone number. For example,17785555555. In case of mul-
tiple numbers, use comma separation as noted in the dialog.

6. Click Next.

7. Choose the extension to receive incoming calls and enter the prefix that will be used to dial out. For example,9.

8. Click Next.

9. In the SIP Registrar dialog, specify the hostname provided by Telephonic (kerio.telephonic.ca) and the
default port 5060. Leave the Username and password fields empty, and disable both checkboxes for registration and
user ID.

NOTE
Telephonic Canada provides a free testing account (with DID) and $5.00 credit for customers evaluating Kerio
Operator.

2.7.32How to configure Kerio Operator to connect to Voicepulse.com

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Learn how to connect Kerio Operator to a SIP account with Voicepulse Inc. We assume that you already have a Voicepulse
SIP account and know your SIP credentials. (If you do not know the credentials, log in to your account at
www.voicepulse.com, go to Setup and click View next to your SIP authentication name.

Prerequisites

Before starting this procedure, ensure you have:

http://www.youtube.com/embed/u13wL8FIMfI?rel=0&showinfo=0&autoplay=1
http://www.voicepulse.com/
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Your telephone number assigned to you by Voicepulse. For example +1 555 123 4567.

Your SIP authentication name – note this is not the user name you use to log into Voicepulse web interface. The SIP
authentication name is typically something like VaSBFLM12a".

Your SIP password. Again, this is not the password you use to login to Voicepulse web interface. It is the second part
of your SIP credentials. The password is typically something like u2TYRUa878.

Configuration

1. Log in to the administration interface of your Kerio Operator and go to the Call Routing screen.

2. Click Add a SIP Interface.

3. Enter a interface name, choose the option New providerand enter your telephone number with 1 at the begin-
ning.

4. Click Next.

5. Choose the extension to receive incoming calls on and enter the prefix that will be used to dial out. For example,9.

6. Click Next.

7. Enter jfk-primary.voicepulse.com as the Domain (IPaddress/hostname). Use sjc-primary.-
voicepulse.com if you are closer to San Jose, CA than to New York.

8. Enter your SIP authentication name and password.

9. Ensure Required to register is checked.

10. Click Next.

11. Verify the information in the Summary section and click Finish.

Your connection to Voicepulse is now configured.
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2.7.33How to configure Kerio Operator to connect to VOIP-Unlimited

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Learn how to connect Kerio Operator to a SIP account with VOIP Unlimited. We assume that you already have a VOIP
unlimited SIP account and know your SIP credentials.

Prerequisites

Before starting this procedure, ensure you have:

Your phone number and username, as provided by VOIP Unlimited.

Your password.

SIP proxy address. Currently,sip.voip-unlimited.net.

All of this information is emailed to you from VOIP-Unlimited.

Configuration

1. Log in to the Kerio Operator admin interface, go to the Call Routing section and click Add a SIP Interface.

2. Name your new interface and enter your assigned phone number.

3. Click Next.

4. Select the desired internal extension (queue, script, conference or group) and optionally enter an outbound prefix.

5. Click Next.

6. Enter sip.voip-unlimited.net in the Domain (IPaddress/hostname) field, enter your username (not your
phone number) into the Username field and your password into the Password field.

7. Click Next.

8. Verify the information in the Summary section and click Finish.

9. Open the route configuration and go to theCodecs tab and correct the supported codecs list tomatch those sup-
ported by VOIP-Unlimited. The supported codecs are G729, G711a and G711u.

10. Click OK.

2.7.34How to configure Kerio Operator to connect to VoipVoice

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Learn how to configure connect Kerio Operator to VoipVoice using a SIP truck.

Prerequisites

Before starting this procedure, ensure you have:

Your telephone number.

The user name and password of the SIP account.
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The SIP Domain.

If you have a firewall, make sure the SIP and RTP ports are open and properly routed toKerio Operator.

Configuration

1. Log in to the administration interface of your Kerio Operator and navigate to the Call Routing screen.

2. Click Add a SIP Interface.

3. Enter a description for the interface name. For example,VoipVoice.

4. Choose the option New providerand enter your telephone number. For example,0550935405.

5. Click Next.

6. Choose the extension to receive incoming calls and enter the prefix that will be used to dial out.

7. Click Next.

8. Enter the SIP domain in the Domain (IPaddress/hostname) field.

9. Enter your VoipVoice User Name as the username and the SIP-Password as the password.

10. Ensure Required to register is checked.

11. Click Next.

12. Verify the information in the Summary section and click Finish.

Your VoipVoice connection is now configured.

2.7.35How to configure Kerio Operator to connect to Xphone.cz

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Learn how to connect Kerio Operator to a SIP account with Xphone CZ. We assume that you already have a Xphone SIP
account and know your SIP credentials. (If you do not know the credentials, login to your account atwww.xphone.cz, go
to Setup and click View next to your SIP authentication name.

Prerequisites

Before starting this procedure, ensure you have:

Your phone number, as provided by xphone.cz. For exzample,123456789.

Your username and password.

SIP proxy address. Currently,sip2.xphone.cz.

All of this information can be found on logging in to http://www.xphone.cz, under Nastaveni / Settings and then
Prihlasovaci udaje / login credentials.

Configuration

1. Log in to the Kerio Operator admin interface, go toCall Routing section and click Add a SIP Interface.

2. Name your new interface and enter your assigned phone number.

3. Click Next.

http://www.xphone.cz/
http://www.xphone.cz/
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4. Select the desired internal extension (queue, script, conference or group) and optionally enter an outbound prefix.

5. Click Next.

6. Enter sip2.xphone.cz in Domain (IPaddress/hostname), enter your username (not your phone number) in
Username and your password in Password.

7. Click Next.

8. Verify the information in the Summary section and click Finish.

9. Open the route configuration and go to the Codecs tab and correct the supported codecs list tomatch those sup-
ported by Xphone. See your xphone.cz account for exact information - https://www.xphone.cz/zone_user_settings_
codecs.php).

https://www.xphone.cz/zone_user_settings_codecs.php
https://www.xphone.cz/zone_user_settings_codecs.php
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10. PressOK.

2.7.36How to connect Kerio Operator to Skype Connect

NOTE
This functionality was last redesigned for Kerio Operator 2.4 and newer.

Prerequisites

Before starting this procedure, ensure you have:

The SIP User ID for your Skype Connect profile. To find this ID, log to your Skype Manager account, view the details of
your Skype Connect profile and navigate to Authentication Details. The SIP User is usually a 14-digit number that starts
with 9905.

The password generated by Skype for your Skype Connect profile. You will find it in the same Skype Manager page
as the SIP User ID.
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The phone number you have associated with Skype Connect profile. Skype lets you choose a number in about 20
countries. For example, a phone number in USA would look like +1 408 555 0123.

Configuration

1. Log in to the administration interface of your Kerio Operator and go to the Call Routing screen.

2. Click Add a SIP Interface.

3. Enter an interface name, choose the New provideroption and enter your telephone number. For example,
14085550123.

4. Click Next.

5. Choose the extension to receive incoming calls and enter a prefix that will be used for external calls. For example,9.

6. Click Next.

7. In the Domain (IPaddress/hostname) field, enter sip.skype.com.

8. Enter your SIP User ID in the Username field and enter the Password.

9. Ensure Required to register is checked.

10. Click Next.

11. Verify the information in the Summary section and click Finish.

You should be able to receive calls at your telephone number after finishing these steps. You should also be able to call
numbers within the country in which you have chosen your phone number.

However, you have to do a few additional steps to be able to call international numbers.

Skype requires that you send international numbers in the E.164 format with + in front of the country code. In our
example, the dial-out prefix is 9 and we will add the prefix 900 for international calls. The approach is as follows:

1. Go to the Call Routing screen again and click Add in Routing of outgoing calls.

2. In the AddOutgoing Route dialog, enter 900 as the route prefix and add your Skype Connect interface as created
before.

3. Modify the values for the Called number so that 3 digits are stripped off as we want to remove the prefix 900) and
replace is with +.

4. Click OK to save the route.

Now, as an example, if you want to call a number in the Netherlands, you would dial 90031…and this would get
translated this to+31… and will send the call to your Skype Connect interface.

The Skype™ name, Skype Connect™ and their logos are trademarks of Skype.

2.8 Gateways
This section helps you connect via various gateways.

2.8.1 Configuring Kerio Operator and Cisco SPA8800 for calls over an analog telephone line 88

2.8.2 Configuring Kerio Operator and GrandstreamGXW 4104/4108 for calls over analog telephone lines 91

2.8.3 Configuring Kerio Operator and GrandstreamGXW4224 to use analog phones for internal extensions 94

2.8.4 Configuring Kerio Operator and GrandstreamHT503 for calls over analog lines 97
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2.8.5 Configuring Kerio Operator and WellTech 2504/WellGate 2504 to use analog phones for internal exten-
sions 99

2.8.6 Configuring Kerio Operator and Well/Yeastar NeoGate TB400 for calls between SIP and EuroISDN 103

2.8.7 Configuring Kerio Operator and Well/Yeastar NeoGate TG200 for calls between SIP and GSM 105

2.8.8 Configuring Kerio Operator and Yeastar NeoGate TE100 for calls over analog lines 108

2.8.9 Configuring PRI telephone service through the Digium VoIP Media Gateway 113

2.8.10 Connection with Linksys SPA3102 analog (FXS/FXO) to SIP gateway 117

2.8.1 Configuring Kerio Operator andCisco SPA8800 for calls over an analog telephone line

Cisco SPA8800 is an analog-to-SIP gateway equipped with 4 FXS and 4 FXO telephone ports.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Learn how to configure the SPA8800 with Kerio Operator to place and receive phone calls over the FXO interface (analog
telephone line).

Prerequisites

We assume that your Kerio Operator is up and running and you have at least one internal extension.

We also expect:

Your SPA8800 is already connected to your LAN and you have access to its web administration. To discover the
device’s IP address or change the basic network settings, you can connect an analog phone to the Phone 1port on the
SPA and use the device’s simple IVR system as described in the SPA8800 Quick Start Guide.

Your PSTN line is connected to the Line 1port of the SPA device.

Additionally, we have describe the configuration of a single line. If you are about to use several lines on the SPA, you
need to repeat the configuration steps up to 4 times. The SPA8800 uses a separate SIP/UDP port for every analog line, so
you need one SIP interface in Kerio Operator for each line in use. The default port numbers are 5061 for Line 1,5161
for Line 2, 5261 for Line 3, and 5361 for Line 4.

Configuring Kerio Operator

NOTE
The PSTN phone number 5550199, Kerio Operator IP address 10.1.2.95 and SPA8800 IP address 10.1.2.200
are all sample values and are used as examples to explain the configuration process.

1. In the administration interface, go toCall Routing.

2. Create a new SIP interface with 5550199 as the external number.

3. Click Next.

4. In the second screen, choose an extension to receive calls from this interface and set a dial-out prefix (for example 9).

5. In the third screen, set the following:
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a. Set the IP address of the SPA device. For example,10.1.2.200

b. Set the username. Kerio Operator uses to authenticate with the SPA. For example,spa8800.

c. Set a password, for example pass5550199.

d. Clear the Required to registeroption. The SPA is not able to behave as a SIP registrar.

Formore information, refer to Connecting Kerio Operator to TelePacific (page 52).

6. In the last screen, select Edit detailsof the created interface and click Finish.

After you finish the configuration of the SIP interface, the Edit External Interface dialog box opens:

1. Go to the SIPDetails tab.

2. In the OutboundProxy field, set the IP address of the SPA device with a port number 5061. For example,
10.1.2.200:5061.

3. Leave the InboundProxy field empty.

4. Click OK to save your changes.

Configuring SPA8800

1. Connect to the web interface of your SPA device. For example,10.1.2.200.

2. Go to the administration section (log in as the administrator, if needed) and click Voice and then Advanced— in our
example, we reach the URL http://10.1.2.200/admin/voice/advanced.

3. Go to the Line 1 configuration page. All subsequent steps (except the step 11) will be done on this page.

4. Verify that Line Enable is set to yes.

5. Under SIP Settings, verify that SIPPort is set to 5061. Set the Auth INVITE field to yes.

6. Scroll down to the ProxyandRegistration section:

http://10.1.2.200/admin/voice/advanced
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a. Proxycontains Kerio Operator’s IP address. For example,10.1.2.95.

b. SetUseOutboundProxy to no.

c. Set Register to no.

d. SetUseOBProxyIn Dialog to no.

e. SetMakeCallWithout Reg to yes.

f. SetAnsCallWithout Reg to yes.

5. Scroll to the Subscriber Information section:

a. SetDisplayName to some non-empty string. Use something like External call or Analog device tomake it
easier for your users to distinguish calls coming through the SPA device.

b. SetUser ID to your external telephone number, for example 5550199.

c. Set Password to your chosen authentication password, for example pass5550199.

d. SetUseAuth ID to yes.

e. SetAuth ID to your chosen authentication user name. For example,spa8800.

Screenshot 5: Configuring Proxy and Subscriber Information in SPA8800

6. Scroll to the Dial Plans section. SetDial Plan 8 toS0<:5550199@10.1.2.95>. Here,5550199 is the external
phone number and 10.1.2.95 is the IP address of Kerio Operator.

7. Now move to the VoIP-To-PSTN Gateway Setup section. Set the VoIPCallerDefault DP field to none.

8. Scroll to the PSTN-To-VoIPGatewaySetup section:

a. PSTNCIDNumberPrefix should be empty.

b. PSTNCallerDefault DPmust be 8. (DP stands for Dial Plan — see step 6 above).
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NOTE
Note about Caller ID: On a typical PSTN line, the Caller ID (aka CLIP or CID) is usually transmitted using the FSK
modulation between the first and the second ring of the incoming call. If your PSTN line provides the Caller ID
service, set PSTNCIDForVoIPCID to yesbut also increase the value in PSTNAnswerDelay (under FXO Timer
Values) so that the SPA device can hear the 2 rings before starting the VoIP call to Kerio Operator.

9. Go to the FXO TimerValues (sec) section:

a. Set VoIPAnswerDelay to 0.

b. Set PSTNAnswerDelay to 0. If you want to transfer the PSTN Caller ID to the VoIP side, enter a number (in
seconds) that approximately corresponds to 2 rings on your PSTN line.

10. Save the configuration by clicking on Submit All Changesat the bottom of the configuration page. Note that the
device might need 20-30 seconds to save and apply the new configuration.

11. If you enabled the Caller ID detection in step 8, go to the Regional > Miscellaneousand check that the fields Caller
IDMethod and Caller IDFSKStandard correspond with the standard used by the local telco company. The most usual
method is Bellcore— bell202, but youmay need to ask the telco about the Caller ID encoding method they are using.

Both Operator and the SPA8800 are now configured and you can place some test calls. If you are not satisfied with the
volume of the sound transmitted from the analog side to VoIP or vice versa, you can return to the Line 1 configuration
page, scroll to International Control and change the values for SPA To PSTNGain and/or PSTNTo SPAGain.

2.8.2 Configuring Kerio Operator andGrandstreamGXW4104/4108 for calls over analog tele-
phone lines

GrandstreamGXW 4104 is an analog-to-SIP gateway with four FXO ports. The GXW 4108 model has eight FXO ports.

Prerequisites

To complete the configuration, you need:

Kerio Operator up and running.

At least one internal extension.

The Grandstream gateway connected to your LAN.

One analog phone connected to the first port of the GXWgateway.

In the example below:

The Kerio Operator IP address is 10.1.2.95.

The Grandstream gateway's IP address is 10.1.2.200.

The phone number of connected phone is 1234567.

The internal extension's number is 100.

NOTE
The example below uses GXW 4104, firmware version 1.4.1.5. The GXWgateway runs without a SIP password in a
peer-to-peer configuration. Use this configuration in a safe local network.
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Kerio Operator configuration

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Click Add SIP Interface.

3. Type a name for the interface (for example, the provider's name). The name must not contain spaces or special char-
acters and must be unique.

4. SelectNew provider.

5. In the With external number field, type the number 1234567 and click Next.

6. Select an extension that receives all calls, For example, (100.

7. Optionally, in the Prefix to dial out field, type a prefix for outgoing calls and click Next.

8. In the Domain (IPaddress/hostname) field, type the IP address of the GrandstreamGXWgateway,10.1.2.200.

9. Deselect the Required to registeroption and click Next.

10. Verify the information in the Summary section and click Finish.
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GrandstreamGXW configuration

To configure the GXW 4104 model, use the ch1-4 parameter. For a GXW 4108 model configuration, use the
parameterch1-8.

1. In the GrandstreamGXW administration interface, go toAccounts> Account 1> General Settings.

2. In the SIPServer field, type the IP address of (10.1.2.95).

3. In the Account Active field, select Yes.

4. Optionally, set up your Account Name and OutboundProxy.

5. Save your settings.

The web interface now asks whether youwant to reboot to apply the new configuration. You can reboot now or
continue with the configuration and reboot later.

1. Go toAccounts> UserAccount and verify that the configuration form is empty.

2. Go to Settings> Channel Settings> Calling to VoIP.

a. SetUser ID toch1-4:1234567;. Calls that come to any of the four analog ports are send to Kerio Oper-
ator as if the number called was 1234567. To differentiate among the analog ports, type additional external
numbers (for example,1234568) in the SIP interface in Kerio Operator and setUser ID toch1-
2:1234567;ch3-4:1234568. This configuration maps analog ports 1 and 2 to the number 1234567
and ports 3 and 4 to the number 1234568.

b. In the SIPServer field, set ch1-4:pl;.

c. In the SIPDestination Port field, set ch1-4:5060;.

3. Go to FXO Lines> Settings> Port Caller IDSetting.

a. In the Numberof RingsBefore Pickup field, set ch1-4:2;. Analog lines usually transmit the caller ID
between the first and second ring. If you want to detect the caller ID, youmust allow at least two rings before
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accepting the call.

b. In the Caller IDScheme field, set the option to the method used by your analog line provider. For example,
for Bellcore use ch1-4:1;.

c. In the Caller IDTransport Type field, set ch1-4:1; to transmit the caller ID in the SIP From field.

4. Go to FXO Lines> Dialing > Dialing to PSTN, and in the StageMethod (1/2) field, set ch1-4:1;.

5. Reboot the gateway.

After the reboot, make several test calls to verify the configuration.

NOTE

To change the volume of the sound transmitted between the analog line and the SIP, go to FXO Lines> Settings>
Port Voice Settingsand modify the audio gain values.

2.8.3 Configuring Kerio Operator andGrandstreamGXW4224 to use analog phones for internal
extensions

GrandstreamGXW4224 is an analog-to-SIP gateway that allows you to connect up to 24 analog phones. Similar models
with 16, 32, and 48 FXS ports exist.

Prerequisites

Before going into actual process, we assume the following:

Kerio Operator is up and running.

You have at least one other SIP phone that allows you to place a test call.

Grandstream gateway is connected to your LAN and you have access to its web configuration interface.

At least one analog phone is connected to the Grandstream gateway (to the 1st FXS port);

Kerio Operator configuration

1. In the administration interface, go to Extensions.

2. Create the extensions you are about to assign to the analog phones. In this example, we create just a single extension
1101.
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Screenshot 6: Edit Extension dialog

NOTE
The SIP username can be the same as extension number but we use the SIP username 1101p1 to show that the
username can be different. Also, write down the SIP password or copy it to the clipboard.

GrandstreamGXW4224 Configuration

1. Connect to the Grandstream’s web interface.

2. Go to Profile 1 (see screenshot below). The Grandstream gateway lets you configure up to 4 SIP servers.

3. Configure Kerio Operator as the 1st server (Profile 1).

4. In the Profile 1, check that Profile Active is set to Yes.

5. Key in Kerio Operator’s IP address as the PrimarySIPServer. For example,10.1.2.95.

6. Check that the field DNSMode is set to the value A Record.

7. Check that the Local SIPport is set to5060.
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Screenshot 7: Profile 1 screen

8. Scroll down to the bottom of the Profile 1page and click Update.

9. Go to the screen FXSPorts.

10. Key in the SIP identifiers, password, and server profile for each of the 24 analog ports (or 16, 32, 48 ports, respect-
ively). To configure the extension 1101, we do the following for FXSPort 1:

a. Enter 1101p1 into both SIPUser ID and Authenticate ID fields.

b. Enter the extension’s password.

c. Enter 1101 into the Name field.

d. Select Profile 1.

Screenshot 8: FXS Ports

11. Scroll down to the bottom of the screen and click Update.

12. Reboot the gateway.

Testing

When the reboot is complete, you should see the extension registered in Kerio Operator’s Extensionsgrid. Also the
Grandstream’s Status screen should show the registered extensions. You can now place some test calls between analog
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phones connected to the gateway and your other SIP phones.

2.8.4 Configuring Kerio Operator andGrandstreamHT503 for calls over analog lines

The Grandstream HT503 is an analog-to-SIP ATA device with one FXO and one FXS port. You can use this device with
Kerio Operator tomake calls over the telephone network.

Prerequisites

To complete the configuration, you need:

Kerio Operator up and running.

At least one internal extension.

Telephone line connected to the FXO port.

The GrandstreamHT503 connected to the same LAN as Kerio Operator.

The example in this topic uses the following inputs:

The Kerio Operator IP address is 10.1.2.95.

The GrandstreamHT503's IP address is 10.1.2.200.

The external number from the provider is 123456.

The SIP password used for the FXO configuration on the GrandstreamHT503 is pass1234.

Connecting to a network with another DHCP server

The GrandstreamHT503 runs a DHCP server on the LAN port. If you have another DHCP server in your network, connect
the device to your network via the WAN port and enable web access to the administration interface on that port.

To enable the access:

1. After the device boots, connect an analog phone to the FXS port.

2. Press *** to access the voice menu.

3. Press 12 and then 9.

To hear the IP address of the device, press *** and then 02.

Configuring the GrandstreamHT503

To configure the Grandstream device, start by configuring the FXO port:

1. In the administration interface of the device, go to the FXO PORT section.

2. In the PrimarySIPServer field, type the Kerio Operator IP address. For example,10.1.2.95.

3. In the SIPUser ID and Authenticate ID fields, type the external number. For example,123456.

4. In the SIPRegistration field, selectNo.

5. Optionally, in the Caller IDScheme field, select the method used by your provider to detect the caller's ID for incom-
ing calls.

6. In the Caller IDTransport Type field, select Relayvia SIPFrom.

7. In the Numberof Rings field:

http://www.grandstream.com/products/gateways-and-atas/analog-telephone-adaptors/product/handytone-503
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To detect the caller's ID for incoming calls, type 2.

If your provider does not offer Caller ID, type 1.

8. In the PSTNRing Thru FXS field, selectNo.

9. In the Wait forDial-Tone field, selectNo.

10. In the StageMethod field, type 1.

11. Click Update and then Apply to save your changes.

After you finish configuring the FXO port, configure the rest of the settings:

1. Go to the BASIC SETTINGS section.

2. Go to the Unconditional Call Forward to VOIP section.

3. In the User ID field, type the external number (123456 in the example).

4. In the SIPServer field, type the Kerio Operator IP address (10.1.2.95 in the example).

5. In the SIPDestination Port field, type 5060.

6. Click Update and then Apply to save the changes.

Configuring Kerio Operator

1. In the administration interface of Kerio Operator, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.

3. Type a name for the interface (for example, the name of the gateway). The name must not contain spaces or special
characters and must be unique.

4. SelectNew provider.

5. In the With external number field, type the external number (123456) and click Next.

6. Select an extension that receives all calls.

7. Optionally, in the Prefix to dial out field, type a prefix for outgoing calls and click Next.
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8. In the Domain (IPaddress/hostname) field, type the IP address of the Grandstream device (10.1.2.200).

9. In the Username field, type the external number.

10. In the Password field, type the SIP password used for the FXO configuration on the GrandstreamHT503. For
example,pass1234.

11. Clear the Required to registeroption and click Next.

12. Select the Edit detailsof the created interface option and click Finish.

After Kerio Operator finishes the configuration wizard, the Edit External Interface (SIP) dialog box opens:

1. Go to the SIPDetails tab.

2. In the Outboundproxy field, type 10.1.2.200:5062.

3. In the Inboundproxy field, type 10.1.2.200:5062.

4. Click OK to save your changes.

After you complete the configuration, make some test calls to verify the connection between Kerio Operator and
GrandstreamHT503.

2.8.5 Configuring Kerio Operator andWellTech 2504/WellGate 2504 to use analog phones for
internal extensions

WellTech 2504 is an analog-to-SIP gateway with 2 Ethernet ports and 4 FXS ports that allow you to connect up to 4
analog phones. It is sold as WellGate 2504 in some markets.

Learn how to integrate Kerio Operator with WellTech 2504/WellGate 2504.

Prerequisites

Before starting the configuration, we assume:

Your Kerio Operator is up and running. In the example below the Kerio Operator’s IP address has been used as
10.1.2.95.

You have at least one other SIP phone that allows you to place a test call.
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Your WellTech 2504 is connected to your LAN and you have access to its web configuration interface.

At least one analog phone is connected toWellTech 2504 (to port Tel 1).

NOTE
The WellTech gateway runs a DHCP server on its LAN interface by default. If you already have a DHCP server running
in your LAN, do not connect the gateway’s LAN interface to your network straight away. Following the device’s quick
installation guide, you can first connect a single computer to the WellTech’s LAN interface and set up networking as
needed for your LAN.

Kerio Operator configuration

1. In the administration interface, go to Extensions.

2. Create the extensions you are about to assign to the analog phones. In this example, we create just a single extension
1001.

Screenshot 9: Edit Extension dialog

NOTE
Because of the limitations in how the WellTech gateway handles SIP identifiers, the SIP username must be the same
as the extension number (1001). Also. take a note of SIP password or copy it to the clipboard.

WellTech 2504 Configuration

1. Connect to the WellTech’s web interface.

2. Go to FXS Settings> SIPProxy.

3. In the PrimaryProxyServer, type Kerio Operator’s IP address.

4. Check that the PrimaryProxyServerPort is set to5060.

5. Click Apply.
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Screenshot 10: SIP Proxy screen

6. Go to FXS Settings> FXS Line and click the edit icon for the first line. The edit icons are in the first column of the
table. The line edit screen should appear.

7. Scroll to the bottom of the screen, set the field RegisterType to Registerand type the extension number (1001) into
the TEL No field.

8. Type the extension’s SIP username into the field User ID (it must be the same as the extension number 1001).

9. Type (or paste) the extension’s SIP password.

10. Click Apply
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Screenshot 11: FXS Setting

If you are using multiple lines, configure them in a similar way. The unused lines should be set as inactive (the field Line
State).

The WellTech gateway needs to be restarted to start using the new configuration. Go toMaintenance and reboot the
device.

Testing

The WellTech gateway may need about a minute to reboot. As soon as it is up and running, the extensions should
appear as registered in Kerio Operator’s Extensionsgrid. You can now place some test calls between the analog phones
and another SIP phone.
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2.8.6 Configuring Kerio Operator andWell/Yeastar NeoGate TB400 for calls between SIP and Eur-
oISDN

NOTE
This information is designed for Kerio Operator 2.3.5 and older.

For more information about creating and configuring a SIP interface in newer versions, see Connecting to VoIP
service providers.

Yeastar NeoGate TB400 (sold under the Well brand in some countries) is a SIP-to-ISDN gateway. The gateway can be
equipped with 2 or 4 BRI ports and hence it supports up to 8 parallel calls.

Prerequisites

Before starting the configuration, we assume:

Kerio Operator is up and running.

You have at least one other SIP phone that allows you to place a test call.

Your NeoGate TB400 is connected to your LAN and you have access to its web configuration interface.

You have one EuroISDN line connected to the 1st BRI port on the NeoGate.

You have two external phone numbers assigned to your EuroISDN line.

You know the signaling type for your ISDN line (point-to-point or point-to-multipoint).

In the example below:

The Kerio Operator IP address is 10.1.2.95.

The NeoGate TB400 IP address is 10.1.2.200.

The two external phone numbers are 300123456 and 300123457.

NeoGate TB400 configuration

Connect to the web administration interface of your TB400 and do the following steps:

1. Go to the BRI Settings> Module List screen and open the edit dialog for module BRI1.

2. Set Signaling toBRI-CPE or BRI-CPE-PTMP depending on whether your line uses point-to-point or point to
multi-point signaling, respectively.

3. Switch to the DODSettings section in the edit dialog and key in the first external phone number (300123456) in
both theDODstart from and Associated numberstart from fields.

4. Click AddDOD and add your second external number (300123457) as done in the previous step.

5. Click Save to close the edit dialog.
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Screenshot 12: Configuring externalnumbers

6. Go to the SIPSettings> Trunkscreen.

7. Select VoIPAccount.

8. Set the Type field toSIP and Transport toUDP.

9. Type your first external phone number (300123456) into the Account field.

10. Type some complex password into the Password field.

11. Click Save.
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Screenshot 13: Configuring VoIP account in TB400

12. Click ApplyChanges.

IMPORTANT
Youmay encounter a situation with gateway not using the DOD numbers on the BRI interface correctly until
restarted. So youmay also want to restart NeoGate at this point

Kerio Operator configuration

1. Connect to your Kerio Operator administration GUI and go to the Call Routing screen.

2. Create a new SIP interface. Enter your external numbers separated with comma in the first screen of the Add SIP Inter-
facewizard. For example,300123456,300123457.

3. In the second screen of the Add SIP Interfacewizard, select an extension to receive calls from this interface and set a
dial-out prefix (in our example, let’s use 9 as the prefix).

4. Enter the following values in the third screen:

a. Key in the gateway’s IP address (10.1.2.200) in the Hostnameor IPaddress field.

b. Port number should be 5060.

c. The Username should be your phone number (300123456).

d. Key in your TB400 VoIP account password.

e. Must registerwith the RegistrarorProxy should remain checked.

You can now place some test calls. Use the prefix you have assigned to the new SIP interface to call via NeoGate TB400.

2.8.7 Configuring Kerio Operator andWell/Yeastar NeoGate TG200 for calls between SIP andGSM

Yeastar NeoGate TG200 (Well NeoGate TG200 in some countries) is a SIP-to-GSM gateway. The gateway can be
equipped with one or two GSM modules and supports at most two parallel calls.
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NOTE
This information is designed for Kerio Operator 2.4 and newer.

Prerequisites

To complete the configuration, you need:

Kerio Operator up and running.

At least one other SIP phone that allows you to place a test call.

The NeoGate TG200 gateway connected to your LAN.

At least one SIM card inserted into NeoGate TG200 and the SIM card’s PIN number in the NeoGate’s web con-
figuration.

In the example below:

The Kerio Operator IP address is 10.1.2.95.

The NeoGate gateway IP address is 10.1.2.200.

The SIM card number is 700123456.

Configuring NeoGate TG200

Connect to the web administration interface of your NeoGate TG200:

1. Go to SIPSettings> Trunk.

2. Select the VoIPAccount option.

3. Set the Type field to SIPand Transport toUDP.

4. In the Account field, key in the SIM card number.

5. In the Password field, key in a password. Use this password when configuring the SIP interface.

6. Click Save.

Screenshot 14: Configuring VoIP account in TG200



KerioOperator 2Getting started |107

7. Go to Route Settings> Outgoing Routes.

8. Add a new outgoing route.

NOTE
The default route in NeoGate TG200 does not work when calling numbers in the international format with “+” at the
beginning.

If you need the international format when calling back, add another route as a workaround:

1. Go to Route Settings> Outgoing Routes.

2. Add a new outgoing route.

3. In the NewOutgoing Route dialog box, key in a new route name in the RouteName field.

4. In the Dial Pattern field, key in the +X. string.

5. Move at least one GSM module fromAvailable Trunks to Selected.

6. Click Save.

Screenshot 15: The route to handle the internationalnumber format in TG200

Configuring Kerio Operator

1. In the administration interface of Kerio Operator, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.
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3. Key in a name for the interface. The name must not contain spaces or special characters and must be unique.

4. SelectNew provider.

5. In the With external number field, key in the SIM card number and click Next.

6. Select an extension that receives all calls.

7. In the Prefix to dial out field, key in a prefix for outgoing calls (7 in our example) and click Next.

8. In the Domain (IPaddress/hostname) field, key in the IP address of the NeoGate TG200 gateway.

9. In the Username field, key in the SIM card number and key in the Passwordconfigured for the VoIP account in the
gateway.

10. Select the Required to registeroption and click Next.

11. Verify the information in the Summary section and click Finish.

You can now place some test calls. Tomake a call via the NeoGate TG200 gateway, use the prefix for outgoing calls
configured for the gateway.

NOTE
Kerio Operator adds the interface prefix and extends the number (7+4411234567 in our example). To call back, you
can dial the extended number because of the additionally configured outgoing route.

2.8.8 Configuring Kerio Operator and Yeastar NeoGate TE100 for calls over analog lines

Yeastar NeoGate TE100 is an analog-to-SIP gateway with a single E1/T1/J1 port that supports the PRI standard. You can
use this device with Kerio Operator tomake calls over the telephone network.

Learn how to integrate Kerio Operator with Yeastar NeoGate TE100.

Prerequisites

To complete the configuration, you need:

http://www.yeastar.com/Products/PRI-VoIP-Gateway-TE100
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Kerio Operator up and running.

At least one internal extension.

The Yeastar NeoGate gateway connected to the same LAN as Kerio Operator.

In the example below:

The Kerio Operator IP address is 192.168.62.107.

The Yeastar NeoGate gateway's IP address is 10.1.2.200.

The trunk of numbers from the provider is 555 12xx.

The internal extension number is 100.

Configuring Yeastar NeoGate TE100

1. In the administration interface of the Yeastar NeoGate gateway, click Gateway.

2. In the Digital Trunksection, click to open the trunk configuration.

3. In the ModeType field, select:

E1 in Europe.

T1 in the USA.

3. In the Linecoding field, select:

HDB3 in Europe.

B8ZS in the USA.

4. In the Framing field, select:

Enable CRC4 in Europe.

ESF in the USA.

5. In the Switch Type field, select:

Euro ISDN in Europe.

national in the USA.
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6. Click Save.

After you finish configuring the trunk, you need to verify that the gateway is connected:

1. Click the Statusbutton in the upper right corner.

2. Go to SystemStatus> E1/T1Status.

3. Verify thatAlarm indicates Connect.

After verifying the gateway connection, continue with the configuration:

1. Go toVoIPSettings> VoIPTrunkand remove all default VoIP trunks.

2. Click AddVoIPTrunk to open the AddNew Account dialog box.

3. In the TrunkType field, select Service Provider.

4. Key in a name for the VoIP trunk. For example,My Operator.

5. Key in the IP address (192.168.62.107) of Kerio Operator.
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6. Click Save.

7. Go to Route Settings> Route List.

8. Click to edit the E1_to_SIP route.

9. In the SendCall Through field, select ServiceProvider — MyOperator and click Save.

10. Click to edit the SIP_to_E1 route.

11. In the Call Comes in From field, select ServiceProvider — MyOperator and click Save.

12. Click ApplyChanges in the upper right corner.

Configuring Kerio Operator

1. In the administration interface of Kerio Operator, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.

3. Key in a name for the interface (for example, the name of the gateway). The name must not contain spaces or special
characters and must be unique.

4. SelectNew provider.

5. In the With external number field, key in the number 555 12xx and click Next.
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6. Select an extension (100) that receives all calls.

7. Optionally, in the Prefix to dial out field, key in a prefix for outgoing calls and click Next.

8. In the Domain (IPaddress/hostname) field, key in the IP address (10.1.2.200) of the Yeastar NeoGate gateway.

9. Verify the information in the Summary section and click Finish.
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2.8.9 Configuring PRI telephone service through theDigium VoIPMedia Gateway

You can connect Kerio Operator to a Primary Rate Interface (PRI) telephone service. This requires a gateway device or
adapter to convert the voice media into a signal that Kerio Operator can process. The following topic covers the
necessary steps to configure Kerio Operator with the Digium G200 VoIPMedia Gateway.

Installing the Digium VoIP Media Gateway on the network

The device obtains an IP address automatically when connecting to the network. You can identify the device's IP address
from your network DHCP server. If you use Kerio Operator as the DHCP server you can locate the leased IP address from
Configuration > Network> [DHCPleasesbutton].

Connecting to the Digium VoIP Media Gateway

1. Input the IP address of the device into the web browser of a management computer located on the same network.
Youmust connect using a secure (HTTPS) type of connection.

2. Login to the device asAdminwith the password Admin

3. After logging into the device, you can assign a static IP address and configure a new administration password. Refer
to the Gateway User’s Manual for details.

https://www.digium.com/products/voip-gateways/g200
http://docs.digium.com/gateway/gateway-manual.pdf
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Configuring the Digium VoIP Media Gateway

Adding a SIP endpoint

A SIP endpoint defines the credentials that Kerio Operator uses to register with the gateway device.

1. Locate Configuration > SIPendpoints

2. Add a new SIP endpoint and input the following parameters:

Name: Custom name for the SIP endpoint (e.g., operator).

Username: The SIP username that Kerio Operator uses to register.

Password: The SIP password that Kerio Operator uses to register.

Registration: Select Endpoint registerswith thisgateway.

All other parameters should use the default setting.

Adding call routing rules

The Digium device can support multiple SIP endpoints and PRI/BRI interfaces. Therefore it is necessary to create rules
that define where to route incoming and outgoing calls. Locate Configuration > Call Routing Rules.
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Create a rule to direct calls from the PRI/BRI interface to the SIP endpoint:

From: Choose the PRI/BRI port (e.g.,port1).

To: Choose the SIP endpoint (e.g., operator).

Match: Choose All.

DID Manipulation:None.

Create another rule to direct calls from the PRI/BRI interface to the SIP endpoint. Use the same parameters as the previous
rule, with the From and To values in reverse order.

NOTE
If you have multiple PRI/BRI interfaces you should create a Call Routing Group that includes each connected PRI
interface. Refer to this group when configuring Call Routing Rules.

Registering Kerio Operator to the Digium device

Locate Configuration > Call Routing in the Kerio Operator administration. Add a SIP interface and configure the
following parameters:

Interface name: A label for the SIP interface.

New provider with external number: Input the phone number(s) assigned by your telephone service provider.

Incoming calls: Specify where to route incoming calls.

Outgoing calls: Define a prefix if desired.

Domain, hostname or IP address: IP address of the Digium device.

Username: The username assigned to the SIP endpoint.
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Password: The password assigned to the SIP endpoint.

Required to register with Registrar: Enable this option.

After you add the SIP interface, edit the interface and go to the SIPdetails tab. Locate the Authentication username
field and define the username of the SIP endpoint.

NOTE
Youmay need to contact your telephone service provider to ensure that they do not remove digits from the
telephone number when routing incoming calls to your PRI service. You can refer to the security log to verify the
details of rejected calls.
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Checking connectivity status

You can review the status of the SIP endpoints and PRI ports from the administration of the Digium device. Locate the
Diagnosticsdialog. Review the Network, SIPEndpoints, and T1/E1 Interfaces to verify successful connectivity of all
configured items.

2.8.10Connectionwith Linksys SPA3102 analog (FXS/FXO) to SIP gateway

Linksys SPA3102 is an analog-to-SIP gateway equipped with one FXS and one FXO telephone port.

NOTE
This information is designed for Kerio Operator 2.4 and newer.

Learn how to configure SPA3102 gateway with Kerio Operator over the FXO interface.

Prerequisites

To complete the configuration, you need:

Kerio Operator up and running.

At least one internal extension.

The PSTN line connected to the Line port of the SPA3102 device.

The SPA3102 gateway connected to your LAN through only one port.
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IMPORTANT

The Linksys SPA3102 gateway has its own DHCP server in the Ethernet (LAN) interface and a DHCP client in the
Internet (WAN) interface. If you already have another DHCP server in your LAN, do not connect the Ethernet
interface of the gateway. Follow the steps in the installation guide of the device.

After the installation of the device:

1. Connect the Internet port to your LAN.

2. Connect an analog phone to the Phone port of the SPA3102 gateway.

3. Dial **** to access the voice menu.

4. Dial 110# to obtain the IP address of the device.

5. To enable web administration on the WAN port of the SPA3102 gateway, dial 7932# 1#.

In the example below:

The Kerio Operator IP address is 10.1.2.95.

The Linksys SPA3102 gateway IP address is 10.1.2.200.

The PSTN number is 123456.

Configuring Kerio Operator

1. In the Kerio Operator administration interface, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Click Add SIP Interface.

3. Key in a name for the interface. The name must not contain spaces or special characters and must be unique.

4. SelectNew provider.

5. In the With external number field, key in the PSTN number and click Next.

6. Select an extension that receives all calls.

7. In the Prefix to dial out field, key in a prefix for outgoing calls (9) and click Next.

8. In the Domain (IPaddress/hostname) field, key in the IP address of the Linksys SPA3102 gateway.

9. Key in an username (spa3102) and a password (pass123456).

10. Disable the Required to registeroption and click Next. The gateway does not behave as a SIP registrar, so Kerio
Operator must authenticate before each call.
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11. Select the Edit detailsof the created interface option and click Finish.

After you finish the configuration, the Edit External Interface dialog box opens:

1. Go to the SIPDetails tab.

2. In the Outboundproxy field, key in the IP address of the gateway and the port,10.1.2.200:5061. The
Inboundproxy field leave empty.

3. Click OK to save your settings.

Configuring the Linksys SPA3102 gateway

1. Connect to the Linksys SPA3102 web administration interface and go toVoice > Advanced:

2. Go to Line 1, in the Line Enable field select no, and click Submit All Changes to save your settings.

3. Go to PSTNLine and in the Line Enable field select yes.

4. In the SIPPort field, key in 5061.

5. Go to the ProxyandRegistration section:

a. In the Proxy field, key in the Kerio Operator IP address.

b. In the UseOutboundProxy field, select no.

c. In the Register field, select no.

d. In the UseOBProxyIn Dialog field, select no.

e. In the MakeCallWithout Reg field, select yes.

f. In the AnsCallWithout Reg field, select yes.

5. Go to the Subscriber Information section:
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a. In the DisplayName field, key in a new name (External Call in our example).

b. In the User ID field, key in the PSTN number.

c. In the Password field, key in the password configured for the SIP interface in Kerio Operator.

d. In the UseAuth ID field, select yes.

e. In the Auth ID field, key in the username configured for the SIP interface in Kerio Operator.

6. Go to the Dial Plans section and in the Dial Plan 8 field key in the S0<:123456@10.1.2.95> string.

7. Go to the VoIP-To-PSTNGatewaySetup section:

a. In the VoIP-To-PSTNGatewayEnable field, select yes.

b. In the VoIPCallerAuthMethod field, selectHTTPDigest.

c. In the One StageDialing field, select yes.

d. In the VoIPCallerDefault DP field, select none.

8. Go to the VoIPUsersand Passwords (HTTPAuthentication) section:

a. In the VoIPUser1Auth ID field, key in the username configured for the SIP interface in Kerio Operator.

b. In the VoIPUser1Password field, key in the password configured for the SIP interface in Kerio Operator.

c. In the VoIPUser1DP field, select none.

9. Go to the PSTN-To-VoIPGatewaySetup section:

a. In the PSTN-To-VoIPGatewayEnable field, select yes.

b. In the PSTNCallerAuthMethod field, select none.

c. In the PSTNRing Thru Line 1 field, select no.

d. Leave the PSTNCIDNumberPrefixoption blank.

e. In the PSTNCallerDefault DP field, select 8.
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NOTE

If your PSTN line provides the Caller ID service, in the PSTNCIDForVoIPCID field, select yes, and increase the value
for PSTNAnswerDelay (see step below), so the SPA3102 gateway can transmit the Caller ID using the FSK
modulation between the first and the second ring of the call before the start of the VoIP call to Kerio Operator.

10. Go to the FXO TimerValues (sec) section:

a. In the VoIPAnswerDelay field, key in 0.

b. In the PSTNAnswerDelay field, key in 0.

NOTE
To transfer the PSTN Caller ID to the VoIP side, key in the number of seconds that represents two rings on your PSTN
line.

11. Click Submit All Changes to save your settings.

2.9 Kerio Operator API
The Kerio Operator API enables you to programmatically access your Kerio Operator server to integrate with third-party
solutions or write scripts to automate specific tasks. The API provides all actions available in the client and administration
interfaces of the product. For example, you can add/remove users, update IP address groups, read logs, manage time
ranges, and much more.

Licensing

The API is part of Kerio Operator and is governed by the product’s license. In summary, the license to use Kerio Operator
also entitles you to use the API on your server. Third-party software vendors may distribute their applications both for free
or for profit. There is no royalty fee for using the API.

Get involved

A dedicated forum is available for sharing your ideas, questions, answers, and other feedback with the developer
community. You can participate in the forum at forums.kerio.com.

Introduction

The API is accessible via a secure, session based HTTP connection. All communication is formatted as a JSON string and
directed to a designated URL. For example, a request for the Kerio Operator administration API may go to:

https://server.example.com:4021/admin/api/jsonrpc/

The URL to access the API consists of the following parts:

http://forums.kerio.com/f/38/
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URL part Title Description

https:// Protocol The API uses HTTPS

server.example.com Hostname The Internet accessible hostname (domain name) of your server

:4021 Port The port number for accessing the API

/admin/api/jsonrpc/ File path The file path of the JSON interface

The Kerio Operator API is accessible via two separate interfaces that provide different functionality. The Kerio Phone
interface provides phone functionality such as adding favorites, reviewing recent calls, or setting up call forwarding. The
Kerio Operator Administration interface configures all server based functionality such as adding users, configuring SIP
interfaces, or assigning extensions. The port number and file path vary depending on the interface.

Refer to the table below:

Product interface Port File path

Kerio Phone 443 /myphone/api/jsonrpc/

Kerio Operator Administration 4021 /admin/api/jsonrpc/

Prerequisites

To access the API, you need a Kerio Operator user account. Depending on the interface, this may be a standard user
account, or an administrator account with elevated permissions. The type of account you use to authenticate determines
your permissions when accessing the API. In order to communicate with the API you need a framework for processing
the requests and managing the network connection. A common framework for these actions is PHP and cURL.

Authentication

The API uses a two step authentication process. The first authentication step involves a username and password, the
same type of account used to access the Kerio Operator interface. After successful authentication, the API returns a
randomized token, and a session cookie. All subsequent requests to the API must include the token and session cookie in
the HTTP headers of the connection. The method for handling the session cookie and token depends on the
framework used in your application. Refer to the example below for information on how you can manage authentication
to the API using cURL.

API Requests

All requests to the API must be encoded as a JSON string. The JSON string is an array consisting of the JSON version, an
identifier, the API method, and the parameters of the query. You can use a web browser to inspect the JSON request and
response for any interaction with the product interface. Refer to Inspecting the Kerio Operator API communication in
a web browser for details.

Example API Communication

The following example uses PHP and cURL to get the next available extension number.

//Custom variables
$api_cookie="/tmp/kerio-api-cookie";
$api_url="https://operator.example.com:4021/admin/api/jsonrpc/";
$api_user="admin-api";
$api_password="secretpassword”;

http://go.gfi.com/?pageid=kerioapi_help#CSHID=1989
http://go.gfi.com/?pageid=kerioapi_help#CSHID=1989
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//Initialize the cURL request
$ch = curl_init();
curl_setopt($ch, CURLOPT_URL, $api_url);
curl_setopt($ch, CURLOPT_HTTPHEADER, "Content-Type:ap-
plication/json");
curl_setopt($ch, CURLOPT_RETURNTRANSFER, true);
curl_setopt($ch, CURLOPT_SSL_VERIFYHOST, false);
curl_setopt($ch, CURLOPT_SSL_VERIFYPEER, false);
curl_setopt($ch, CURLOPT_COOKIEJAR, $api_cookie);
curl_setopt($ch, CURLOPT_COOKIEFILE, $api_cookie);

//Server login request to obtain the API token and session cookie
$api_login = array(

'jsonrpc' => '2.0',
'id' => 1,
'method' => 'Session.login',
'params' => array(

'userName' => $api_user,
'password' => $api_password,
'application' => array(

'name' => 'Sample app',
'vendor' => 'Kerio',
'version' => '1.0'

)
)

);
curl_setopt($ch, CURLOPT_POSTFIELDS, json_encode($api_login));
$return=json_decode(curl_exec($ch),true);
$token=$return['result']['token'];

//Verify the token, otherwise return the JSON response and exit
the script.
if ($token=="") {printf(htmlspecialchars($json_return)); exit();}

//Add the token to the cURL headers
curl_setopt($ch, CURLOPT_HTTPHEADER, array("Content-Type:ap-
plication/json","X-Token:".$token));

//Get the next available extension number
$api_query = array(

'jsonrpc' => '2.0',
'id' => '1',
'method' => 'Extensions.getNextValidNumber',
'params' => array()

);
curl_setopt($ch, CURLOPT_POSTFIELDS,json_encode($api_query));
$return=json_decode(curl_exec($ch),true);
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$next_ext=$return['result']['extensionNumber'];

curl_close($ch);

2.9.1 Inspecting Kerio Operator API communication in aweb browser

You can use a web browser to inspect the API communication used in Kerio Operator. This is helpful in case youwant to
learn how to adapt functionality into your custom application.

The web interfaces of Kerio Operator use XMLHttpRequest (XHR) to exchange JSON formatted data. Browsers display
this type of activity in the network details section of the developer view. You can find each JSON formatted request and
the corresponding response of any action you perform in the interface.

1. Log in to the Kerio Phone or Kerio Operator administration interface.

2. Enable the developer view in your browser.

3. Perform the action youwant to build into your application.

4. Locate the JSON requests and responses in your browser's developer view.

Using Google Chrome to obtain the API request for adding a user in Kerio Operator

1. In Google Chrome, enable the Developer Tools.

2. Log in to the Kerio Operator administration and create a new user. Formore information, refer to Creating user
accounts (page 193).

3. In the Google Chrome developer view, go to the Networkpanel. See Network panel overview for details.

4. Locate the resources named jsonrpc/ in the RequestsTable and select the first item. Note that you can also filter
the table results to display only API resources. In the filter box, type the string "jsonrpc".

5. In the preview area of the resource, select the Headers tab.

6. Expand Request Payload to view the formatted JSON request.

7. Browse each JSON resource and examine the payload details until you locate the resource that corresponds to your
action.

8. Click view source to show the unformatted JSON string.

https://developer.mozilla.org/en-US/docs/Web/API/XMLHttpRequest
https://developers.google.com/web/tools/chrome-devtools/
https://developers.google.com/web/tools/chrome-devtools/#network_panel
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Screenshot 16: JSON resources showing inDevelopers Tools
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3Using
This section contains information about:

3.1 Hardware phones and devices 126

3.2 Backups 144

3.3 CRM integration and desktop dialers 147

3.4 Monitoring 159

3.1 Hardware phones and devices
This section helps you configure and use hardware phones.

3.1.1 Hardware telephone basic usage 126

3.1.2 Configuring BLF on Polycom phones 130

3.1.3 Configuring Cisco / Linksys SPA phones to support more than three callers in a conference 130

3.1.4 Configuring SnomM300/M700 with Kerio Operator 131

3.1.5 Configuring the Aastra 6755i IP Phone with Kerio Operator 135

3.1.6 How to configure Busy Lamp Field (BLF) on Cisco SPA500S 137

3.1.7 How to configure Busy Lamp Field (BLF) on snomphones 139

3.1.8 How to configure Busy Lamp Field (BLF) on Well phones 141

3.1.9 Linksys/Cisco SPA: Setting the TFTP address without using the DHCP parameter 66 142

3.1.1Hardware telephone basic usage

Learn how to use common functions of hardware phones supported by Kerio Technologies).

Using loud speaker

Every telephone has a special button for loud speaker (speaker button). You can usually press this button either
before dialing or anytime during a call.

Using Do not Disturb

If you select Do not Disturb option (DnD), the phone will generate the busy tone to inform the other party that you are
not available.

Learn how to configure DnD in various supported hardware phones.

Cisco IP Phone 7960/7940

1. Press the Settingsbutton

http://www.kerio.com/operator/technical-specifications
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.

2. Scroll toCall Preferences and press Select.

3. Scroll toDoNot Disturb.

4. Press Yes.

Cisco SPA

1. Pressmore.

2. PressDnD.

Polycom IP 33x

1. PressMenu.

2. Select Features.

3. SelectDo not disturb.

For unblocking incoming calls, use the same sequence.

Forwarding calls

Most hardware phones support call forwarding. However, you can also set it in Kerio Phone too.

Conference calls

Most hardware phones also support conference calls. However, it is much easy and simple to use conferences in Kerio
Operator.

Transferring calls

When youwant to transfer a call, you usually have two options:

Attended transfer -you can connect with the third party, find out if the person is on the phone and make an
announcement.

Blind transfer - the call is transferred without any announcement.

Learn how to configure these options in various supported hardware phones.

Cisco IP Phone 7960/7940

Attended transfer

1. Initiate or answer the call.

2. Pressmore.

3. Press Transfer.

4. Dial the number to which youwant to transfer the call.

5. When the dialed number rings, press Transferagain, or wait for the other party's answer, announce the call and then
press Transfer.

6. Hang up if the party accepts the call.

http://go.gfi.com/?pageid=operator_help#cshid=938
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If the party refuses the call, return to the original call by pressing the Resume softkey.

Blind transfer

1. Initiate or answer the call.

2. Pressmore.

3. Press BlndXfr.

4. Dial the number to which youwant to transfer the call.

5. Terminate the call.

Cisco SPA

Attended transfer

1. Initiate or answer the call.

2. Press Trnsfer.

3. Dial the number to which youwant to transfer the call.

4. Wait for the connection.

5. Press Trnsferagain.

6. Hang up.

Blind transfer

1. Initiate or answer the call.

2. Press Trnsfer.

3. Dial the number to which youwant to transfer the call.

4. Press Trnsferagain.

5. Hang up.

Polycom IP 33x

Attended transfer

1. Initiate or answer the call.

2. Press Trans.

3. Dial the number to which youwant to transfer the call.

4. Wait for the connection.

5. Press Transagain.

6. Hang up.

Blind transfer

1. Initiate or answer the call.

2. Press Trans.
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3. Press Blind.

4. Dial the number to which youwant to transfer the call.

5. Hang up.

Snom 300

Attended transfer

1. Initiate or answer the call.

2. Press L1/L2 key (hold).

3. Dial the number to which youwant to transfer the call.

4. Wait for the connection.

5. Press Transferkey.

6. PressOKkey.

7. Hang up.

Blind transfer

1. Initiate or answer the call.

2. Press Transferkey.

3. Dial the number to which youwant to transfer the call.

4. PressOKkey.

5. Hang up.

Snom 320/821

Attended transfer

1. Initiate or answer the call.

2. PressHold key.

3. Dial the number to which youwant to transfer the call.

4. Wait for the connection.

5. Press Transferkey.

6. PressOKkey.

7. Hang up.

Blind transfer

1. Initiate or answer the call.

2. Press Transferkey.

3. Dial the number to which youwant to transfer the call.
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4. PressOKkey.

5. Hang up.

3.1.2 Configuring BLF on Polycom phones

BLF (Busy Lamp Field) is a light placed on a telephone device. BLF notifies you if another extension is busy or not.

Setting BLF on Polycom telephones is not as easy as on other telephones. You need to prepare a configuration file and
upload it to Kerio Operator.

Preparing a configuration file

Prepare a file with the following content:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?><attendant
attendant.resourceList.1.address="sip:10@192.168.12.91"
attendant.resourceList.1.label="Ten"
attendant.resourceList.2.address="sip:11@192.168.12.91"
attendant.resourceList.2.label="Eleven"/> <call
call.directedCallPickupMethod="legacy" call.directedCallPickupString="*8"/>

This example file enables two BLF buttons. Button one monitors extension 10 on Kerio Operator with IP address
192.168.12.91. This button is labeled Ten. A second button monitors extension 11 on same Kerio Operator and
has label Eleven. Call pickup PBX service is set to*8.

Upload the file to/var/tftp/polycom-0004f223510b-manual.cfg where 0004f223510b is a
phone hardware (MAC) address.

Uploading the configuration file to Kerio Operator

NOTE
The file must be uploaded via SSH using SCP.

Enabling SSH in Kerio Operator

Follow these instructions:

1. In the administration interface, go to Status> SystemHealth.

2. Click Taskswhile pressing the Shift key.

3. Select Enable SSH.

4. Connect to Kerio Operator via SCP (use for example WinSCP for Windows). For access, use username root and pass-
word of a Kerio Operator administrator.

5. Upload the file.

3.1.3 Configuring Cisco / Linksys SPAphones to supportmore than three callers in a conference

The Cisco / Linksys SPA phone models support 3-way calling, which allows up to three callers in a conference. In some
cases, youmay require more than three callers. In this scenario, administrators can configure conferences. To further
simplify the workflow, you can adjust the conference button of Cisco / Linksys phones to utilize a pre-configured
conference line. This allows the operator of the Cisco / Linksys phone tomove callers into the conference, without
requiring the caller to hang up and call back into the conference extension.

http://winscp.net/eng/download.php
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Configuring dedicated conference extensions

Each person whomay need to incorporate this type of conferencing should be assigned their own static conference
extension. For example, Alice may have extension 220, and Bob has extension 221. Their dedicated conference
extensions may be 3220 (for Alice) and 3221 (for Bob).

Adjusting the phone's conference button

Access the phone's web administration by entering its IP address into a browser (from a computer on the same network).
You can obtain the phone's IP address through the soft menu of the device, or from the 'Extensions' dialog in the Kerio
Operator administration. After entering the phone's administration, follow these steps:

1. Click the Admin login link in the top right corner (If the phone is automatically provisioned, youmay be prompted to
login).

2. If you are required to login, the user is 'admin' and the password is the master password assigned in the Config-
uration > Provisioned Phonesdialog (Additional information is available in Configuring automatic phone pro-
visioning).

3. Click the advanced link.

4. Go to the Ext 1 tab.

5. Locate the Conference BridgeURL input field.

The value of the Conference BridgeURL is the extension of the conference at (@) the host / IP of Kerio Operator. For
example, Alice's dedicated conference is 3220, so her conference bridge URL would be 3220@example.com (where
example.com is the hostname of your Kerio Operator). After inputting the value, click Submit All Changesat the bottom
of the page and allow the phone to reboot.

Operating conferences from the phone

By specifying a conference bridge URL, the action of the conference soft key will change, however the functional
behavior remains the same. To place callers into the conference, follow these steps:

1. Press the conf soft key while on an active call (this will place the caller on hold)

2. Make a new outgoing call

3. Once connected to the new party, press the 'confLx' soft key. This will move all parties to the conference.

4. Repeat steps 1 - 3 for each additional caller.

3.1.4 Configuring SnomM300/M700with Kerio Operator

Snom M300/M700 is a SIP-to-DECT base station working with M-series wireless handsets.

http://wiki.snom.com/M-series
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NOTE
This information is designed for Kerio Operator 2.4 and newer.

Kerio Operator provisions SnomM300 and M700 base stations, but youmust register handsets and assign internal
extensions to them tomake and receive calls.

Prerequisites

The base station connected to Kerio Operator.

At least one Snom handset.

At least one internal extension assigned to the phone.

To assign an extension to the phone:

1. Go to Provisioned Phones.

2. Select a phone and click Edit.

3. Click Add and assign an extension.

4. Click OK to save your changes.

Formore information, refer to How to add a phone (page 172).

Configuring the base station and the handset

After Kerio Operator provisions the base station and you receive the IP address and password, you need to register the
handsets and then assign the internal extensions in the base station's administration interface.
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Registering the handset

To see the handset in the base station's administration interface, youmust register the handset first:

1. Open the main menu of the Snom handset and go toConnectivity.

2. Select Register.

3. Key in a password of the handset and click OK.

The handset then registers to the base station.

Assigning the internal extension to the handset

After you register the handset to the base station, you need to assign an extension to the registered handset:

1. Log in to the administration interface of the Snombase station. See the official Snom wiki for more details.

2. Key in admin as the username and a password.

3. Click OK.

4. In the administration interface, go to Extensions.

5. In the Extensions table, click the number of the extension youwant to assign.

http://wiki.snom.com/M-series
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6. In the SelectHandset(s) table, select the handset youwant to assign that extension to.

7. Click Save.

The display name and the number of the internal extension display on the main screen of the handset. Make a test call
to verify the configuration of the handset.

Configuring time zones

To display your local time on handsets, youmust configure the time zone in the administration interface of the base
station:

1. Log in to the administration interface of the Snombase station.

2. Go to Timezone.

3. Disable the Set timezonebycountry/region option.

4. Set the Timezone.
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5. Click Save.

Your handsets now automatically display the local time.

3.1.5 Configuring the Aastra 6755i IP Phonewith Kerio Operator

This topic covers the basic configuration and usage of an Aastra 6755i IP phone with Kerio Operator.

NOTE
As of Kerio Operator version 2.3, this phone model can be automatically provisioned. Refer to the system
requirements for a complete list of auto-provisioned phones.

Provisioning a new line (SIP account)

To configure a new line, log into the web administration of the phone by typing the phone's IP address into your
browser. The default login for Aastra phones is admin/22222.

Navigate toAdvanced Settings> Line 1 and input the following values:

Screen Name - The name that will appear on the phone's LCD.

Phone Number - Your extension.

Authentication Name - Your SIP login name (e.g. 230p1).

Password - Your SIP password.

NOTE
Before configuring the line, make sure you've created an extension in Kerio Operator.

Proxy Server - The IP Address or hostname of Kerio Operator.

Registrar Server - The IP Address or hostname of Kerio Operator.
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Configuring Busy Lamp Field (BLF)

Busy Lamp Field (BLF) allows the phone operator to view the status of other extensions, using an LED indicator. There is
also an associated button next to the indicator, which acts as a speed dial to the extension being monitored.

The Aastra 6755i includes 12 programmable buttons / indicators that can be used for various functions, including BLF.
The actions for these buttons are located under SoftkeysandXML, and Programmable Keys. Both configuration dialogs
offer the same functionality, however the softkeys label and accessibility can change based on the phone's status, while
the labels of the programmable keys are static.

To set a button for BLF, select BLF from the pull down menu under the type column. The value will be the extension you
want tomonitor. In case of call parking, this will be any one of the assigned parking slots (e.g. *51).
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Parking a call

Call parking is a feature that allows you to transfer a call to a temporary holding extension, which can then be joined
from another phone. Before anyone can park a call, a range of parking slots must be defined in Kerio Operator. For
configuration details refer to the KB topic Configuring and using call parking. To park an active call, press the Xfer
(transfer) soft key. Then press the button which has been designated as a parking slot. Wait until you've been connected
to the parking slot, then press again the Xfer button. The caller is then put into the parking slot, and will hear hold music.
You can then hang up the phone.

NOTE
If nobody picks up the call within the defined timeout period (40 seconds by default), the caller will be bounced
back to the person who parked the call.

Joining a parked call

If you have configured BLF with a parking slot, the LED will indicate that there is a parked call on that parking slot. To join
the call, simply press the button and the phone will speed dial to the extension of that parking slot.

3.1.6How to configure Busy Lamp Field (BLF) on Cisco SPA500S

Busy Lamp Field (BLF) feature allows users tomonitor several other extensions. Sometimes, the term "Direct Station
Selection” is used for the same functionality. State of the monitored extensions is usually indicated by a series of LED
lights with buttons.

1. Idle state – LED is green

2. Error state – LED is orange

3. Ringing state – LED is red (blinking)

4. Busy or Connected state – LED is red

The "Call Pickup” function is usually configured together with BLF allowing, for example, a receptionist to pickup ringing
calls with a press of a single button.

Kerio Operator configuration

Busy Lamp Field

There is no configuration needed tomake BLF work.
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Call Pickup

Enable the Call Pickup feature and configure an extension (e.g. "**”). When dialing "**10” while extension 10 is ringing,
the call will be redirected to your phone.

Phone configuration

This guide has been tested on a Cisco IP Phone SPA508G (firmware 7.4.8a) with an attendant console SPA500S (hw 1.0.6,
sw 2.0.2).

1. Open the phone administration in your browser (eg. http://192.168.1.10).

2. Login as administrator and open advanced configuration.

3. Select the Attendant Console screen.

4. Set Subscribe Expires to1800.

5. SetUnit 1Enable toyes.

6. SetUnit 2Enable toyes if you have a second SPA500S unit.

7. Set ServerType toAsterisk.

8. SetAttendant Console Call PickupCode to the extension of Directed Call Pickup followed by a # sign. When press-
ing a button, the # sing will be replaced by the extension number. Use "**#” for Directed Call Pickup at "**”.

9. Configure the unit keys. Use fnc=blf+sd+cp;sub=10@$PROXY tomonitor extension 10.

10. Don't forget to save the configuration.
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Call Parking

To park a call, use the xfer (transfer) soft key. Then dial to a designated parking slot (e.g. *53). If you have configured BLF
keys tomonitor parking slots, you can simply press the key which is monitoring the parking slot (e.g. *53). After you hear
the announcement youwill then hear the hold music. You can then press the xferLx (blind transfer) soft key to join the
caller into the parking slot. The caller is then parked, and you can hang up the call.

3.1.7How to configure Busy Lamp Field (BLF) on snomphones

Busy Lamp field (BLF) feature allows users tomonitor several other extensions. Sometimes the termDirect Station
Selection is used for the same functionality. State of the monitored extensions is usually indicated by a series of LED lights
with buttons.

Idle state – LED is off.

Ringing state – LED is blinking.

Busy or Connected state – LED is on.

The Call Pickup function is usually configured together with BLF allowing, for example, a receptionist to pickup ringing
calls with a press of a single button.

Operator configuration

Busy Lamp Field

There is no configuration needed tomake BLF work.

Call Pickup

Enable the Call Pickup feature and configure an extension (e.g. "**”). When dialing **10 while extension 10 is ringing,
the call will be redirected to your phone.

Phone configuration

Follow these steps on snom 360 (firmware 8.4.18) and snom 820 (firmware 8.4.32).

1. Open phone administration in your browser (eg. http://192.168.1.10).

2. Make sure that the phone is running firmware version 8.

3. View screen Setup> Function Keys.
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4. Configure BLF function on the buttons P1...Px and set:

a. First field toActive

b. Second field toBLF

c. Third field to<sip:extension@ipAddress;user=phone>|callPickup. Here

extension is the monitored extension (e.g. 10).

ipAddress is the IP address of Operator (e.g. 192.168.1.1).

callPickup is the Call Pickup extension (optional).

For example,<sip:10@192.168.1.1;user=phone>|**. In this example,** signifies that extension 10
doesn't use the Call Pickup feature.

5. Don't forget to save the configuration.

Call Parking

To park a call, first place the caller on hold. Then dial to a designated parking slot (e.g. *53). If you have configured BLF
keys tomonitor parking slots, you can simply press the key which is monitoring the parking slot (e.g. *53). After you hear
the announcement youwill then hear the hold music. You can then press the transfer button to join the caller into the
parking slot. The caller is then parked, and you can hang up the call.
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3.1.8How to configure Busy Lamp Field (BLF) onWell phones

Busy Lamp field (BLF) feature allows users tomonitor several other extensions. Sometimes the term "Direct Station
Selection” is used for the same functionality. State of the monitored extensions is usually indicated by a series of LED
lights with buttons.

1. Idle state – LED is off

2. Ringing state – LED is blinking

3. Busy or Connected state – LED is on

The Call Pickup function is usually configured together with BLF allowing, for example, a receptionist to pickup ringing
calls with a press of a single button.

Operator configuration

Busy Lamp Field

There is no configuration needed tomake BLF work.

Call Pickup

Enable the Call Pickup feature and configure an extension (e.g. "**”). When dialing "**10” while extension 10 is ringing,
the call will be redirected to your phone.

Phone configuration

This guide has been tested on Well SIP-T28p (firmware 2.60.9.5).

1. Open phone administration in your browser (eg. Http://192.168.1.10).

2. View screen Phone> DSSKey.

3. Configure BLF function on the keys DSS Keys. Set:
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a. Type toBLF.

b. Value the monitored extension (e.g. 10)

c. Extension to the Call Pickup extension + extension number. (e.g. **10). This field is optional.

4. Don't forget to save the configuration.

NOTE
It might take a while for phones to subscribe for notifications after Operator is rebooted. In this case either wait up to
10 minutes or reboot the phone.

3.1.9 Linksys/Cisco SPA: Setting the TFTP addresswithout using theDHCP parameter 66

Use this topic, if:

You want to use phone provisioning.

Your DHCP server does not support parameter 66.

You use the Linksys/Cisco SPA phone.

Setting the TFTP address without using the DHCP parameter 66 for Linksys SPA942

1. In a web browser, type the IP address assigned to the phone.

2. In the phone configuration, click Admin Login > Advanced> Provisioning.

3. Enter the TFTP address in Profile Rule for in the following format:tft-
p://Kerio.Operator.IP.address/spa942$MA.cfg

4. Click Submit All Changes.

5. After the phone restarts, restart the phone manually again. In the web browser, type the following address:
http://phone.IP.address/admin/reboot
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Screenshot 17: Configuring the Linksys/Cisco SPAphone

Profile rules for other Linksys/Cisco SPA telephones

Other Linksys/Cisco SPA telephones can have different administration interfaces, however, option Profile Rule is available
in all telephones.

We prepared a list of profile rules for you:

Type Profile Rule

Cisco 7940,7960 N/A

Cisco 7941,7961,7960G,7940G N/A

Cisco SPA112 tftp://<ip>/_spa112<mac>.cfg

Cisco SPA122 tftp://<ip>/_spa122<mac>.cfg

Cisco SPA301 tftp://<ip>/Cisco/SPA301/<mac>.cfg

Cisco SPA303 tftp://<ip>/Cisco/SPA303/<mac>.cfg

Cisco SPA3102 tftp://<ip>/_spa3102<mac>.cfg

Cisco SPA501G tftp://<ip>/Cisco/SPA501G/<mac>.cfg

Cisco SPA502G tftp://<ip>/spa504G<mac>.cfg
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Type Profile Rule

Cisco SPA504G tftp://<ip>/Cisco/SPA504G/<mac>.cfg

Cisco SPA508G tftp://<ip>/Cisco/SPA508G/<mac>.cfg

Cisco SPA509G tftp://<ip>/Cisco/SPA509G/<mac>.cfg

Cisco SPA525G tftp://<ip>/spa525G<mac>.cfg

Cisco SPA525G2 tftp://<ip>/Cisco/SPA525G2/<mac>.cfg

Linksys PAP2T tftp://<ip>/_pap2t<mac>.cfg

Linksys SPA1001 tftp://<ip>/Linksys/SPA1001/<mac>.cfg

Linksys SPA901 tftp://<ip>/spa901<mac>.cfg

Linksys SPA921 tftp://<ip>/spa921<mac>.cfg

Linksys SPA922 tftp://<ip>/spa922<mac>.cfg

Linksys SPA941 tftp://<ip>/spa941<mac>.cfg

Linksys SPA942 tftp://<ip>/spa942<mac>.cfg

Linksys SPA962 tftp://<ip>/spa962<mac>.cfg

3.2 Backups
This section provides information about server backup and data recovery.

3.2.1 Saving Kerio Operator configuration toMyKerio 144

3.2.2 Saving Kerio Operator configuration to FTP/SFTP or local storage 145

3.2.1 Saving Kerio Operator configuration toMyKerio

NOTE
This information is designed for Kerio Operator 2.5 and newer.

Kerio Operator can automatically back up and upload the configuration files toMyKerio every day.

Each backup can include:

Configuration files

Local voicemail data

System logs

Call history log

License

Recorded calls

Custom provisioning files /var/tftp

To configure backup to an FTP server instead, read the Saving configuration to FTP server topic.

https://www.kerio.com/mykerio
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Saving configuration to MyKerio

Before you start, connect your Kerio Operator to MyKerio. For details, read Adding Kerio Operator to MyKerio.

Once Kerio Operator is connected toMyKerio:

1. In the administration interface, go toAdvancedOptions> Backup andRecovery> Remote Backup.

2. In Type, selectMyKerio.

3. Select Enable automatic dailybackup.

4. Set the starting time and the period.

5. Click Apply.

Kerio Operator uploads configuration files once a day.

Restoring configuration from a backup

To learn how to restore your configuration from a backup, read the Backups in MyKerio topic.

3.2.2 Saving Kerio Operator configuration to FTP/SFTP or local storage

Kerio Operator can backup the following items:

System configuration — system settings, IVR (auto attendant scripts), users, logos, firmwares etc.

Local voicemail data— if you use integration with Kerio Connect, Kerio Operator sends voicemails via IMAP to Kerio
Connect. These voicemails are not backed up.

http://go.gfi.com/?pageid=mykerio_help#CSHID=1929
http://go.gfi.com/?pageid=mykerio_help#CSHID=1897
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SSL certificate — only an active SSL certificate is backed up.

System logs — all logs from the Logs section.

Call history log — all logs from the Status> Call History section.

License — a .key file with your licence.

Recorded calls — locally saved recorded calls. You can also back up recorded calls to a FTP server.

Custom provisioning files /var/tftp

Saving backups at a remote FTP/SFTP storage

1. Configure a FTP or SFTP server for storing the backup. Formore information, refer to Configuring Remote
FTP/SFTP Storage (page 305).

2. In the administration interface, go toAdvancedOptions> Backup andRecovery.

3. Under Remote Backup, select Type as either FTP/SFTP. In case of FTP/SFTP also set the Numberof files to keep.

4. Verify the path to the remote storage type and test the settings using the Backupon Remote Storage button.

5. Check Enable automatic backup to remote storage to periodically perform automatic backups if required.

6. In the Start at field, specify the time of taking a backup.

7. In the Period field, specify how often backups should be performed.

8. Next toContent, click Edit and select content types for backup. By default, Kerio Operator backs up only a system con-
figuration.

9. Save the settings.

Saving a backup locally

1. In the administration interface, go toAdvancedOptions> Backup andRecovery.

2. Under Backup, click Download Backup File.

3. Select a backup content. By default, Kerio Operator creates a full backup.

4. Click Create Backup forDownload.

5. Click Download and save the file.

Recovering data from a backup

1. In the administration interface, go toAdvancedOptions> Backup andRecovery.

2. Click Upload Backup File.

3. Select the file and upload the backup to Kerio Operator.

4. When the Recoverydialog box appears, select the configuration and data for recovery.

5. Click Recovery.

6. Click OK to restart.

After the restart, the backup recovery is complete.

NOTE
After restoring from a backup, restart your browser in order to log back into the administration interface.
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3.3 CRM integration and desktop dialers
This section helps you integrate with CRM systems and desktop dialers.

3.3.1 Salesforce integration with Kerio Operator 147

3.3.2 Using Kerio Operator App for Salesforce 150

3.3.3 Configuring OutCALL for dialing from the Microsoft Outlook contacts 154

3.3.4 CRM integration using the AMI 158

3.3.1 Salesforce integrationwith Kerio Operator

NOTE
Lightning Experience from Salesforce doesn't allow the settings described below. Switch to Salesforce Classic to
complete the configuration.

Kerio OperatorApp forSalesforce is based on Call Center. The Call Center is an application embedded in
Salesforce and integrates Salesforce with Kerio Operator. For more information about Call Centers, go to
https://help.salesforce.com/.

Kerio Operator App for Salesforce enables:

Click-to-dial.

Displaying contacts, accounts and leads during the call.

Logging calls into Salesforce.

To use Kerio Operator App for Salesforce, install the application. You can download it from Kerio Operator administration
interface.

Kerio Operator supports:

Salesforce Enterprise Edition

Salesforce Performance Edition

Salesforce Unlimited Edition

This topic helps you to install and configure Kerio Operator App for Salesforce. Formore information, refer to Using
Kerio Operator App for Salesforce (page 150).

Configuring Kerio Operator

Add the Salesforce hostname to Kerio Operator and download Call CenterDefinition for Salesforce.

1. In the administration interface, go to Integration.

2. In the Salesforce integration section, click Configure.

3. Login to your Salesforce and copy the Salesforce hostname. Paste the hostname to Salesforce hostname in Kerio
Operator.

https://help.salesforce.com/apex/HTViewHelpDoc?id=cti_overview.htm
http://www.salesforce.com/crm/editions-pricing.jsp
http://www.salesforce.com/crm/editions-pricing.jsp
http://www.salesforce.com/crm/editions-pricing.jsp
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4. Check if the Kerio Operator's hostname is complete. If the field is empty, type a correct Kerio Operator's hostname.

5. Save the settings.

6. Click DownloadCall CenterDefinition.

NOTE
The communication is based on HTTPS by default. Verify that port 443 is open in both directions and make sure that
the hostname of the SSL certificate matches the Kerio Operator hostname. Formore information, refer to
Configuring SSL certificates (page 258).

Configuring salesforce.com

Configuration is divided into three steps:

Step 1: Adding Kerio Operator Call Center

To add Kerio Operator Call Center to Salesforce, follow these steps:

1. In Salesforce, click your name and go to Setup.
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2. In the QuickFind, type Call Centerand click Call Centers in the results.

3. Skip the help page if it appears.

4. Click the Import button in the All Call Centerspage.

5. Click the Choose File button and select the call center definition file you downloaded earlier.

6. Click Import.

Kerio Operator Call Center (Kerio Operator App for Salesforce) is installed in Salesforce. Now add users to the call center.

Step 2: Adding users to the call center

To add users (your colleagues) from Salesforce to Kerio Operator Call Center, follow these steps:

1. In Kerio OperatorCall Center, click ManageCall CenterUsers.

2. Click AddMoreUsers.

3. Leave the form as it is and click Find.

4. Select users and click Add to Call Center.

The users appear in the Kerio OperatorCall Center:ManageUsers table.

Go toHome in the main menu. You can see the Kerio Operator Call Center application if your user account is added in
the Kerio Operator Call Center.
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Step 3: Installing the Kerio Operator Open CTI Package

Kerio Operator Open CTI Package enables searching salesforce contacts, accounts and leads in the Kerio Operator Call
Center application.

1. Go to Salesforce.

2. In the address bar of your browser, add this string after your Salesforce hostname (in our case it is https://eu2.-
salesforce.com/):packaging/installPackage.apexp?p0=04tb0000000QG2n ... The final res-
ult is similar to:
https://eu2.-
salesforce.com/packaging/installPackage.apexp?p0=04tb0000000QG2n

3. A PackageUpgradeDetailspage is opened.

4. On page PackageUpgradeDetails, click Continue.

5. On page KerioOperatorOpenCti, click Next.

6. SelectGrant access to all usersand click Next.

7. Click Install.

8. If you are successful, the application answers that the installation is complete.

You can test all features of Kerio Operator App for Salesforce. Formore information, refer to Using Kerio Operator App
for Salesforce (page 150).

Configuring number transformation for calls from Salesforce

Tomake calling via Kerio Operator App for Salesforce easy, add number transformations which ensure that numbers
are dialed correctly from Salesforce.

Formore information, refer to Using number transformation (page 206).

Configuring outgoing prefixes

You can also configure prefixes in Kerio Operator Call Center. However, number transformation is recommended.

1. Go to Kerio Operator Call Center.

2. Click Edit.

3. Change prefixes in the DialingOptions section.

4. Click Save.

Prefixes are the same for Kerio Operator and Salesforce now.

3.3.2Using Kerio Operator App for Salesforce

Learn how to use Kerio Operator App for Salesforce. If you need to install and configure Kerio Operator App for Salesforce,
go to Salesforce integration with Kerio Operator .

Log into Kerio Operator App for Salesforce

Dialing of numbers is available to all users who use a software or hardware phone which has an extension of the Kerio
Operator PBX configured. If the telephone is connected, it is possible to dial the called number using Kerio Operator App
for Salesforce.

Before using the Kerio Operator App for Salesforce, you will be prompted to login:
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1. Login to Salesforce, go toHome. You can see Kerio Operator App for Salesforce.

Screenshot 18: Kerio OperatorApp for Salesforce onHomepage

2. To login to Kerio Operator App for Salesforce, type Kerio Operator credentials (the same credentials as for Kerio
Phone).

3. Click Login.

If you succeed, the application is open and the extension is idle.

Screenshot 19: A successfull loginwith a registered extension

If your extension is offline, you have not registered phone extension. You should do the following:

If you have more extensions, change the extension (click your name and select the extension).

Check that your phone is working.

Contact your system administrator.

Dialing calls (click-to-dial) from Salesforce

To dial the number, click any number marked as a phone number.

Dialing in Salesforce works on a callback basis. This means that Kerio Operator App for Salesforce connects directly with
the PBX and the PBX contacts back your phone. Therefore, the side effect of this operation is that upon clicking on Dial,
your phone starts to ring as well as the called person's one. Pick it up and wait for the called person to answer.
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Screenshot 20: The phone number

NOTE

If the phone icon is gray, used extension is offline. Formore information, refer to Log into Kerio Operator App
for Salesforce (page 150).

Displaying contact, account or lead during the call

Kerio Operator App for Salesforce can log all incoming and outgoing external calls. The call history (last five calls by
default) appears directly in Kerio Operator App for Salesforce. When you click on an item connected with the phone
number (it can be an account, contact or lead), the item appears and you can see the details of the caller.

Screenshot 21: Click to viewdetail

Call logging in Salesforce

You can log incoming and outgoing calls to the ActivityHistory in Salesforce.

1. In the Kerio Operator App for Salesforce, move your cursor onto contact, account or lead.
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Screenshot 22: Click to Log a call

2. When a text Clickto "Log a Call"appears, left-click. The Log a Callpage appears.

Screenshot 23: Log a Call dialog

You can edit a task immediately.

Advanced settings

Changing prefixes

If you need to change a prefix, click your name and selectDial out prefix.

If you are required to dial a prefix for outgoing calls, you can configure the Kerio Operator App for Salesforce to
automatically prepend dialed numbers with a prefix. If you need to assign a prefix, click your name and select dial out
prefix.

Changing a language

If you need to change a language of Kerio Operator App for Salesforce, click your name and select Change language.

Opening Kerio Phone from Kerio Operator App

If you want to open Kerio Phone directly from Kerio Operator App, click your name and selectOpen Kerio Operator
Client.

The advantage is that you do not have to fill the credentials twice.

Configuring a time zone

Salesforce time zone should be consistent with your computer:
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1. In Salesforce, go toMySettings.

Screenshot 24:My Settings

2. Click Personal.

3. Click Language&TimeZone.

4. Change the time zone and save the settings.

3.3.3 ConfiguringOutCALL for dialing from theMicrosoft Outlookcontacts

OutCALL allows you to dial calls directly fromMicrosoft Outlook 2000 and newer. It uses the AMI interface (Asterisk
Manager Interface) which Kerio Operator supports.

Download OutCALL at http://outcall.sourceforge.net/

What youneed

Microsoft Outlook 2000 or newer.

WARNING
OutCALL supports only the 32-bit version of Microsoft Outlook.

Password for dialer (AMI) generated in Kerio Operator.

Install and configure OutCALL on the user’s computer.

Settings in Kerio Operator

Read topic CRM integration using AMI for information on Kerio Connect settings. The standard settings are as follows:

1. Login to Kerio Operator as an administrator.

2. Open the Configuration > Users section.

3. Double-click the user whom youwish to enable the OutCALL communication.

4. This opens the Edit userdialog. In the event, go to the Advanced tab.

5. Check Password fordialer (AMI) and copy the password (displayed upon clicking on the icon with keys).

http://outcall.sourceforge.net/
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Screenshot 25: Dialer Password

Configuring OutCALL

1. On user’s computer, install Microsoft Outlook and create amail account (unless it has been created before).

2. Close Microsoft Outlook before installing OutCALL.

3. Download OutCALL at http://outcall.sourceforge.net/.

4. Install it on user’s computer.

5. If the installation was successful, run OutCALL. OutCALL will run as a service with an icon displayed in the notification
area (System Tray).

WARNING

Formore information, refer to Troubleshooting (page 157).

6. Right-click the icon. Context menu is displayed.

7. Select Settings.

8. This opens the OutCALL— Settingsdialog. Go to the Server tab.

http://outcall.sourceforge.net/
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Screenshot 26: OutCALL—configuring connection to Kerio Operator

9. In the Server field, enter the DNS name or IP address of Kerio Operator.

10. In the Username field, enter the username in the same format as it is used in Kerio Operator.

11. In the Password field, enter password for dialer (AMI).

WARNING

Password for dialer does not equal the username used to login to Kerio Phone.

12. Switch to the Extensions tab. The default extension is set to10. Click on Edit and enter the SIP username (the SIP
username format can be found in the Kerio Operatoradministration in section Extensions).

Screenshot 27: OutCALL— setting user extensions

13. Save the settings. Once the application connects to Kerio Operator, a pop up window is displayed informing about
the successful connection.
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Troubleshooting

OutCALL stopsworking after the start

OutCALL stops working after the start if the path to the folder contains special characters. OutCALL does not work on
localized versions of Microsoft Windows XP where the Application Data folder is localized (e.g. in Czech,"C:\Docu-
ments and Settings\user\Data aplikací"). The problem is solved on Microsoft Vista and newer
because the folder is not localized.

OutCALL stops working after the start if the username used for login to the computer contains special characters. The
solution is easy: change the username so that it does not contain special characters.

Logs

If you wish to verify the communication between OutCALL and Kerio Operator, look at the logs:

Screenshot 28: The Debug log—AMI

1. Login to Kerio Operator administration.

2. Go to section Logs> Debug

3. Right-click the log area and selectMessages.

4. This opens the Loggingmessagesdialog window. Check the AMI (CRMIntegration, DesktopDialerApplications)
option.



KerioOperator 3 Using |158

3.3.4 CRM integration using the AMI

Asterisk Manager Interface (AMI) is an interface which enables other applications to connect to Kerio Operator (which
includes Asterisk) and to communicate via the AMI commands. You can use it tomake phone calls. It enables you to:

dial calls from your CRM system,

monitor call statuses in your CRM system (e.g., create logs),

direct calls to another extension or terminate calls in your CRM system.

Connecting Kerio Operator with other applications

You can connect an application with Kerio Operator very easily. The settings are different for connections with a client
(the server-to-client connection) and with a server (the server-to-server connection).

How to connect a client application (desktop application for dialing numbers) with Kerio Operator

To connect the applications, you need the username and password of the client application user:

1. In the administration interface, go to Configuration > Users.

2. Select a user and open the Edit Userdialog.

3. Go to tab Advanced and check option Password fordialer (AMI).

4. Click on the icon and note down the displayed password.

5. Enter the username and password in the client application to authenticate.

How to connect a server (CRM system) with Kerio Operator

You need the authentication data which you enter to your CRM system:

1. In the administration interface, go toConfiguration > Integration > General.

2. Click Configure at Third partyCTI integration (AMI).

3. Check Third partyCTI integration isenabled.

4. Click Add.

5. Enter Account name (usually the name of the CRM system).

6. The password is generated automatically. Click on the icon and note down the password.

7. To test the communication, set the permissions to full control. If the communication is successful, youmay limit the per-
missions.

NOTE
Some applications allows you only to originate calls but they use asterisk commands which require a higher level of
permission (usually full control).

8. Login to your CRM system and enter the password for the AMI integration.

9. Test the communication by dialing an extension.

Application we have tried and prepared a configuration guide

Formore information, refer to Configuring OutCALL for dialing from the Microsoft Outlook contacts (page 154).

http://www.voip-info.org/wiki/view/Asterisk+manager+API
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What to do when communication fails

Consult the logs in Kerio Operator:

1. In the administration interface, go to section Logs> Debug.

2. Right-click on the log screen and select optionMessages in the context menu.

3. This opens the LoggingMessagesdialog box. Check the AMI (CRMIntegration, DesktopDialerApplications).

Configure the internal firewall of Kerio Operator

1. In the administration interface, go to sectionConfiguration > Network> Firewall and check the settings.

2. If your CRM system is located outside your local network, add its IP address in section Configuration > Definitions>
IPAddressGroups,

3. Go back to section Configuration > Network> Firewall and select a new IP address group for the integration with
the CRM system.

3.4Monitoring
This section contains information about:

3.4.1 Using Dashboard in Kerio Operator 159

3.4.2 Monitoring Kerio Operator 160

3.4.3 Managing logs in Kerio Operator 163

3.4.4 SNMP monitoring 164

3.4.5 Monitoring active calls 165

3.4.1UsingDashboard in Kerio Operator

Kerio Operator includes a customizable Dashboard. A dashboard consists of tiles and each tile displays a different type of
information (graphs, statistics, etc.). It gets displayed as you log into Kerio Operator.

It is also accessible fromConfiguration > Dashboard.
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3.4.2Monitoring Kerio Operator

When you are experiencing problems with your connection, we recommend you tomonitor the status of your PBX.

Monitoring can be done using the Status section:

Monitoring active calls

All current calls can be viewed under Status> Calls.

You can see a table where each call occupies one line and a graph displays a number of calls in time in the Calls section.

Go to the Calls section, especially in case that you plan to restart the PBX which may result in an undesired termination of
a call in progress.

Call History

The Call History section keeps a list of all internal and outbound calls of the PBX.

Call Historycan be viewed under Status> Call History.

To add or remove columns in the call history:

1. In the administration interface, go to Status> Call History.

2. Mouse-over a name of a column and click the arrow on the right side.

3. In Columns, you can:

select new columns to add them to the Call History,

deselect columns to remove them.
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Each line contains information about one call. The following actions can be applied to the call history:

Action Description

Export to aCSV file You can click on Advanced >Export to aCSV file to save the file on your local drive.

Clear Click on Advanced > Clear and confirm your decision in the corresponding dialog.

NOTE

Individual users can delete their history in the Kerio OperatorSoftphone. However, this operation only hides the
data. They are not removed from the PBX and logs.

Monitoring Recorded Calls

Section Status> RecordedCallsdisplays all calls recorded from call queues. This section displays a table where each
recorded call occupies one row. Select a call to listen to it, download it to your computer or remove it.

Click Settings to record calls locally or to a remote storage. Formore information, refer to Saving recorded calls (page
299).

Monitoring a Kerio Operator dial plan

A dial plan contains a list of all the used extensions and their users. You can export this list to a CSV file or print it.

Go to section Status> Dial Plan to see the list:

Export to CSV— the button exports the data in the format described in table.

ExtensionNumber Type ID Description

111 1 Winston Smith



KerioOperator 3 Using |162

ExtensionNumber Type ID Description

112 1 Ada Monroe

50 7 Voicemail

Changing the Dial Plan

If you use automatic phone provisioning and the change in your dial plan may affect automatically provisioned phones,
update of the phones configuration is needed. Kerio Operator detects such changes automatically and displays a
warning. If you confirm this warning, phones will be restarted at the time you selected in the dialog. You can restart the
phones later manually in section Provisioned Phones. To restart the phones, click on the Advanced> Restart all
phonesbutton.

Monitoring active conferences

All current conferences can be viewed under Status> Conferences. The window displays two tables. Each line in the
first table displays one conference. The second table displays information about individual conferences. Just select a
conference and the details in the bottom table are updated.

Monitoring call queues

All active call queues and their parameters can be observed in section Status> CallQueues. The window displays three
tables. Each line in the first table displays one call queue.

The other tables display agents and callers in a queue. Just select a queue and the details in table Agentsand Callersare
updated.

You can also reset the call queue statistics to start from zero. Use the Reset button.

SystemHealth

The administration interface allows you to view the status of CPU, memory and disk space of your computer with Kerio
Operator.

NOTE
In the Storage Space chart, the graph shows the used space and not the space available.

For example, if the graph shows 64% for the recorded calls it means that 64% is used for storing calls and then, other
files take up the other 36%.

System status can be viewed under Status> SystemHealth.

In this section, click Tasks to:

restart telephony subsystem

reboot Kerio Operator

power off Kerio Operator

do factory reset of Kerio Operator

The Support information link generates an asterisk configuration file and last 100 lines of all logs. This information may
be helpful especially when solving issues in cooperation with the Kerio Technologies technical support.

See detailed information about disk space usage by clicking on Details. This opens a dialog with information about disk
usage of audio files, voicemail and configuration file of Kerio Operator.
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3.4.3Managing logs in Kerio Operator

Logs are files where information about certain events (e.g. error and warning reports, debugging information) is
recorded. Each item is represented by one row starting with a timestamp (date and time of the event). Messages in logs
are displayed in English for every language version of Kerio Operator.

Configuring logs

Logs are available in the Kerio Operator administration interface in section Logs.

When you right-click in a log, you can configure the following settings (available in all logs):

Option Description

Save log You can save whole logs or a selected part in a txt or HTML format. See also Log Settings option.

Highlighting You can save any part of text in logs for better reference. Specify a substring or regular expression and all rows con-
taining such text will be highlighted.

Log Settings Apart from immediate savings, you can configure regular saves of individual logs, specifying the size and number of
saved files. You can also enable external logging to a Syslog server.

Clear Log Use this option for deleting a log.

Types of logs

Type Description

Auth The Auth log includes information about all successful attempts to login to Kerio Operator (to the administration or
client interfaces).
Failed login attempts are logged into the Security log.

Config The Config log stores the complete history of communication between Kerio Operator Administration and the server. It
is possible to determine what administration tasks were performed by a specific user.

Debug Debug log is a special log which can be used to monitor specific information. This is especially useful for problem-
solving.
To enable the Debug log, right-click in the log window and select the Messages option in the context menu. In the
opened dialog window, select specific information you wish to monitor.

WARNING

In addition, displaying too much information slows Kerio Operator's performance. We recommend that you only
display information that you are interested in and only when necessary.

Error The Error log displays serious errors that affect the functionality of the entire PBX. The Kerio Operator administrator
should check this log regularly and try to eliminate problems found here. Otherwise, users might have problems with
some services or/and serious security problems might arise.

Event The Event log gives information about phone and interface registrations, phone provisioning, new versions of Kerio Oper-
ator, etc.

Kernel The Kernel log contains records generated by the operating system. It includes information about starting and stopping
of the server, logs generated by individual processes, etc.

Security The Security log contains the failed login attempts to Kerio Operator.

Warning The Warning log shows error warnings which are not severe. Typical examples of such warnings are messages stating
that a user with administrator rights has a blank password or that a user account of a given name does not exist.
Events recalling warning messages in this log do not seriously affect the PBX functionality. However, they can point at
current or possible problems. The Warning log can help if for example a user is complaining that services are not
working.
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3.4.4 SNMPmonitoring

Enabling SNMPmonitoring in Kerio Operator

SNMP is a protocol which allows you tomonitor Kerio Operator status.

1. In the administration interface, go toNetwork> General.

2. Click Configure.

3. Check SNMPmonitoring isenabled.

4. In the Location field, type any text which will help you recognize the server and its location.

5. In the Contact field, type address which will help you recognize the server and its location.

6. Select which version to use — 2c (default password contains string public) or 3.

NOTE
Version 2c supports passwords as plain text only (community string), version 3 supports encryption. Some
monitoring tools, however, do not support version 3.

Using Cacti for SNMPmonitoring

Cacti is a standard monitoring tool which can handle the SNMP protocol.

If you use Cacti tomonitor your servers, go to cacti.net to acquire a template for Kerio Operator. It was created for Cacti 8.8
and newer and contains graphs similar to screen-shot below.

To import the template, follow these steps:

1. Connect to your Cacti with your browser.

2. Download the template archive and extract it.

3. Select Import Templates.

4. Click Choose File and select the XML template file.

http://www.cacti.net/
http://docs.cacti.net/usertemplate:host:kerio:operator
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Once the import is finished, go to the Devices section, add a new device, enter the DNS name of Kerio Operator and in
the Host Templatemenu select Kerio Operator.

3.4.5Monitoring active calls

NOTE
This information is designed for Kerio Operator 2.3 and newer.

Call monitoring allows you to participate in any active call by dialing a special prefix, followed by an extension.

You can use call monitoring in call centers where supervisors need tomonitor trainees during conversations with
customers.

WARNING
When you join an active call, the active callers have no indication that you have joined the call.

Call monitoring is protected by a PIN number. Whoever knows the PIN can listen to any extension in your telephony
subsystem. Therefore, we recommend to set special call permissions for people who can use the call monitoring
prefix.

The default prefix for call monitoring is *6, and it is configured in the PBX services. The prefix is disabled by default and
you have to enable it manually.

Configuring callmonitoring

To configure the call monitoring service, follow these steps:

1. In the administration interface, go to PBXServices.

2. Double-click Callmonitoring.

3. In the Edit Service dialog, you can change the service extension.
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4. Check the Service isenabled option.

5. Read the disclaimer carefully and click I Agree.

6. Click the keys icon and remember the PIN number. You can also change the PIN number. The PIN protects the call
monitoring frommisuse.

7. Select the Audiomode:

Listen only — muted: When joining an active call in listen only mode, there is no indication to the active
callers that you have joined the call.

Whisper to the extension only — muted only to remote party

Talk to both — unmuted

8. To allow users to change the audiomode with DTMF codes, check the Allow themonitoring user to change the
modeusingDTMF codes (4, 5, 6) option. Users can change the audiomode with a key on their phone devices (4 is for
Listen only, 5 is forWhisper to the extension onlyand 6 is for Talkto both).

9. Click OK.

The call monitoring service is configured.

Setting call permissions

Set a call permission group for users who can use the call monitoring feature (people who knows the PIN number):
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call monitoring is allowed on extensions, which can be monitored (rules 1, 2 and 3 in the figure)

other calls with *6 are forbidden (rule 4 in the figure)

Example:

The first three rules allow call monitoring on extensions 111, 112, 113:

1. In the administration interface, go toDefinitions> Call Permission Groups.

2. Click Add.

3. In the AddCall Permission Group dialog, add the name of the group.

4. In the Description field, type Group restricts call monitoring to listed extensions.

5. Click Add.

6. In the AddPrefixdialog, type *6111.

7. Switch the rule toAllowed and click OK.

8. Repeat the steps 5, 6 and 7 for extensions 112 and 113.

The fourth rule disables general usage of *6 prefix:

1. Click Add in the AddCall Permission Group dialog (it is still opened).

2. In the AddPrefixdialog, type *6.

3. Switch the rule toDenied and click OK.Now, you can compare your result with figure. They should be the same.

WARNING
The denial rule must be placed below the allowing rules.

4. Click OK in the AddCall Permission Group dialog.
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The group for call monitoring is established.

Now, youmust assign the group to users eligible to use the call monitoring prefix and know the PIN number:

1. In the administration interface, go toConfiguration > Extensions.

2. Select an extension assigned to John Smith (in figure it is extension 201) and click the Edit button.

3. In the Edit Extension dialog, change Call permissionsgroup toCallmonitoring group (see screenshot).

4. Click OK.

5. If the user has assigned more extensions, youmust set Callmonitoring group for all of them to avoid a risk of misuse
of the call monitoring.
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The cal monitoring group is assigned the user who is eligible to use the call monitoring prefix.

Using callmonitoring

To use the call monitoring service youmust know:

the service extension (*6by default),

the PIN,

the monitored extension (for example 111).

For extension 111, dial *6111 to listen to the conversation. Then, you will be asked for the PIN number. Now, you are
silently connected to the call on extension 111.

If you are connected to the 111 extension, you can change amode during the call (if allowed by the call monitoring
service):

press 4 for listen only mode

press 5 for whisper to the extension only

press 6 for talk to both

You can alsomonitor all employees in your office:

extensions in your office start with 11

five of them are assigned to employees (111, 112, 113, 114, 115)

If you dial *611, you can connect to the first ongoing call from all extensions starting with 11

If you dial *61, you can connect to the first ongoing call from all extensions starting with 1

If you dial *6, you can connect to the first ongoing call from all extensions of your telephony subsystem.

Pressing * key will look for another call tomonitor.
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WARNING

As you can see, the user can monitor all calls in your telephony subsystem. Therefore, it is important to set call
permissions for all users, who are eligible to use the call monitoring prefix.
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4 Settings
This section contains information about:

4.1 Phone provisioning 171

4.2 Accounts 192

4.3 Numbering 197

4.4 Call settings 208

4.5 PBX services 222

4.6 Security 255

4.7 Server settings 262

4.1 Phone provisioning
This section contains information about:

4.1.1 Configuring automatic phone provisioning 171

4.1.2 Provisioning of Kerio Operator Softphone for mobile devices 176

4.1.3 Accessing company contacts through LDAP on provisioned phones 178

4.1.4 Using provisioning tools 180

4.1.5 Editing provisioning templates 181

4.1.6 Displaying your company logo on the provisioned phones 182

4.1.7 How to configure phone provisioning on Polycom phones 184

4.1.8 Phone provisioning - wrong detection of CISCO phones 190

4.1.9 Uploading configuration files to Kerio Operator TFTP server 191

4.1.1 Configuring automatic phone provisioning

NOTE

Watch the Configuring automatic phone provisioning in Kerio Operator video.

Phone provisioning is used for automatic configurations of selected hardware SIP phones. Phone provisioning means:

phone automatically connects to the PBX after booting and is assigned a phone extension,

extensions are managed in the administration interface,

if you confirm or plan it, the systemwill perform an automatic restart of provisioned phones if needed,

phone firmware is automatically updated,

http://player.vimeo.com/video/99559897
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displaying a company logo on hardware phones supported by Kerio Operator

accessing company contacts through LDAP

NOTE
Automatic firmware update is not supported for the Polycom phones and the original Cisco phones (Cisco SPA is
supported). However, there is a possibility to update the firmware. You can upload all necessary files to folder
/var/tftp in Kerio Operator manually. Formore information, refer to Uploading configuration files to Kerio
Operator TFTP server (page 191).

IMPORTANT
Use of phone provisioning is not always suitable. If Kerio Operator is located and runs in the Internet, for security
reasons we do not recommend to use automatic phone provisioning.

What youneed

1. In your local network, you need a DHCP server supporting parameter 66 (TFTP server address). Enter the address of
Kerio Operator in this parameter.

NOTE

Formore information, refer to Configuring parameter 66 in DHCP server in Kerio Control (page 270).

2. Only selected phones support automatic phone provisioning.

3. Appropriate settings need to be done in Kerio Operator.

NOTE
If you wish to connect a phone which is not currently supported in Kerio Operator, you cannot use automatic
provisioning. The configuration must be done on the hardware phone.

How to add a phone

1. In the administration interface, go to Provisioned Phones> Hardware Phones.

2. Click Provisioning Settings. The configuration dialog windows is opened.

3. Check the Enable provisioning option. The option must be checked.

4. Check option Create new extension fornewlyregistered phones in case you create users locally (do not map them
from a directory service).

WARNING

The Create new extension fornewlyregistered phonesoption is checked by default. If you uncheck it, you cannot
use automatic remote phone restart — youwill have to restart phones manually if needed.

5. Each telephone must be authenticated when connecting to the PBX. Extension number and password are used for
SIP authentication (Master Password in this case). Option Masterpassword forphones isenabled enables to create one
password for all provisioned phones. The password is saved in the configuration file which is sent to the phone upon
the first connection to the network and the phone will use this password to authenticate at Kerio Operator. If you dis-
able option Masterpassword forphones isenabled, all phones will have their own passwords (it can be viewed in the
configuration dialog of each phone).

http://www.kerio.com/operator/technical-specifications
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Now the general environment for the provisioned phones is configured. Once a phone is connected to your network, it
will be listed in section Provisioned Phones.

Adding phonesmanually

Phones which are not connected to the network can also be provisioned. Youmay do somanually — you need the
phone's hardware address and the type of the phone. The procedure is described below:

Screenshot 29: Connecting a phonemanually

1. In section Provisioned Phones, click Add.

2. This opens a dialog which requires the hardware address of the phone (MAC address of the network card in the
phone). The address may lack the colons. Once you save it, the colons will be added automatically.

3. Select the correct type of the hardware phone (special configuration scripts are created according to the phone
type).

4. (Optional) Set a label of the phone (for example the name of your company). The upper label on the phone display.

5. Assign the phone user or users whowill use it.

NOTE

If you do not know towhich person the extension will be assigned, check option Generate new extension
numberand the extension will be assigned automatically. Phones without extensions assigned cannot be
provisioned.

Importing from CSV file

Phones can be imported from a CSV file. Data in the file must follow certain rules:



KerioOperator 4 Settings |174

hwAddress — hardware address of the phone,

phoneManufacturer — name of the phone's manufacturer,

phoneType — phone type,

extension1; extension2; ... — extensions assigned to the phone. The maximumnumber of extensions depends on
the phone type.

Each phone uses one line and all items are separated by a semicolon.

The file may look as follows:

00:1a:a0:be:1e:cd;Cisco;7940;111;112
00:1b:b0:cd:e1:ca;Cisco;7960;115
00:1c:c0:ab:a2:24;Linksys;SPA942;113;114

Import data from a CSV file as described below:

1. In the Provisioned Phones section, click on Advanced> Import fromaCSVfile.

2. This opens dialog Import fromaCSVfile— click on UploadCSVfile.

3. If the data in the file are correct, a list of all the phones and extensions is displayed. Check those youwant to import.

4. Click OK.

5. The imported phones are displayed in the Provisioned Phones table.

Restarting provisioned phones

When you change configuration which affects provisioned phones, the phones need to be restarted (for example,
when you create a new call route). When you do so, a dialog window recommending phone restart is displayed. You can
do it immediately or wait for a more convenient time (for example to an off-peak time). To restart phones later:

1. Open the Provisioned Phones section.

2. Click Advanced> Restart All Phones.

WARNING
Some Cisco telephones from newer series are not able to restart automatically. In case of configuration changes you
have to check the result. If anything is wrong, restart the phones manually.

This warning doesn't relate to Cisco SPA phones.

Firmware

Kerio Operator allows easy installation of phone firmware which are managed through the phone provisioning:

1. Go to section Provisioned Phonesand click on the Advanced> Firmwaresbutton.

2. In the Firmwaresand Logosdialog, select a firmware and click Edit.

3. In the Edit firmware dialog, select Verify the firmware. Kerio Operator vrifies if the firmware includes all important files
and information.

4. Click Upload File.

5. This opens a dialog where you select a firmware file and confirm the selection.

6. In the New firmware dialog, select the appropriate phone.

7. Click OK.
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The new firmware is installed and after the restart will be installed to phones.

Uploading a phone provisioning module

If you want to change or create a provisioning module (archived templates + PHP scripts which can change phones
behavior), download Provisioning Developer Documentation and read it carefully.

When the provisioning module is prepared and archived, upload it to Kerio Operator:

1. Go to administration interface.

2. In section Provisioned Phones, click Advanced> ProvisioningModules..

3. Click Upload.

4. Restart your phones.

Overriding templates

For more information, refer to Editing provisioning templates (page 181).

What to do if you want to know the password of your phone

If any of your users needs to know the password of their phone, we do not recommend to provide themwith the Master
Password. We have a specific solution:

1. In the administration interface, go to Provisioned Phones> Hardware Phones.

2. Click Provisioning Settings.

3. Disable master password.

Once you disable it, each phone will have their own password which can be shared with individual users.

Configuring inter-digit timeout

Inter-digit timeout sets the time between dialing the last digit and automatic dial. If your users complains that it is too
long or too short, you can adjust it:

1. Go to the administration interface.

2. In section Provisioned Phones, go to Provisioning Settings.

3. In the Phone Provisioning Settings, set the Inter-digit timeout.

http://download.kerio.com/dwn/kerio-operator-provisioning-docs.zip
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How phone provisioning works

Screenshot 30: Automatic HW phone provisioning

This is how the automatic phone provisioning works:

The telephone boots in the network and sends a DHCP request for an IP address.

DHCP server accepts the request, assigns an IP address and sends it back in a DHCP reply. Besides the IP address, the
message also contains TFTP (Trivial File Transfer Protocol) server address — Kerio Operator, in our case.

SIP phone connects to TFTP server integrated in Kerio Operator.

Kerio Operator checks whether the phone is new:

if it is new, Kerio Operator generates a new phone extension for the phone;

if it is not new, Kerio Operator finds the extension which the phone has used.

Kerio Operator generates a configuration file suitable for the particular phone type and sends it via the TFTP protocol.

The phone is configured using the values it has acquired in the configuration file and is ready to be used.

NOTE
Some phones perform an automatic restart during the configuration.

4.1.2 Provisioning of Kerio Operator Softphone formobile devices

This topic describes auto-provisioning of Kerio Operator Softphone for mobile devices. Auto-provisioning and its
functionality for SIP phones is described in Configuring automatic phone provisioning.

Prerequisites

Kerio Operator must have a DNS name. Type the DNS name in the Configuration > Networksection.
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WARNING
To secure your Kerio Operator Softphones on Android devices, youmust have a fully qualified domain name in the
SSL certificate of the Kerio Operator server.

Kerio Operator must use a valid SSL certificate. The certificate name must correspond with the Kerio Operator DNS
name. For more information, see Securing Kerio Operator Softphone with SSL certificates.

Configuring provisioning for Kerio Operator Softphone

Step 1 Add a new extension or a new registration of their existing extension to users who want to use Kerio Operator Softphone.

Step 2 Add users to provisioning:

1. In the administration interface, go to Configuration > Provisioned Phones > Softphones
2. Click Add.
3. In the Select User dialog, select the user who wants to use Kerio Operator Softphone.
4. Save the settings.

Step 3 Users must configure their mobile devices to connect to Kerio Operator.

Securing Kerio Operator Softphone with SSL certificates

To secure your Kerio Operator Softphones, youmust have one of the following SSL certificates:

A paid SSL certificate signed by a certification authority. These certificates do not require any further configuration.

WARNING

Do not use wildcard certificates. Kerio Operator Softphone follows the RFC 5922 standard.

A self-signed certificate created by your Kerio Operator server. If you use a self-signed certificate, users must down-
load and install the certificate manually. For more information, go toUsing the self-signed certificate from your Kerio
Operator server.

Configuring a dial plan

Users with Kerio Operator Softphone want to use their contact list, where phone numbers are stored in different formats.
The Dial Plan translates phone numbers from the format used in a user's contact lists to the format that can be dialed via
your Kerio Operator PBX:

1. In the administration interface, go to Provisioned Phones> Softphones.

2. Click Dial Plan Configuration.

3. Click Add to create a new rule.

4. Save the rule and click Test in the Dial Plan Configuration dialog.

5. If you need more rules, create another one.

6. Sort rules from specific to general. Rules are applied from top to bottom.

7. Save the settings.

Creating rules

You can use the following characters when creating new rules.

http://go.gfi.com/?pageid=operator_help#cshid=1320
https://tools.ietf.org/html/rfc5922#section-7.2
http://go.gfi.com/?pageid=operator_help#cshid=1000
http://go.gfi.com/?pageid=operator_help#cshid=1000
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Character Description

0 to 9 digits

x a single wildcard

*#+ Keyboard symbols

[ ] A collection that can include a range. For example [6-9] means 6 7 8 9. Or [136-9] means 1 3 6 7 8 9.

. Repeat the last element 0 or more times. For example, with the pattern 12. the following input will match: 1 (The 2 is
repeated zero times) 12, 122, 1222 and so on

Screenshot 31: Characters for yourdial plan

Example 1: International calls from USA

Match number:+x.

Remove prefix: +

Add prefix:011

The following image describes a scenario when youwan to call from the USA (prefix 011) to GB (prefix +44) and
outgoing prefix of your company is 9.

Screenshot 32: International calls from USA to GB

Example 2: Outgoing prefix 9

Match number:x.

Remove prefix: leave empty.

Add prefix:9

Example 3: International calls in Europe (replacing + by 00)

Match number:+x.

Remove prefix:+

Add prefix:00

4.1.3Accessing company contacts through LDAP on provisioned phones

Kerio Operator offers searching in your LDAP directory from your provisioned phones.
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WARNING
Cisco79xx phones are not supported.

Polycom phones are not supported with Kerio Connect LDAP.

Connecting to Kerio Connect LDAP/Microsoft Active Directory

1. In the administration interface, go to Provisioned Phones.

2. Click the Provisioning Settingsbutton.

3. In the Phone Provisioning Settingsdialog, select option Directoryconfiguration isenabled.

4. Click Configure.

5. Click ConfigurationWizard.

6. Select type of a service:

Kerio Connect LDAP — type Kerio Connect hostname, username and password.

Active Directory — type domain name and hostname of your Active Directory and credentials of account
with at least read-only access to Active Directory,

Screenshot 33: The Directory Configuration dialog after finishing Kerio Connect LDAP configuration

NOTE
We recommend to create a special account with read-only access and use credentials of this account.
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3. Save the settings.

4. In Provisioned Phones, click Advanced and restart all provisioned phones. Phones read the new configuration and
start to communicate directly with the LDAP server.

Try this feature on your phone. Find a directory on the phone and check the contact list.

For information on how to use your phone directory, read the manual of your phone.

Connecting to LDAP in general

1. In the administration interface, go to Provisioned Phones.

2. Click the Provisioning Settingsbutton.

3. In the Phone Provisioning Settingsdialog, select option Directoryconfiguration isenabled.

4. Click Configure.

5. Fill the DirectoryConfiguration dialog.

6. Save the settings.

7. In Provisioned Phones, click Advanced and restart all provisioned phones. Phones read the new configuration and
start to communicate directly with LDAP server.

Try this feature on your phone. Find a directory on the phone and check the contact list.

For information on how to use your phone directory, read the manual of your phone.

4.1.4Using provisioning tools

NOTE
New in Kerio Operator 2.3!

Kerio Operator includes tools for phone administration. These tools can:

display the phone web interface.

open a packet sniffer for a communication between the phone and Kerio Operator.

ping IP address of the phone.

Using provisioning tools

1. In the administration interface, go to Provisioned Phones.

2. Right-click a provisioned phone and in the context menu select Tools.

3. Select a tool and use it.
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4.1.5 Editing provisioning templates

Kerio Operator offers overriding templates for provisioned phones.

Template overrides were developed to allow you to change default values in the provisioning template. You can change
for example remote changing BLF, speed dials or phone's language).

Using Template Overrides

1. Go to administration interface.

2. In section Provisioned Phones, click Advanced> TemplateOverrides..

3. Click Edit.

4. Edit the template. Kerio Operator uses the same file for a group of phones, for example for all snom phones or all Cisco
SPA phones.

5. Click OK.

6. Click Close.

7. Restart your phones.

Using developer's documentation

When you edit a template, you can use input variables that come preset when your scripts are run. Variables are
described in Kerio Operatorprovisioning reference guide:

1. Download Provisioning Developer Documentation.

2. Extract the ZIP file.

http://download.kerio.com/dwn/kerio-operator-provisioning-docs.zip
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3. Open refguide.pdf.

You can use all variables mentioned in the downloaded document.

Example: Changing a phone's language

Lines beginning with @ contain regular PHP code which is executed when the template is sent to the phone. So you
can do things like:

@ if ($IDENT === 'snom720') {
language: Deutsch
@ }

This switches the snom 720 phones' language to German.

To find out what the variable $IDENT can contain, you can temporary add line:

@ var_dump($PHONE_TYPES);

To view the result:

1. In the Provisioned Phones> Hardware Phones section, right-click the snomphone.

2. In the context menu, click DownloadConfiguration and select the correct interface.

3. Open the saved archive and verify the variable in the file.

To differentiate between the phones, you can use variables such as $PHONE_IP or the $LINES array. To change a
specific phone, one can do:

@ if ($PHONE_IP === '192.168.12.11') {
language: Deutsch
@ }

NOTE
In this case you can not verify the functionality by downloading the file in the administration, because the
$PHONE_IP does not match.

Another example is:

@ if (isset($LINES[0]) && $LINES[0]['TELNUM'] === '21') {
language: Deutsch
@ }

The example checks if the phone has at least one extension number and sets the language to German if the first
extension is 21.

4.1.6Displaying your company logo on the provisioned phones

You can display your company logo on hardware phones supported by Kerio Operator.

What youneed

Logo— each phone firmware needs a logo in a different format.

Phonesmust be provisioned.
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Which type of logo do youneed

1. In the administration interface, go to Provisioned Phones.

2. Click the Advanced> Logosbutton.

3. In the Firmwaresand Logosdialog, go to tab Logos.

4. Find the firmware type installed on your phones and click Edit. In Notes, you can find the logo parameters.

Screenshot 34: Logo parameters in the Edit Logo dialog

Adding your logo to phones

The Kerio Operator logo is set by default and you have to change it:

1. In the administration interface, go to Provisioned Phones.

2. Click the Advanced> Logosbutton.

3. Find the logo type for your phone and click Edit.

4. Click Upload File and upload your logo.

5. Close the dialog.

6. In Provisioned Phones, click the Provisioning Settingsbutton.

7. In the Phone Provisioning Settingsdialog, selectDisplay logo on the screen.

8. Save the settings.

9. Restart all phones manually.
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4.1.7How to configure phone provisioning on Polycom phones

This topic takes you through the configuration of the automatic phone provisioning via TFTP on Polycom phones.

1. After the phone boots, click the Menu button.

2. Select Settingsand confirm.
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3. SelectAdvanced and confirm.
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4. Now the phone requires a password for phone provisioning.

5. Enter the default password which is 456 (once the provisioning is configured, the password will be synchronized
with the one set in the Kerio Operator administration interface in section Provisioned Phones).

6. SelectAdmin Settingsand confirm.
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7. SelectNetworkConfiguration and confirm.
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8. Select ServerMenu and confirm
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9. Select ServerType and use the right arrow to switch to Trivial FTP.
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10. Press Exit to exit the Settings.

4.1.8 Phone provisioning - wrong detection of CISCO phones

Problem

You cannot configure a provisioned phone.

The phone has be detected and the administration interface in section Provisioned Phonesdisplays a different
type of phone.

The phone does not accept the extension it has been assigned.

Explanation

Some phones support two types of protocols:

SCCP

SIP

The default protocol is set to SCCP. Phones may not detect the correct communication protocol. As Kerio Operator uses
SIP for communication, the telephone cannot be attended.

How to solve it?

Switch the communication protocol of the phone from SCCP to SIP manually.
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Example: Cisco SPA 525

1. Go to the phone configuration interface in your browser:https://phoneIPaddress/admin/advanced

2. Change SPA525-protocol to SIP.

3. Change SPA525-auto-detect-sccp to no.

4. Login to Kerio Operator and go to Provisioned Phones.

5. Remove the wrongly detected phone (it has been detected as an older CISCO phone).

6. Restart the phone (so called soft restart).

Screenshot 35: Configuring the Cisco SPA525 phone

NOTE
A similar problem has been identified for CISCO SPA 303. In this case, the phone’s administration is locked (we have
found the solution on https://supportforums.cisco.com). Further steps are similar to Cisco SPA 525.

4.1.9Uploading configuration files to Kerio Operator TFTP server

Why to use phone or other device configuration file

phone provisioning of unsupported devices (hardware phones or other devices with a TFTP client)

phone firmware upgrade

BLF configuration, ring tones (different ring tones for different phones)

password change for all extension assigned to one phone

Obtaining the configuration file

The following instructions will come in handy, if you wish to change the configuration file of a provisioned phone:

https://supportforums.cisco.com/thread/2053315
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1. In the administration interface, go toConfiguration > Provisioned Phones.

2. Right-click the phone whose configuration file you wish to download.

Screenshot 36: Downloading the configuration

3. Click DownloadConfiguration and select the interface. Each interface has a different configuration — different IP
addresses.

4. The ZIP file with the current configuration will be automatically saved on your computer.

Uploading new or changed configuration files to Kerio Operator

What you need

The file must be uploaded via SSH using SCP.

Locate configuration files to/var/tftp

How to enable SSH in Kerio Operator

Follow these instructions:

1. In the administration interface, go to section Status> SystemHealth.

2. Click Taskswhile pressing theShift key.

3. Select Enable SSH.

4. Connect to Kerio Operator via SCP (use for example WinSCP for Windows) and upload the file via SSH using SCP. For
access use username root and password of a Kerio Operator administrator.

4.2 Accounts
This section helps you create user accounts and their phone extensions.

http://winscp.net/eng/download.php
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4.2.1 Creating user accounts 193

4.2.2 Creating extensions 194

4.2.3 Configuring multiple registration of an extension 195

4.2.1 Creating user accounts

User accounts in Kerio Operator are used for:

Login users to Kerio Phone

Link users with an extension

Set access rights to the system

Adding new accounts

You can create either a local user or map existing users from a directory service.

Adding local accounts

If you do not use directory services, create a local user in the Kerio Operator administration:

1. In the Configuration > Users section, click Add.

2. The AddUserdialog box opens.

3. On the General tab, type username and password. The username must not contain spaces, diacritics and special sym-
bols.

4. Click OK.

The user account appears in the Users section and the user can connect to Phone.

Adding accounts from directory service

Mapping differs according to the directory service used:

Microsoft Active Directory

Apple Open Directory

You need basic login credentials to connect directory service to Kerio Operator.

Formore information, refer to Connecting Kerio Operator to directory service (page 276).

Assigning extensions to users

An extension is an internal telephone line. Each user can have assigned one or more extensions in Kerio Operator.

1. In the Configuration > Users section, select a user and click Edit. The Edit Userdialog box opens.

2. On the Extensions tab, click Add. The Select Extensionsdialog box opens.

3. In the Select Extensionsdialog box, click Add. The Add Extension dialog box opens with predefined unused exten-
sion.

4. If the extension number meets your dial plan, click OK. If not, rewrite the extension number and then click OK.

5. Save the settings.

The users can use their Kerio Operator phone extension.

http://go.gfi.com/?pageid=operator_help#cshid=958
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Formore information, refer to Creating extensions (page 194).

Configuring ringing rules

Formore information, refer to Redirecting calls (page 210).

4.2.2 Creating extensions

An extension is an internal telephone line. Each user can have assigned one or more extensions in Kerio Operator.

The total number of extensions is limited to three times the number of licensed users.

NOTE

Service extensions configured on the PBX services tab are not counted by the license file.

Adding new extensions

You have three options to add a new extension:

An extension is created automatically when you connect a provisioned phone to the network.

You can create an extension in Configuration > Users— the extension is assigned to a particular user.

Create an extension in Configuration > Extensions— the extension is created as standalone (without being
assigned to a user).

Creating a standalone extension

If you have a phone which is not used by any particular user, you can create a standalone extension for it.

1. In the administration interface, go toConfiguration > Extensions.

2. Click Add> Add Extension.

3. Type an extension number. The field suggests an unused extension. You can change the extension number manu-
ally if necessary.

4. Save the settings.

SIP username and SIP password

Each extension has a SIP username and a SIP password. Kerio Operator uses SIP usernames and SIP passwords for
authentication of phones to Kerio Operator. You use SIP username/password for connecting softphones or hardware
phones to Kerio Operator. Formore information, refer to Configuring multiple registration of an extension (page
195).

SIP usernames/passwords cannot be used to login into Kerio Operator or Kerio Phone.

Using SIP username/password

1. In the Kerio Operator administration interface, go toConfiguration > Extensions.

2. Select an extension and click Edit....

3. In the Edit Extension dialog, you can see fields SIPusername and SIPpassword.

4. To display the SIP password, click the keys icon.
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Screenshot 37: SIP username and SIP password

Now you can view the SIP username/password and use it for connecting a phone to Kerio Operator.

Encrypting calls

In Kerio Operator, you can encrypt your calls for any extensions.

1. In the Kerio Operator administration interface, go toConfiguration > Extensions.

2. Select an extension and click Edit...

3. Click the Advanced tab and select Encrypt communication (TLS and SRTP).

4. Click OK.

Now Kerio Operator encrypts all calls for the selected extension.

Formore information, refer to Securing Kerio Operator (page 255).

4.2.3 Configuringmultiple registration of an extension

Do youwant to use your extension with various phones? Softphone in your cell phone or IP phone in your smartphone?
The solution is multiple registration.

NOTE
Multiple registration (in contrary to assigning more extensions to one user) gives user the possibility to call from the
same extension any time they make a call.

EXAMPLE

User Brenda Roar with username broar working at the Marketing department uses the extension 224. When
necessary, she also works from home. She uses the following to communicate:

1. She has an automatically provisioned phone Cisco 7940 in his office.

2. She has X-Lite softphone on her home computer.
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3. Occasionally, when connected via WiFi, she uses a SIP client on her mobile phone.

With correct settings of multiple registration that will be described in the following chapter she can use all the before-
mentioned methods to authenticate.

Creating multiple registrations

1. Open section Configuration > Extensions.

2. Select Brenda Roar’s extension (224). Click on Add> AddAnotherRegistration.

Screenshot 38: Extensions >Add Another Registration

3. A new registration is added to the user table. Add another registration. The result should be similar to the following
image.

Screenshot 39: Extensions >Multiple registration
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4. Double-click the 224p1 registration and note the SIP username and SIP password from the opened dialog.

Screenshot 40: Edit Extension> Login information for X-Lite

5. Click OK.

6. In the X-Lite settings (detailed information for installation can be found in topic Configuring the X-Lite software
phone), enter the newly generated string intoUser ID and the SIP password into Password.

7. Repeat steps 4 to 6 for the second registration for the SIP client on amobile phone.

4.3 Numbering
This section provides information about:

4.3.1 Mapping external and internal numbers 197

4.3.2 Displaying, hiding and overriding phone numbers 204

4.3.3 Setting emergency numbers 205

4.3.4 Using number transformation 206

4.3.5 Adding area codes to called numbers 208

4.3.1Mapping external and internal numbers

In Kerio Operator you can map external numbers to internal extensions. You can:

Strip the first 0-n digits from the number, including reducing the number to an empty string

Add other digits to the beginning of the number

Routing incoming calls

In Kerio Operator, you can use rewriting rules tomap numbers for SIP and standard phone interfaces. Depending on
your provider's requirements, youmay need to strip out or change numbers

http://go.gfi.com/?pageid=operator_help#cshid=923.html
http://go.gfi.com/?pageid=operator_help#cshid=923.html
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Example:

A company has 100 phone numbers from a telephone provider.

For incoming calls, the provider sends the whole number.

For outgoing calls, the provider requires the whole number.

Internal extensions have the format 2xx.

The prefix for outgoing calls is 9.

When external PhoneA (with the number 5550399) calls internal PhoneB (with the number 5550101 and the internal
extension 201):

1. PhoneA dials PhoneB'snumber and a signal goes to the provider.

2. The provider sends the number to Kerio Operator.

3. The rewriting rule strips five digits from the left and adds the prefix 2.

4. The call connects.

Mapping a trunk of numbers

To set the interface for an interval of numbers (55501xx in this example):

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of outgoing calls.

2. Select the routing rule for the provider interface and click Edit. The Edit Incoming Calldialog box opens.
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3. In the Called number section, strip the first five digits from the left, and add the prefix 2. This modifies the number to
the final format of the extension (2xx).

4. In the Calling number section, do not strip out any digits, and add the prefix 9. This is useful when youwant to call
back the external number.

5. Click OK.

Mapping a single number or multiple numbers

To set the interface for single or multiple numbers (5550100 to 5550199 in this example):

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Select the routing rule for the provider interface and click Edit. The Edit Incoming Calldialog box opens.

3. Double-click a line in the Extension column and assign an extension to the external number.
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4. In the Called number section, strip the first two digits from the left, and add the prefix 2. This modifies the number
to the final format of the extension (2xx).

5. Click OK.

Routing outgoing calls

You can configure outgoing calls when creating an interface, either SIP or hardware cards.

For rewriting the numbers, you need additional configuration.

Example:

External PhoneA has the number 5550199.

Internal PhoneBhas the number 5550101 and the internal extension 201.

For outgoing calls, Kerio Operator uses the prefix 9.

The provider needs the whole number for outgoing calls.

When PhoneBcalls PhoneA:
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1. PhoneBdials the number with the 9prefix (95550199).

2. Kerio Operator uses rewriting rules and strips out the first digit (9). The number Kerio Operator sends to the provider is
5550199.

3. The provider connects to PhoneA.

To achieve this configuration:

1. In the administration interface, go toConfiguration > Call Routing > Routing of outgoing calls.

2. Select an interface and click Edit. The Edit Outgoing Route dialog box opens.

3. In the Called number section, strip one digit from left and do not add a prefix.

4. Click OK.

Rules for outgoing calls

You can configure rules for outgoing calls:

1. In the administration interface, go toConfiguration > Call Routing > Routing of outgoing calls.

2. Select an interface and click Edit.

3. In the Calling number (Caller ID) section, select one of these options:

Mapextensions to external numbersbased on routing of incoming calls if you want to use a table of
external numbers configured for the provider

Assign the default numberto all extensions if you want to use a default number for all extensions

Rewrite extension numbers (default numbernot used) if you want to rewrite numbers in a specific way
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Exceptions to the outgoing routes

To create an exception:

1. In the administration interface, go toConfiguration > Call Routing > Routing of outgoing calls.

2. Select an interface and click Edit.

3. Enable the Use route onlyfornumbersdefined in exceptionsoption.

4. Click the Exceptions tab and click Add.

5. To change the internal number, double-click the displayed extension and select a new extension.

6. To change the external number, double-click the displayed number and select a new number.

7. If you want to hide this extension's number so the call recipient cannot see it, select the box in the HideCaller ID
column (see Displaying, hiding and overriding phone numbers for more details).

8. Click OK.
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Working with prefixes for outgoing calls

Kerio Operator works with prefixes for outgoing calls in a specific schema and you can use one prefix for multiple
providers. Kerio Operator uses the longest prefix matching the dialed number. If that dial attempt fails, Kerio Operator
tries the next route with the same prefix.

Example

Use the prefix 011 for two providers (provider1 and provider2) and the prefix 0 for outgoing calls.

Dials the number 011234567.

After dialing this number:

1. Kerio Operator goes through the Routing of outgoing calls table and tries tomatch the prefix.

2. Kerio Operator finds twomatching prefixes, 0 and 011, and uses the longest prefix.

3. Kerio Operator tries the 011prefix to connect toprovider2.

4. If the connection does not work, Kerio Operator uses the same prefix to connect toprovider1.

5. If the connection still does not work, Kerio Operator does not try to use the last prefix (in this example, the 0prefix),
and the call fails.

Changing the order of prefixes

Kerio Operator works with providers for the same prefix in order from top to bottom. You can change that order by the
using arrows on the right side of the administration interface tomove it up or down.
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4.3.2Displaying, hiding and overriding phone numbers

Hiding users´ phone number

NOTE
Redesigned in Kerio Operator 2.4!

To hide users´ phone numbers for outgoing calls:

1. In the administration interface, go to the Configuration > Call Routing > Routing of outgoing calls section, select a
prefix and click Edit. The Edit Outgoing Route dialog box opens.

2. Go to the Exceptions tab.

3. Add an extension.

4. Select the box in the HideCaller ID column.

5. Click OK.

NOTE
Some VoIP service providers do not allow hiding of phone numbers. If you use one of these providers, this settings
do not work. See topic Connecting to VoIP service provider.

Changing phone number to a name

For outgoing calls, you can change the phone number to display a name:

1. In the administration interface, go to the Configuration > Call Routing > Interfacesand routing of incoming calls
section, select an interface and click Edit. The Edit External Interface dialog box opens.

2. Go to the Advanced tab.
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3. In the Outgoing calls section, select the Override displaynamewith option, and type a new name.

4. Click OK.

Extending display names for incoming calls

NOTE
New in Kerio Operator 2.4!

In Kerio Operator, you can extend the display name of incoming calls. The configuration works for all numbers that reach
the interface and Kerio Operator adds the configured text to the beginning of the number or the caller's ID.

For example, a call center provides a technical support for several companies (for example,Workplace). Administrator
wants to extend a display name of incoming calls with the company name, so the call center employees know from
where comes the call:

1. In the administration interface, go to the Configuration > Call Routing > Interfacesand routing of incoming calls
section.

2. Select an interface and click Edit. The Edit External Interface dialog box opens.

3. Go to the Advanced tab.

4. In the Incoming calls section, select the Prependdisplaynamewith option, and type Workplace -.

5. Click OK.

After this configuration, Kerio Operator extends all incoming calls to this interface with Workplace - (for example,
Workplace - 5550155).

4.3.3 Setting emergency numbers

When configuring emergency numbers, you can:

add emergency numbers to the system,

enable direct dialing (without the prefix for calling external networks).

NOTE

Call permitions and security restrictions are not applied to emergency numbers.
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Configuring emergency numbers

1. In the administration interface, go toConfiguration > Call Routing.

2. Click the EmergencyNumbersbutton placed in the lower left corner.

3. Click Overwrite and select the country.

4. If the lists of emergency numbers do not suit your needs, click Add to create your own emergency numbers.

Enabling direct dialing

All outgoing calls to external networks use a prefix. You can configure an exception for emergency numbers:

1. In the administration interface, go toConfiguration > Call Routing.

2. Click the EmergencyNumbersbutton placed in the lower left corner.

3. Check Enable direct dialing.

4. SelectUsed outgoing route. This route will be used for all calls to the emergency numbers.

WARNING
If the direct dialing is enabled, you cannot create extensions which equal the emergency numbers.

4.3.4Using number transformation

A number transformation in Kerio Operator ensures that phone numbers dialed automatically by an application (such as
Click to Call) are dialed in the right format. The right format is the same format as for usual calls — without the outgoing
prefix, or without the international call prefix. It depends on your SIP provider and their SIP server settings.

Youmay need the number transformation if your users use:

Click to Call in Kerio Connect Client

Kerio Operator App for Salesforce

Kerio Phone

All the above mentioned applications dial phone numbers in the same format as they are displayed. If the number has
an international prefix, Kerio Operator must delete it. If your Kerio Operator uses a prefix for outgoing calls, youmust
create a rule for adding the prefix in front of the phone number.

Configuring a number transformation

If you use an outgoing prefix in your environment, youmust add a number transformation rule to Kerio Operator:

1. In the administration interface, go to Integration.

2. On the NumberTransformation tab, add the rule for your outgoing prefix (for example 9).

3. Click Add.

4. In the AddNumberTransformation Rule dialog, type dot in the Match number field. Numbers of any length are
matched.

5. In the Addprefix field, add the outgoing prefix (for example 9).

6. Click OK.

http://go.gfi.com/?pageid=operator_help#cshid=1616
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Example

The example uses the US international prefix and shows you a number transformation if:

9 is an outgoing prefix.

Your SIP provider cannot dial numbers starting with a +.

In case of local calls, you want to strip the international prefix.

In case of international calls, you want to change + to 011.

If the number does not start with 9, the rule adds 9 in front of the phone number.
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4.3.5Adding area codes to called numbers

In some situations you need to add an area code to your dialed numbers. In Kerio Operator, you can set the area code
automatically.

Example:

You use only 7-digit schema for your phone numbers (for example 555-5555)

Your provider accepts only 10-digit numbers

To change your schema from 7-digit to 10-digit numbers:

1. Go toConfiguration > Call Routing.

2. Click Add... under the Routing of outgoing calls section.

3. On the General tab, add prefix number (for example 9).

4. Select your interface.

5. For CalledNumbers set Strip digits from left to 0 and type a 3-digit number prefix (for example 450).

6. Click OK.

After that, all outgoing calls dialed with the 9 prefix have 10-digit format (in our example 450555-5555 instead of 555-
5555).

Disabling outgoing calls to certain countries or regions

Formore information, refer to Disabling outgoing calls to certain countries or regions (page 217).

4.4 Call settings
This section provides information about:

4.4.1 Bandwidth used by the different codecs 209
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4.4.2 Using Opus codec for Kerio Phone 209

4.4.3 Redirecting calls 210

4.4.4 Blocking incoming calls in Kerio Operator 212

4.4.5 Disabling computer calls for Kerio Phone 215

4.4.6 Disabling outgoing calls to certain countries or regions 217

4.4.7 Video calling in Kerio Operator 218

4.4.1 Bandwidth used by the different codecs

When you are using Voice over IP, the used VoIP phones and PBX can use different so called codecs. The consumption of
bandwidth depends on which codec you use.

The following table gives you a short overview of the bandwidth consumption of the different codecs. On the page
from asteriskguru.com, you can also find a bandwidth calculator tool.

codec name bandwidth (incl. overhead) bandwidth for 5 concurrent calls quality

G.711 a/u-law PCM 80 kbit/s 512 kbit/s ISDN

G.729 CS-CELP 32 kbit/s 200 kbit/s good

iLBC iLBC 32 kbit/s 200 kbit/s good

G.723.1 MP-MLQ 21 kbit/s 110 kbit/s average

G.723 A-CELP 15 kbit/s 80 kbit/s average

GSM fullrate GSM 13 kbit/s 80 kbit/s average

G.726 AD-PCM 55 kbit/s 386 kbit/s GSM

SpeeX SpeeX 4 - 15 kbit/s 25 - 80 kbit/s variable

4.4.2UsingOpus codec for Kerio Phone

NOTE
New in Kerio Operator 2.5!

Kerio Operator allows you to use the Opus codec for calls via Kerio Phone for desktop and web. To use Opus for all your
calls:

1. In the Kerio Operator administration interface, go toAdvancedOptions> Telephony.

2. In the Codec configuration section, select the PreferOpuscodec option.

3. Click Apply.

NOTE
Kerio Operator transcodes Opus to another codec every time the other caller doesn't use it. Transcoding calls
increases the CPU usage. If you expect larger amount of concurrent calls, disable this option.

http://www.asteriskguru.com/tools/bandwidth_calculator.php
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4.4.3 Redirecting calls

NOTE
Redesigned in Kerio Operator 2.4!

Kerio Operator can route incoming calls to different internal extensions or external numbers.

You can configure ringing rules (call forwarding) for each user in the Ringing Rules section.

NOTE

Users can also change their ringing rules in the Phone interface in the Forwarding section.

Configuring ringing rules in the administration

See the following example:

Bob has the internal extension 11 and a cell phone with the number5550155. He wants to receive calls on his cell
phone. When he is busy, calls fallback to voicemail.

1. In the administration interface, go toConfiguration > Users.

2. Select an account and click Edit. The Edit Userdialog box opens.

3. Go to the Extensions tab.

4. Select an extension and click Ringing Rules.

5. Enable the Ring extension option.

6. Select a number for Timeout. When the specified time runs out, Kerio Operator forwards the call.

7. ForWhen busy, select the Continue option.

8. Click Add and type the number 5550155 and a description (cell phone).
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9. Select a number for Timeout.

10. Enable the Fallbackto voicemailoption.

11. Click OK to save your changes.

Additional configuration

NOTE
New in Kerio Operator 2.4!

For ringing rules, you can configure additional settings:

Configure extension to allow only one incoming call

Apply ringing rules to calls coming from call queues and ringing groups

Configuring extensions to allow only one incoming call

If your phones support multiple calls, you can configure your extensions to reject or redirect additional incoming calls
when an extension is already busy with a call.

To allow only one incoming call at a time:
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1. In the administration interface, go toConfiguration > Users.

2. Select an account and click Edit. The Edit Userdialog box opens.

3. Go to the Extensions tab.

4. Select an extension and click Ringing Rules.

5. Enable the Allow onlyone incoming calloption.

6. Click OK.

Kerio Operator now handles incoming calls using the configuration set in the Ringing Rulesdialog box.

Applying ringing rules to calls coming from call queues and ringing groups

To configure ringing rules for calls from call queues and ringing groups:

1. In the administration interface, go toConfiguration > Users.

2. Select an account and click Edit. The Edit Userdialog box opens.

3. Go to the Extensions tab.

4. Select an extension and click Ringing Rules.

5. Enable the Use the above rulesalso forRingingGroupsandCallQueuesoption.

6. Click OK.

Configuring call forwarding in Kerio Phone

For more information refer to Redirecting calls in Kerio Phone.

4.4.4 Blocking incoming calls in Kerio Operator

If you want to block incoming calls from certain numbers, you can add the numbers to Kerio Operator's Blacklist .

Kerio Operator then blocks all numbers in the blacklist. No incoming calls from these numbers are connected.

http://go.gfi.com/?pageid=operator_help#cshid=938
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Adding numbers to the blacklist

1. In the administration interface, go toConfiguration > Blacklist.

2. Click Add.

3. Type the number youwant to block (Match number). You can match an entire number, or you can use X for single
characters and . (dot) for multiple characters.

4. Add a description to document the reason for blacklisting the number.

5. Click OK.

6. Add as many rules as you need.

7. (Optional) You can also block anonymous callers.
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NOTE
Do not use this option if your provider does not show the caller's number. Otherwise, all incoming calls are blocked.

8. Click Apply.

When you receive a call from any of the numbers in the blacklist, your extension appears to be busy and the call is not
connected.

Adding numbers from Call History

In Call History, you can select any incoming call number to add to the blacklist.

Right-click the number (a line) and select Blacklist.

When a call is blocked by blacklisting, you see Blacklisted in the Status column in Call History.

Adding/removing numbers with a PBX service

You can also use your phone to add numbers to the blacklist.

Kerio Operator has three pre-defined PBX services:

*30 for adding numbers to the blacklist

*31 for removing numbers from the blacklist

*32 for adding the last caller to the blacklist

To add a number to the blacklist:

1. Dial the service number for adding numbers:*30.

2. After the beep, enter the phone number.

3. Hang up.

To add the last caller to the blacklist:

1. Dial the service number for adding last number:*32.

2. Confirm the number.

3. Hang up.

To remove a number form the blacklist:

1. Dial the service number for removing numbers:*31.

2. After the beep, enter the phone number.

3. Hang up.
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Importing blacklists

You can prepare a CSV file of numbers to be blocked and import init to Kerio Operator.

Each line in the file defines one entry. Entries must have the following format:

0,"555.","All numbers beginning with 555 are blocked"
1,"+.","All calls from foreign countries beginning with +"
1,"00.","All calls from foreign countries beginning with 00"
1,"X906.",""

NOTE
Separe all items with commas, and put number definitions and descriptions inside quotation marks.

If any item is empty, keep the quotation marks.

To import the file, go to the Blacklist section and click Import fromaCSVfile.

Exporting blacklists

You can export the list of blacklisted numbers to a *.csv file.

1. Click Export to a CSVfile.

2. Go to the correct folder, assign a file name, and save.

4.4.5Disabling computer calls for Kerio Phone

NOTE
New in Kerio Operator 2.5.2!

Kerio Operator enables you tomake calls via Kerio Phone for desktop and web using WebRTC.
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You can disable the WebRTC support in the administration, so that users cannot see and use the Computerextension in
their applications.

You can disable computer calls for:

A single user

Multiple users

All users on your Kerio Operator Server

Disabling computer calls for a single user

1. In the administration interface, go toConfiguration > Users.

2. Select a user and click Edit.

3. Switch to the Advanced tab.

4. Deselect the Computercalls fromKerio Phone option.

5. Click OK.

At this point, a selected user can no longer use the Computerextension for making calls.

Disabling computer calls for multiple users

1. In the administration interface, go toConfiguration > Users.

2. Select multiple users and click Edit.

3. Switch to the Advanced tab.

4. In the Computercalls field, selectNo.

5. Click OK.

At this point, selected users can no longer use the Computerextension for making calls.
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Disabling calls for all users

1. In the administration interface, go toConfiguration > AdvancedOptions.

2. Switch to the Telephony tab.

3. In the Kerio Phone fordesktop andweb section, deselect the Enable computercallsoption.

4. Click Apply.

At this point, users on your Kerio Operator server can no longer use the Computerextension for making calls.

4.4.6Disabling outgoing calls to certain countries or regions

For security reasons, disable calls to countries users never call, create call permission groups and assign them to
extensions.

Call permission groups can:

Allow everything and disable certain prefixes, or

Disable everything and allow certain prefixes

Disabling outgoing calls

1. In the administration interface, go toDefinitions> Call Permission Groups.

2. Click Add or select an existing group and click Duplicate.
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3. In the AddCall Permission Group dialog box, type the name and a description for the group and click Add.

4. Type a specific string of numbers, and choose the option to allow or deny access.

WARNING
To limit outgoing calls, include the prefix for outbound calls (usually 9).

5. (Optional) Repeat steps 2 and 3 to add additional numbers.

6. Click OK to save the settings.

NOTE
Kerio Operator applies the calls permissions in order, one by one.

Assigning call permission groups to extensions

1. In the administration interface, go toConfiguration > Extensionsand assign the created call permission groups to
individual extensions.

2. Select an extension and click Edit. The Edit Extension dialog box opens.

3. Select a Call permissionsgroup.

4. Click OK.

NOTE

To assign a call permission group for multiple extensions, select multiple extensions and click Edit.

Adding area codes to called numbers

Formore information, refer to Adding area codes to called numbers (page 208).

4.4.7 Video calling in Kerio Operator

NOTE
New in Kerio Operator 2.4!

Kerio Operator now supports video calls with video enabled devices or software.

Prerequisites:

Devices or software that use the same supported video codecs

Configured extensions and interfaces to use the same video codec as your devices

Kerio Operator supports these video codecs (all are pass-through only):

H.261 Video

H.263 Video

H.263+ Video

H.264

MPEG4 Video
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Adding video codecs to extensions

To enable video codecs for any extension:

1. In the administration interface, go toConfiguration > Extensions.

2. Select an extension and click Edit. The Edit Extension dialog box opens.

3. Go to the Codecs tab.

4. Select a codec and click Add to insert the codec in the Selected codecs list.
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5. Click OK to save your settings.

WARNING
All extensions participating in a video call must have the same codec.

You can select a single codec and assign it to all your extensions.

Adding video codecs to interfaces

To enable video codecs for any interface:

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Select an interface and click Edit. The Edit External Interface dialog box opens.

3. Go to the Codecs tab.

4. Select a codec and click Add to insert the codec in the Selected codecs list.

5. Click OK to save your settings.

WARNING
Interfaces must have the same codecs as all extensions participating in a video call.
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Troubleshooting

Video codecs in Kerio Operator are pass-through only and Kerio Operator cannot transcode them. For a proper
connection, all devices must use the same codec. See the examples below:

Example of improper configuration

DeviceA tries tomanage a video call with Device B:

DeviceAworks with the H.261Video codec.

Device Bworks with the H.263+ Video codec.

This configuration does not work, because the devices have different codecs and Kerio Operator cannot transcode them.

Example of proper configuration

DeviceA tries tomanage a video call with Device B:

DeviceAworks with the H.264Video codec.

Device Balso works with the H.264Video codec.

This configuration works, because both devices work with the same codec, so Kerio Operator does not need to transcode
any codecs.

Phones do not display any video

If your phone does not display any video during the call:

Set the same codecs for each device. To verify which codecs devices use, see the call history.

Lower the resolution on the caller's phone.

For example,GrandstreamGXV3272 sends video call with 720p resolution toGrandstreamGXV3140, butGrandstream
GXV3140 cannot decode the video. User decreases the resolution on GrandstreamGXV3272 and both phones start to
display the video.

Phones do not transmit video

If your phone does not transmit video call, configure the device tomake a video call.

For example, before youmake the call, configure YealinkVP-530 to prefer video calls.

Video is unstable

Devices with slow CPU or without a hardware acceleration can have problems with decoding the video:
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Decrease the resolution on the caller's phone.

Verify that the network is not jammed. For example, transmitting a VGA signal using aH.264codec takes 400
kbps in each direction.

4.5 PBX services
This section contains information about configuring and using PBX services.

4.5.1 Using PBX services 222

4.5.2 Configuring music on hold 223

4.5.3 Configuring voicemail 224

4.5.4 Configuring and using call parking 228

4.5.5 Configuring and using conferences 230

4.5.6 Configuring auto attendant scripts 231

4.5.7 Setting time conditions in auto attendant scripts 237

4.5.8 Using the Day/night mode in auto attendant scripts 242

4.5.9 Configuring call pickup 248

4.5.10 Configuring call queues 249

4.5.1Using PBX services

Kerio Operator has special phone extensions which run the following services:

Directed call pickup

Call parking

Call monitoring

Call pickup

Voicemail — a service extension to access voicemail. Kerio Operator recognizes which extension is used and you can
set if PIN is required or not. This service is set automatically for provisioned phones.

Voicemailwith login prompt—a service extension to access voicemail. Kerio Operator is not able to recognize
which extension is used. Users must authenticate with typing their extension and PIN.

Echo— this option helps youmonitor whether phones are correctly connected and what is the sound delay. Speak
to the phone after hearing the automated message. If done correctly, your message is recorded and played back.

Music — music plays upon dialing the extension (used for checking the connection).

Current time— auto attendant tells the current date and time.

Dial byextension— auto attendant invites the user to enter the extension which the operator will dial.

Dial byname— user enters first several letters of the callee's surname and system searches among the users created
in Kerio Operator and dials the extension.

Record audio— Kerio Operator starts recording. Thus you can easily create records for auto attendant scripts in
excellent quality.
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Receive faxmessages— the service enables you to receive fax to defined email address. Necessary condition for
enabeling the service is entering email address for receiving faxes in PDF format.

To configure PBX services, go to the administration interface > PBX Services.

WARNING
If you wish to use any service, tick the box next to this service. Extensions offering the services are disabled by
default.

Creating voice files

This chapter shows how to create a records for an auto attendant script easily, fast and in sufficient quality.

1. Prepare texts.

2. In the administration interface, go to PBXServices, enable Record audio and save the settings.

3. Pick up the handset of your phone which is connected to Kerio Operator.

4. Dial the Record audio service.

5. Say individual voice recordings into the headset.

The record is stored in the audio file library in Kerio Operator. You can listen and manage the recordings in the
Definitions> Audio File Library.

NOTE

If you open the administration interface in Safari browser and you cannot play any recordings, read topic Cannot
play voicemails or audio files in Safari.

4.5.2 Configuringmusic on hold

While a caller is waiting for connection or in a call queue (see the Configuring call queues topic), they can hear
recorded music. Kerio Operator has a default music collection. You can add and configure other audio files. You can
upload any file in GSM and WAV format in section Definitions> Music OnHold.

Adding new collections

To add a new music collection (with one or more file), follow these instructions:
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Screenshot 41: Adding NewCollection

1. Go toDefinitions> Music OnHold and click the Add button.

2. In the AddMusic onHold Collection, enter a name for the collection and a description.

3. Click the Add button situated on the right side of the table with added audio files.

4. In the Select Audio File dialog, add file one by one by clicking Upload.

5. Select a file in the list and double-click it. Repeat this step until all your uploaded files are listed in table Audio files in
the collection.

Setting Default Collection

In the AddMusic onHold Collection dialog, check the Make this collection the default music on hold to ensure this
collection is used as default in all other Kerio Operator Administration settings.

The default collection is used while holding the line (usually the Hold button on most phones). The other collections
can be used, for example, in call queues.

4.5.3 Configuring voicemail

Voicemail does not need any configuration. It works automatically once Kerio Operator starts. All users have forwarding to
voicemail inbox enabled by default:

when unavailable

when busy

You can change the settings in section Users (Ringing rules). Users can alsomodify the settings in their Kerio Phone.

You can find the advanced voicemail configuration in the administration interface in section Voicemail.
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Screenshot 42: Configuration> Voicemail

What is direct access to voicemail inbox and how to configure it

Direct access to users' voicemail enables the receptionist to connect calls directly to callee's voicemail.

1. In the administration interface, go toVoicemail > General.

2. Check Allow direct dialing to user'svoicemail boxes.

3. Type a prefix in Prefix fordirect dialing.

4. (Optional) Set an announcement (greeting message). If a call is redirected to voicemail, the caller hears a recorded
message. This message can consist of two parts:

Instructions inform callers what they should do next: Leave amessage after the beep.

Message informs callers that the callee is unavailable (the phone is switched off) or busy (the callee speaks
with someone else).

5. (Optional) To change the size of users' voicemail boxes, adjust the value in Maximummessages in each voicemail
box.

6. (Optional) To automatically delete read messages in full voicemail boxes, selectAutomaticallydelete the oldest read
message if the voicemail box is full.

7. Click Apply.

Now the receptionist can dial the extension for direct access followed by the user's extension. The caller will be directed
to the voicemail box of the person they are calling.

Enabling caller to escape voicemail by dialing 0

If you want to enable escaping voicemail by dialing 0, youmust set an extension where the call is redirected:
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1. In the administration interface, go toVoicemail > General.

2. SelectAfterpressing the 0key, dial extension.

3. Type an extension.

4. Click Apply.

Configuring forwarding of voicemail messages to user’s email inbox

To send voicemail messages to email inboxes of the users, you need to set their email addresses in the administration
interface in Users.

NOTE
If the users' INBOXes are unavailable (the mailserver is down), the user accounts are disconnected from voicemail
and try to reconnect every 5 minutes. Each attempt to connect is recorded in logs.

Mymailserver is Kerio Connect

Formore information, refer to Integrating Kerio Connect and Kerio Operator (page 303).

Mymailserver is a different SMTP server

1. On your mail server, create a special user which will be used for sending the voicemail messages. You can name them
for example operator.

2. Go to administration interface toVoicemail > tab Email and check Send eachmessage to user'semail.

3. In Mail serverhostname, type the SMTP server hostname and click SMTPConfiguration.

4. Set the port number of the port used by your SMTP server. Usually 25 for SMTP and 465 for SMTPS

5. Decide, whether to communicate through secured connection. If the configuration of your mail server allows it, we
recommend the encrypted connection to establish more secure communication.

6. If your SMTP server requires authentication, check Server requiresauthentication. Use the username and password
for the account you created on your mail server in step 1.

7. Click OK.

8. In Voicemail > tab Email, type a valid email address in Senderemail address (so that your antispam rules accept it).
The address should also represent the origin of the message. Example:operator@live-and-let-laugh-
inc.com

Configuring the welcome message for callers

If a call is redirected to voicemail, the caller hears a recorded message. This message can consist of two parts:

Instructions inform callers what they should do next: Leave amessage after the beep.

Message informs callers that the callee is unavailable.

How to set the greeting message?

1. Open section Voicemail.

2. In the Greetingmessagemenu, select whether the caller will hear the instruction, the message or both.

Greeting message for the direct dialing is described in the What is direct access to voicemail inbox and how to
configure it section.
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Changing the extension and voicemail PIN

Users use a special extension number to access their voicemail (by default: 50 or 51) and PIN.

To change the extension or enable/disable PIN, go to section PBXServicesand read topic Using PBX services.

Screenshot 43: PBX Services

To set the user’s PIN, go to account configuration in section Users to tab Extensions.

Accessing voicemail

On your phone, press voicemail button or dial voicemail number and play the message.

Through Kerio Phone.

WARNING
For users of Apple iPhone, iPad or Apple Mac OS X: If you cannot play your voicemail messages in Kerio Phone,
contact the Kerio Operator administrator.An invalid certificate may be the reason.

By forwarding voicemail to your mailbox (to get more information on this option, contact your network administrator).

Removing voicemail data for selected user

You can remove all local data connected with the particular user.

Local data is:

voicemail

custom voicemail greeting message

NOTE
Local data means that you cannot use this feature when you use the Kerio Connect integration — voice messages
are stored in Kerio Connect in this case.

1. In the administration interface, go toUsers.

2. Right-click the table heading.

3. In the context menu, select Columns> Voicemail and Columns> Local Voicemail Size.
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Screenshot 44: Table context menu

4. Right-click the selected user and click Erase Local VoicemailData.

Screenshot 45: User's context menu

If you succeed, there is value 0B in the Local Voicemail Size column.

Managing voicemail via Kerio Phone

For more information refer toUsing Kerio Phone

4.5.4 Configuring andusing call parking

Call parking is a special type of call transfers. Parked calls wait for the callee on a special number.

http://go.gfi.com/?pageid=operator_help#cshid=958
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Configuring call parking

You can park calls on numbers which consist of:

PBX service prefix

Parking position number

1. In the administration interface, go to the PBXServices section.

2. Double-click Call parking to open the Edit Service dialog box.

3. Select the Service isenabled option.

4. In the Service extension field, type the call parking prefix. You can leave the default prefix setting *5.

5. Set the timeout (40 seconds by default). When the timeout expires, the call falls back to the original extension.

6. Set the number of digits for parking positions.

NOTE
se the same number of digits as for extensions (your dial plan). Users can park calls on positions which match their
extension numbers.

7. Save your settings.

Using call parking

1. Initiate or answer the call.

2. Select the call transfer function on your phone. Formore information, refer to Hardware telephone basic usage
(page 126).

3. Dial the call parking number. You can:

Dial the whole parking slot number (for example,*512) to park the call to the specific slot.

Dial the Call parking extension only (for example,*5) to park the call in the first available parking slot. The
voice-prompt message tells you the number of the first available parking slot.
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4. Select the call transfer function on your phone.

5. Terminate the call.

To answer a parked call:

1. Pick up the phone.

2. Dial the call parking number (for example,*512).

If nobody answers the parked call before the timeout expires, the call falls back to the original extension.

4.5.5 Configuring andusing conferences

Telephone conference is one telephone call of three or more users.

Telephone conferences allow participation of Kerio Operator users and external participants. To join a conference,
participants must dial the conference number and PIN.

You can use two different types of conferences — statically or dynamically configured.

Statically configured conference

Statically configured means that conferences are created in the administration interface and each new conference uses
one extension.

NOTE
If there is a lack of extensions, use dynamically configured conferences instead.

Configuring statically configured conferences

1. Go to section Status> Dial Plan and make sure that the extension you have selected for the conference is not used.

2. In Configuration > Conferences, click Add. The Add conference dialog is dispayed.

3. Enter the conference extension and its description.

4. In the menuConference type, choose the Staticallyconfigured option.

5. Optional: Limit the number of participants.

6. Each conference can be protected by a PIN required from all participants upon attempting to enter the conference. If
you wish to secure a conference, set a PIN and deliver it to the members.

7. To enable call recording, select Record Calls.

WARNING
Please note that call recording is a subject to special laws in many countries. It maybe illegal in your jurisdiction or
require notice to the other party on the call. Accordingly, you assume all liability for using the call recording
functions and are responsible for notifying all users of this system of this potential restriction, if applicable.

Connecting to a statically configured conference

1. Dial the conference telephone number / extension.

2. If the conference is protected, you will be asked to enter the PIN.

To leave the conference, simply terminate the call.
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Dynamic conferences

A dynamic conference is created on one extension only. Users set the conference number and PIN after dialing the
extension or the whole telephone number. On one extension, users can set unlimited number of conferences with
different conference numbers.

The disadvantage of dynamic conference is that user has to enter three numbers when dialing the conference (the
extension, the conference number and the PIN).

Configuring dynamic conferences

1. Go to Status> Dial Plan and make sure that the conference extension is not used by a user.

2. In Configuration > Conferences, click Add. The Add conference dialog is dispayed.

3. Enter the conference extension and its description.

4. In the Conference typemenu, choose option Dynamic, created on demand.

5. To enable call recording, select Record Calls.

WARNING
Please note that call recording is a subject to special laws in many countries. It maybe illegal in your jurisdiction or
require notice to the other party on the call. Accordingly, you assume all liability for using the call recording
functions and are responsible for notifying all users of this system of this potential restriction, if applicable.

Connecting to a dynamic conference

To connect to an existing conference, enter the conference number and PIN (if required).

Creating a dynamic conference

1. Dial the conference telephone number / extension.

2. Enter any number for the conference.

3. Set PIN (if required).

4. Communicate these access numbers (extension, conference number and PIN) to other attendees.

To leave the conference, simply terminate the call.

Where to monitor conference activities

All current calls can be viewed under Status> Conferences.

4.5.6 Configuring auto attendant scripts

Auto attendant script is a simple collection of voice menus, submenus and announcements and actions defined for each
of them according to the caller's behavior. It can:

connect to an extension or voicemail,

play an announcement,

navigate through menus and submenus.

send any faxes to a configured email.

Menus can be recorded in various formats. Kerio Operator supports the following formats:
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Supported formats Audio format

gsm 8KHz

wav 8KHz, 16 bits per sample, mono (Kerio Operator encodes all WAV files into this format automatically)

Screenshot 46: Kerio Operator— supported audio formats

How to add new auto attendant script

See the following description of an auto attendant script as an example. Create a script which:

starts after dialing extension 200,

contains a voice menuwith the following text: LOL! You have just reached the Live And Let Laugh company's hotline
(fiendish laugh).

For Sales Department, press 1.

For Quality Assurance Department, press 2.

For Technical Support Department, press 3.

If you wish to speak to the receptionist, press 4.

The Sales Department manages two flagship products of the company. Therefore, two submenus (Joke Lite, Laugh
Home2012) are created.

For Joke Lite, press 1.

For LaughHome2012, press 2.

If you wish to talk to the receptionist, press 3.

Create the same menu for technical support.

Before creating the script, it is necessary to create extensions (in the assigned range 123456XXX) which will be used in
the script.

extension 100— reception of Live And Let Laugh Inc. One of the receptionists Joan Giggle or Brian Snigger will con-
nect the calls if the caller makes no selection from the menu.

extension 203— Quality Assurance Department extension (David Jester).

extension 301— common extension (you can create a call queue or a ringing group) for Joke Lite experts, such as
Frederic Jovial, George Funpoker, Anne Kdotte.

extension 302— common extension for Laugh Home 2012 experts (Tamara Bellylaugh, Otto Spass, Mary Merry).

extension 501— call queue for Joke Lite technical support (Andrew Widegrin).

extension 502— call queue for Technical Support of Laugh Home 2012 (Alan Tickle).

Script settings

Configure the script in the administration interface in section Configuration > Auto Attendant Scripts:
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Screenshot 47: Auto Attendant

1. Click Add and enter the Script extension (extension 200 in our example) and some description.

2. (Optional) To receive faxes to configured email address, selectDetect faxesand send thembyemail to and type an
email address.

3. Click Edit and open the Edit Menu dialog.

4. In the Announcement field, select the recording for the main script. The Select button offers existing recordings or
you can upload your own announcement to the PBX.

NOTE

If you open the administration interface in Safari browser and you cannot play any recordings, read topic Cannot
play voicemails or audio files in Safari.

5. SetNumberof playbacks to twowhich will ensure the menu is played to the caller twice.

6. Once the announcement is played, timeout is started with the default action taken upon its expiration. Set the
timeout to 10 seconds. The default action is the preset hang up action. This means that if the announcement is played
twice and the customer does not make any selection within 10 seconds, the call will be terminated.

7. Click Add. The Key column states the key which confirms the customer's choice. Enter number 1. Enter 1 in this
column. Column Action defines what happens when the caller presses a key on their phone. SelectGo to submenu.
We need to direct calling customers to the extension of the product they are interested in (either Joke Lite or Laugh
Home 2012). In the Announcement column, you can add a record which will be played upon pressing the particular
key (for example: Stay tuned, now youwill be redirected to the Live And Let Laugh Inc Sales Department). Finish the
table according to figure.



KerioOperator 4 Settings |234

Screenshot 48: Editingmainmenu

8. Check Interpret anyother input asextension numberanddial it. This option allows to specify a direct extension
while the auto attendant script is running.

9. Confirm the settings and return to the AddAuto Attendant Script dialog which is now similar to the one in picture
above.

10. Click on menu Salesdept.. Again, the Edit menu dialog is opened but now the menu is for the Sales department.
Follow the same procedure as with the main menu. The resultant menuwill look as the one showed in the picture
below.
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Screenshot 49: Submenu edit

11. Do the same for the Technical Support dept. menu.

Now the script is complete.

NOTE

You can duplicate an existing script if you want to create a similar one — select a script and click Duplicate.

Time condition

The script can be limited to a specific time interval (office hours of your employees or night time when no call queue
agents are available).

The time ranges (intervals) are configured in section Configuration > Definitions> TimeRanges. Once you have the
time range configured, go back to the AddAuto Attendant Script, select the menu youwish to limit and click on the
Convert to TimeCondition button.

Instructions for time condition setting will be better understood through the following example focusing company's
working hours. Sales department works from 9am to 5pm on weekdays. Configure the auto attendant script so that when
customers call during office hours they will be connected to a sales department employee and when they call before or
later they will hear a message announcing that the sales department is closed. To create the condition script, follow
these instructions:

1. In the administration interface, go toConfiguration > Definitions> TimeRanges.

2. Click Add. Dialog Add TimeRange opens.

3. In section Add to a group, select the Create new option and enter a name for the new interval (for example,
Sales Department Office Hours).

4. The Description is optional, for example Weekdays from9am to 5pm.

5. Select daily in the Typemenu and set the desired interval from 9 to 5 in the From and To fields.



KerioOperator 4 Settings |236

6. In the Valid onmenu, selectWeekdays.

7. Click OK to confirm the changes.

8. Open the Configuration > Auto Attendant Scripts section.

9. Click on Add.

10. In the AddAuto Attendant Script dialog, create a corresponding menu (the script created in the previous section
will be used in this example — see the picture below).

11. Select the SalesDepartment submenu and click Convert to TimeCondition.

12. Divide the Sales Department submenu in two time conditions. The first one is played if the condition is met and the
second if the condition is not met. Click on the red highlighted text Set up the time condition.

Screenshot 50: Setting the time condition

13. This opens dialog Edit TimeCondition. In the For time rangemenu, select SalesDepartment OfficeHours.

14. Click on the submenu representing the positive result of the condition. It is currently called Unnamed. In the dialog
Edit Menu just opened, simply add a description (for example Sales Department condition met).

15. Click on the submenu representing the negative part of the condition (now it is empty and unnamed).

16. This opens dialog Edit TimeCondition allowing to add a description (for example, Sales Department — condition
not met).

17. Now you can modify the script. For example, in the Announcement field, add amessage announcing that office
hours of the Sales Department are from 9am to 5pm on weekdays.

18. Save the submenu. The resultant script is displayed in the next picture.
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Screenshot 51: Time condition applied in the script

4.5.7 Setting time conditions in auto attendant scripts

Time conditions are best explained in an example

When configuring auto attendant scripts, Bob encountered the following problem. The company management created
a new quality department. The responsible person is Alice. Bob created a new extension for this department. Alice came
to Bob complaining that dissatisfied customers are calling constantly and she does not even have time for lunch.

Bob knew that Alice needs an auto attendant script which respects her working hours. And how to do it?

1. Bob created new time intervals for Alice’s working hours, her lunch break and also for public holidays.

2. He created records for the following announcements:

Hello. You are calling Live And Let Laugh Inc. We are having a delicious lunch at the moment. If you call after
1pm, we will gladly hear what you have to say. Talk to ya later!”

“Hello. You are calling Live And Let Laugh Inc. We are off the clock at the moment. Please, call us on weekdays
from 8am to 12pm or after lunch from 1pm to 6pm.We will gladly hear what you have to say. Talk to ya later!”

“Hello. You are calling Live And Let Laugh Inc. Have a very merry holiday today. If you wish tomake a com-
plaint, call us on weekdays from 8am to 12pm or after lunch from 1pm to 6pm.We will gladly hear what you
have to say. Talk to ya later!”

3. He created a new auto attendant script with time conditions.

NOTE

You can also use the Day/night mode to create time conditions without a specific time set. Formore information,
refer to Using the Day/night mode in auto attendant scripts (page 242).
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Setting time intervals for auto attendant scripts

1. In the administration interface, go to section Definitions> Time ranges.

2. Add three new time ranges. Two ranges will be of the daily time — Lunch break and Working Hours. Both
ranges will be valid on weekdays.

3. The third range will be absolute. Add the first public holiday when creating the range. Add also other public holidays
and do not forget to add them into the existing group Holidays.

Creating auto attendant scripts in Kerio Operator

The script will follow this scheme:

If Holidays
publicholidays.wav

Else
If Working hours

If Lunch break
lunchbreak.wav

Else
Action: Redirecting to Alice’s extension.

Else
offtheclock.wav

1. In the administration interface, go toAuto Attendant Scripts.

2. Add a new script, assign it extension 300 and add a description (Scripts for complaints desk).

3. Create the first condition: Click Convert to TimeCondition. Double-click on the red link Set up the time condition
and in the Edit TimeCondition dialog, select range Holidays. Save the settings.
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4. Now, edit the first part of the condition in dialog AddAuto Attendant Script. Double-click .

5. In the Edit Menu dialog, type description Holidays and add a file with the announcement about a holiday. Set
timeout to 5 second (this will suffice) and save the settings.

6. Create the second condition: Select the icon and click Convert to TimeCondition (thus the Working
hours condition will be nested into condition Holidays). In the Description field, enterWorking hours; in the For time
range, selectWorking hours. Save the settings.
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7. In the Edit Auto Attendant Script dialog under the Working hours line, two new conditions appear.

8. Create the third condition: Click and click Convert to TimeCondition. In the For time rangemenu,
select Lunch break. Save the settings.
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9. Double-click the last icon. In the Edit Menu dialog, type description Lunch breakand add a file with the
announcement about a lunch break. Set timeout to 5 second and save the settings.

10. Double-click the icon (last but one in the scheme). In the Edit Menu dialog, type description Working
hours (dial Alice). You can add an Announcementwith information about redirecting to the Complaints department.
Set Timeout to 1 second. In the Default actionmenu, selectDial extension number. Type Alice’s extension (211) in
the Extension field and save the settings.

11. Double-click the last condition (icon ). In the Edit Menu dialog, type description AfterHoursand add a
file with the announcement that the Complaints department is close at the moment. Set timeout to 5 second and save
the settings.

WARNING

If you open the administration interface in Safari browser and you cannot play any recordings, read topic Cannot
play voicemails or audio files in Safari.

The resultant script is displayed below.
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4.5.8Using theDay/nightmode in auto attendant scripts

NOTE
New in Kerio Operator 2.3.2!

Day/night mode works similarly to time ranges in auto attendant scripts. The difference is that in a time range you set a
specific time. The Day/night mode is switched on demand.

An example:

Alice works in a Sales department and has flexible working hours. She needs her extension to be available only when
she's at work. She cannot use time ranges because her working hours are not fixed. She will use the Day/night mode to
switch her extension on and off easily.

Alice must add a Day/night mode service to Kerio Operator and then create an auto attendant script using the
created service.

Adding a Day/night mode

1. In the administration interface, go to section Configuration > PBXServices.

2. Click the Add> Add aDay/night Mode Service.
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3. In the Add Service dialog window, fill in the service extension and type a name.

4. Click the two keys icon to display the service PIN number.

5. Click OK.

You can create as many Day/night mode services as you need, for example one for each department.

Selecting the Day/night mode status

You can select the mode status either manually in the administration interface or by calling the service extension.

The Configuration > PBXServices section displays the current status of each mode in the service list.
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Selecting the status in the administration interface

1. In the administration interface, go to section Configuration > PBXServices.

2. Double-click the desired Day/night mode service.

3. Change the mode status.

4. Click OK.

Selecting the status by calling the extension

1. Call the service extension (88 in our example).

2. Enter the service PIN code. When you switch to the day status, you hear a ascending sound. When you switch to the
night status, you hear a descending sound.

3. Hang up.
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Using day/night mode in auto attendant scripts

The script will follow this scheme:

If Working hours
Redirect to extension 256

Else
Play offtheclock.wav
Hangup

1. In the administration interface, go toAuto Attendant Scripts.

2. Add a new script, assign it extension 400 and add a description (Working hours Sales dept.).

3. Click the Convert to Condition button. The Edit Condition dialog opens.

4. Select the Day/night modemode from the drop-down menu. Click OK.

5. Select the Day status (the sun icon) and click Edit. SetDial extension numberas the Default action. Type the exten-
sion number and click OK.
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6. Select the Night status (the moon icon) and click Edit. Select the Announcement to be played when the night status
is active (offtheclock.wav in our example). SetHang up as the Default action. Click OK.
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WARNING

If you open the administration interface in Safari browser and you cannot play any recordings, read topic Cannot
play voicemails or audio files in Safari.

The resultant script is displayed below.
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Now Alice calls the Day/night mode extension (88 in our example) when she comes to work to switch the day
status on. She calls the extension again to switch to the night status when she goes home.

4.5.9 Configuring call pickup

This function enables users to answer a call ringing on an extension on a device at another extension. The PBX
distinguishes between two types of call pickup:

Call pickup within defined groups (so called rooms) by using specific code (by default, this code is *8),

Call pickup by using a special code (by default, this code is **) with the called extension appended at the end.

How to configure call pickup rooms

1. In the administration interface, go toConfiguration > PBXServices, enable Call Pickup and save the settings. Keep
the default pickup code (*8) unless you do have a reason to change it.

2. Go toDefinitions> Call PickupRoomsand click Add to open dialog AddCall PickupRoom.

3. Type the name of the department or the office in the Name field.

4. In the table, add all users and extensions that will be able to pick up calls for one another.

5. Make sure the Room isenabled option is checked.

Example

The Live And Let Laugh company network administrator uses the AddCall PickupRoom dialog to add a group with
room name Local Sales for HPR (Happy people Republic). He adds all sales assistants for local market and their
extensions: Frederic Jovial, Mary Merry, George Funpoker.

Frederic Jovial has a day off today. His phone is ringing. Thanks to the call pickup rooms feature, Mary Merry does not
need to dash for the Frederic’s desk every time a customer calls his extension. She simply dials the magic code *8
and serves the customer at her desk.
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How to configure directed call pickup

Directed call pickup is a service allowing to pickup calls directed to any extension at the PBX. Imagine the following
situation:

the managing director Peter Prank uses extension 101

the financial director Oscar Jape uses extension 102

they share an assistant, Ms Alessandra G. Uffaw.

If Alessandra's phone shows information that someone is calling the managing director (Peter Prank) during his meeting
with the financial director (Oscar Jape), she can accept the call by dialing **101. Once she picks up the call, she learns
that the caller is the International laughter Association manager and arranges ameeting for him and her company’s
executive manager. A few minutes later, the phone at the desk of the financial director Oscar Jape starts ringing. Again,
the assistant can accept this call at her desk phone. now she enters the code **102 and recommends the caller (the
Cirque de Rire ringmaster) to call Mr Jape back later.

As you can see, by dialing the call pickup code, you can answer a call for any extension of the PBX.

For directed call pickup, apply settings as described below:

1. In the administration interface, go toConfiguration > PBXServices.

2. Enable Directed Call Pickup.

3. Directed call pickup is now fully functional.

NOTE

You can use directed call pickup in Kerio Phone.

4.5.10Configuring call queues

Call queues are used to distribute incoming calls between agents.

http://go.gfi.com/?pageid=operator_help#cshid=1690
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Screenshot 52: Call queue

Configuring call queues

1. In the administration interface, go toConfiguration > CallQueues.

2. Click Add to open the AddCallQueue dialog. On the General tab, type the new queue extension number.

3. Select the queue strategy.

4. Click the Agents tab.

5. If you want your agents to log in dynamically, type login and logout code. For example, 12345 to login, and 54321 to
logout. The calls will only go to agents logged into the queue. If you want to assign specific agents permanently to the
queue, click Add to select their extensions.

NOTE
Both methods can be combined. One queue may have agents who are assigned permanently and agents who log
in dynamically.

6. Click the Announcements tab. An announcement is a pre-recorded message that callers hear while waiting in a call
queue. You can import pre-recorded announcements into Kerio Operator (see topic Language settings in Kerio Oper-
ator) or record them by going toConfiguration > PBXServices> Record audio (see topic Using PBX services).

How to select a queue strategy

Round robin with memory mode uses circular call distribution. It remembers the last agent who answered the
phone, and new calls are directed to the next agent in the round queue.

Ring all agents — calls always ring at all agents until one of them answers the particular call.

Ring least recently called agent — the system selects the agents who have not answered the phone for the longest
period.
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Ring agent with fewest calls — the system assigns the call to the agent with the lowest number of calls answered so
far.

Ring random agent — if you select this option, the systemwill choose an agent randomly.

Ring in order — only for permanently assigned agents. You specify a fixed order in which they are always selected.
This strategy is for companies where all calls are answered by a receptionist. In case the receptionist is not answering,
the call is directed to the next agent in order (for example, an administration assistant).

What is the difference between permanently assigned and dynamic agents

Permanent assignment — agent's extension is assigned permanently to the queue.

Dynamic login — agents use special code for logging in and out of the queue.

Recording calls from call queues

Kerio Operator allows recording calls from call queues. No other module or equipment is necessary. Setting can be done
as follows:

1. Open the Configuration > CallQueues section and select the queue in which youwish to record the calls.

2. On the General tab, select Record calls.

To play back recorded calls

WARNING
Please note that call recording is subject to special laws in many countries. It may not be legal in your jurisdiction, or
may require notice to the other party on the call. Accordingly, you assume all liability for using the call recording
functions and are responsible for notifying all users of this system of this potential restriction, if applicable.

Section Status> RecordedCallsdisplays all calls recorded from call queues. Select a call to listen to it, download it to your
computer or remove it.

Deleting Recorded Calls

Recorded calls can be periodically deleted once their total size reaches a certain limit. The limit can be set in section
Status> RecordedCalls.

1. Click Advanced> PeriodicallyRemoveOld RecordedCalls.

2. In RemoveOld RecordedCallsdialog box, enter the maximum size of recorded calls on a disk (in MB).

Configuring a call queue timeout

The call queue timeout period determines the maximum amount of time a caller can be placed in a call queue.
Configuring the limit prevents fromwaiting in a queue infinitely.

The timeout limit is unlimited by default. For setting the limit, perform these steps:

1. In administration, go toConfiguration > CallQueues.

2. Click Add/Edit.

3. On tab General, setQueue timeout.

4. (Optional) Go to tab Announcementsand select Timeout announcement. Such announcement will play when the
limit is reached and should include information about what happens next (tab Exceptions).
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5. Go to tab Exceptions.

6. Choose an action for exceeded limit:

Callers receive a busysignal— if announcement was set, recording plays before call termination.

Forward to— type an extension. Kerio Operator forwards callers to the extension. If announcement was set,
recording plays.

7. Save the settings.

Timeout is configured. If you want to check your settings, lower the limit to several seconds and dial the queue from
several phones.

Configuring amusic on hold and awhile waiting period

A while waiting period is the period when users are waiting in a call queue for an agent. You can set what is playing
during the period:

1. In administration, go toConfiguration > CallQueues.

2. Click Add/Edit.

3. On tab General, selectWhilewaiting:

Music on hold — amusic sounds during the while waiting period.

Ringtone — a ringtone sounds during the while waiting period.

4. If you selected the Music on hold option, select the particular recording in the Music on holdmenu. If you want to
add a new recording to Kerio Operator, go to the Definitions> Music onHold section.

5. Save the settings.

Configuring a queue length

A queue length determines max. number of callers in the queue at the same time. Configuring the limit prevents from
waiting too long in the queue.

The queue length is unlimited by default. For setting the limit, perform these steps:

1. In administration, go toConfiguration > CallQueues.

2. Click Add/Edit.

3. On tab General, setQueue length.

4. (Optional) Go to tab Announcements, select Full queue announcement. Such announcement will play when the
limit is reached and should include information about what happens next (tab Exceptions).

5. Click the Exceptions tab.

6. Select an action for exceeded limit:

Callers receive a busysignal— if an announcement was set, recording plays before a call is terminated.

Forward to— type an extension. Kerio Operator forwards callers to the extension. If an announcement is set,
Kerio Operator plays the recording.

7. Save the settings.

The queue length is configured. If you want to check your settings, lower the limit to 1 and dial the queue from two
phones.
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Configuring exit keys

You can set exit keys for each call queue. Callers can use an exit key for transfer to an extension.

1. In administration, go toConfiguration > CallQueues.

2. Click Add/Edit.

3. On tab General, click Edit next to Exit keys.

4. Edit Exit Keys, click Add.

5. In the Add Exit Keydialog, type an exit key (for example 1).

6. Type an existing extension to transfer calls.

7. Type a description.

8. Save the settings.

When users standing in the queue use the exit key, they are transferred to pre-configured extension.

Configuring call queues without agents

Follow these steps if no agents are logged into the queue:

1. In administration, go toConfiguration > CallQueues.

2. Click Add/Edit.

3. (Optional) Go to the Announcements tab, selectNo agentsannouncement. Kerio Operator plays the announce-
ment when there are no agents in the queue.

4. Go to tab Exceptions.

5. Select an action if the queue has no agents:

Callers cannot join the queue. Callersalreadywaiting are removed— Kerio Operator disconnects all
callers. If No agentsannouncement is selected, Kerio Operator plays the recording.

Callers can join the queue— new callers can connect to the queue. Current callers stay in the queue. If No
agentsannouncement is selected, Kerio Operator plays the recording.

Callers cannot join the queue— new callers cannot connect to the queue. Current callers stay in the
queue. If No agentsannouncement is selected, Kerio Operator plays the recording.

6. If you selected Callers cannot join the queue or Callerscannot join the queue. Callersalreadywaiting are
removed, select one of these actions:

Callers receive a busysignal

Forward to— type an extension or external phone number. Kerio Operator forwards callers to the number.

7. Save the settings.

Settings are complete now. If you want to check your configuration, test these cases:

1. No agent serves the queue. Try to join the queue as a caller.

2. One agent serves the queue. Join the queue as a caller. Agent logs out.

Prioritizing call queues

Agents can operate several call queues. In the following example, an agent is assigned to three queues.



KerioOperator 4 Settings |254

Screenshot 53: Operatingmultiple queues at once

To help agents identify the queues, you can upload various audio records for each queue. The record identifying the
queue is played to the agent before a call from this queue is connected.

Upload new audio record as follows:

1. Select a call queue or create a new one in section Configuration > CallQueues.

2. In the displayed dialog, go to the Announcements tab.

3. Check the Help agents identifythe source queuebyplaying thisannouncement and click on Select.

4. In the Select Audio File dialog box, double-click a record to select it, or upload your own record to Kerio Operator (it
must be in WAV or GSM format). Use the Upload button.

It is also possible to set priorities for individual queues:

1. Open the Configuration > CallQueues section.

2. Select a queue or create a new one.

3. In the displayed dialog, go to the General tab and set the desired priority.

4. Repeat the configuration for other queues.

Queues with higher priority are processed first.

Displaying missed calls on phones in call queues

When an incoming calls rings in the call queue and an agent answers it, other devices in the queue register the call as
missed anyway.

To not display missed calls on other devices:
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1. In the Kerio Operator administration interface, go toConfiguration > CallQueues.

2. Select an extension and click Edit.

3. Switch toAdvanced tab.

4. SelectDo not displaymissed callson the phones.

5. Click OK.

Monitoring active call queues

1. In the administration interface, go to section Status> CallQueues.

2. The top table shows currently active queues.

3. The other tables display agents and callers in a queue. Just select a queue and the details in table Agentsand Callers
are updated.

You can also reset the call queue statistics to start from zero. Use the Reset Statisticsbutton.

4.6 Security
This section helps you secure your Kerio Operator server.

4.6.1 Securing Kerio Operator 255

4.6.2 Configuring SSL certificates 258

4.6.3 Configuring NAT 260

4.6.1 Securing Kerio Operator

Keymeasures

You can take the following measures to secure Kerio Operator:

Restrict communication on firewall to necessary IP addresses and ports, especially if the PBX runs in the Inter-
net.

Restrict communication on the integrated firewall in Kerio Operator.

Create strong SIP passwords.

Restrict the number of attempts to enter SIP passwords.

Using special rules, forbid international outgoing calls to countries you do not communicate with

Restrict international outgoing calls to countries where you rarely call

Encrypt your calls

Encrypt data

The following sections describe these settings in detail.

Configuring firewall in local network

Kerio Operator is usually protected by firewall (in your local network or in the Internet). Certain ports need to be opened
(or mapped) on firewall.
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Service (default
port)

Outbound connection Inbound connection

SIP (5060) allow allow for SIP servers of your provider

IMAP (143) allow if integration with Kerio Connect
is enabled and there is a firewall
between Kerio Connect and Kerio Oper-
ator.

deny

LDAP (389) allow deny

LDAPS (636) allow allow if you use mapping from Active Directory
or Open Directory and there is a firewall
between the directory service and Kerio Oper-
ator.

HTTP (80) allow deny

HTTPS (443) allow allow if you wish users to be able to connect to
Kerio Phone from the Internet.

HTTPS (4021) allow allow if you wish users to be able to connect to
the administration interface from the Internet.

STUN/TURN 
(3478)

allow allow

STUN/TURN
(3479)

allow allow

Configuring firewall integrated in Kerio Operator

Prepare groups of IP addresses which youwish to allow for individual services (create them in Definitions> IPAddress
Groups).

You can configure the integrated firewall in section Network> Firewall.

Service Recommendation

Web server If you want to restrict connections to Kerio Operator administration and softphone, check this option and select an IP
group with addresses from which access will be allowed. Bear in mind that all the PBX users should be allowed to
connect to Kerio Phone at least from their own workstation.

SIP We recommend to restrict the SIP protocol solely to your internal network and external IP addresses of your SIP pro-
vider.

Phone pro-
visioning

For security reasons, we recommend to restrict automatic phone provisioning solely to your internal network
because TFTP sends configuration data as plain text.

CRM integ-
ration

For security reasons, we recommend to restrict communication solely to your internal network.

SNMP mon-
itoring

For security reasons, we recommend to restrict communication solely to your internal network and IP adressess
where monitoring servers are running.

NOTE
If the options are unchecked, no restrictions are set.
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Data Encryption

You can enable encryption to ensure that Kerio Operator encrypts recorded calls, voicemail messages, logs, and
configuration before writing it to the disk.

IMPORTANT
Encryption is bound to a specific storage device, so if you plan to change the hardware youmust first disable
encryption. Also, encryption results in more resources being utilized so performance maybe impacted.

Enabling Encryption

1. In the Kerio Operator administration interface, go toConfiguration > AdvancedOptions.

2. Go to the Data Encryption tab.

Screenshot 54: The data encryption tab

3. Key-in the Password and re-enter to confirm the same.

IMPORTANT
Once encryption is enabled, the password cannot be changed. Remember this password, as youwould require it to
decrypt data.

4. Click Encrypt and confirm the action.

Disabling Encryption

To decrypt: data and disable encryption:

1. In the Kerio Operator administration interface, go toConfiguration > AdvancedOptions.

2. Go to the Data Encryption tab.

Screenshot 55: The data encryption tab
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3. Click Decrypt.

4. Key-in the Password set while encrypting and confirm the action.

Configuring protection against password guesses

Login data guess is one of the most common attacks on a PBX. In Kerio Operator, attackers try to guess extension
numbers and SIP passwords. This type of attack is defined by many unsuccessful attempts to enter extension number
and SIP password during a login. Kerio Operator security settings enable you to limit the number of attempts of a phone
(both software and hardware) to connect to the PBX. Apply settings as described below:

1. In the administration interface, go to Security.

2. Set the limit of unsuccessful attempts (usually 3 to 10 attempts) and set the time period during which attempts will be
counted. Setting the time period protects real users who have forgotten their password or who have made mistakes dur-
ing several logins. When the time limit expires, they can try to login to the PBX again.

3. Set the time during which Kerio Operator will block the source IP address.

4. You can also enter an email address that will be used for sending warnings about blocked IP addresses.

How to recognize there has been an attack attempt

In log Security look for the Authentication failed string. If there are many messages of this kind, somebody
is trying to use a dictionary attack.

What to do in case of an attack

In case of an attack, apply the following instructions as soon as possible:

1. In section Status> Callsand in logs, look for information on which account has been abused.

2. Change the SIP password of this account.

3. Instruct users about handling their login details and secure behavior on the Internet.

4. The PBX is blocked, so it needs to be unlocked again.

4.6.2 Configuring SSL certificates

To secure the PBX by SSL/TLS encryption, you need a SSL certificate. SSL certificates authenticate an identity on a server.

Kerio Operator creates the first self-signed certificate during the installation. The server can use this certificate but users
will have to confirm they want to go to an untrustworthy page. To avoid this, generate a new certificate request in Kerio
Operator and send it to a certification authority for authentication.

WARNING
If you use the Safari browser in your environment (on Apple iPhone, Apple iPad, Mac OS X systems and on Microsoft
Windows), you will not be able to play voice messages in Kerio Phone on their devices with a self-signed certificate.
Youmust have a trustworthy certificate available.

If you use a self-signed certificate, users with Apple mobile devices will not be able to play voice messages in Kerio
Phone on their devices. They must have a trustworthy certificate available.

To encrypt the communication between Kerio Operator and hardware phones (and only a self-signed certificate
available), you have to import or configure information in the phones that the invalid certificate is to be ignored.

Creating self-signed certificates

To create a self-signed certificate, follow these instructions:
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1. In the Kerio Operator administration interface, open section Definitions> SSL Certificates.

2. Click New > New Certificate.

3. In the New Certificate dialog box, type the hostname of Kerio Operator, the official name of your company, city and
country where your company resides and the period of validity. The Hostname and Countryentries are required fields.

4. Click OK.

5. To enable the server to use this certificate, select the certificate and click Set asActive.

Creating certificates signed by certification authority

If you wish to create and use a certificate signed by a trustworthy certification authority, follow these instructions:

1. In the Kerio Operator administration interface, open section Definitions> SSL Certificates.

2. Click New > New Certificate Request.

3. In the New Certificate Request dialog box, type the hostname of Kerio Operator, the official name of your company,
city and country where your company resides and the period of validity. The Hostname and Countryentries are
required fields.

4. Click OK.

5. Select the certificate and click Export.

6. Save the certificate to your disk and email it to a certification organization.

7. Once you obtain your certificate signed by a certification authority, go toDefinitions> SSL Certificates.

8. Click Import.

9. To enable the server to use this certificate, select the certificate and click Set asActive.

Intermediate certificates

Kerio Operator supports intermediate certificates.

To add an intermediate certificate to Kerio Operator, follow these steps:

1. In a text editor, open the server certificate and the intermediate certificate.

2. Copy the intermediate certificate into the server certificate file and save. The file may look like this:

-----BEGIN CERTIFICATE-----
MIIDOjCCAqOgAwIBAgIDPmR/MA0GCSqGSIb3DQEBBAUAMFMxCzAJBgNVBAYTAl
MSUwIwYDVQQKExxUaGF3dGUgQ29uc3VsdGluZyAoUHR5KSBMdGQuMR0wGwYDVQ

..... this is a server SSL certificate ...
ukrkDt4cgQxE6JSEprDiP+nShuh9uk4aUCKMg/g3VgEMulkROzFl6zinDg5grz
QspOQTEYoqrc3H4Bwt8=
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
MIIDMzCCApygAwIBAgIEMAAAATANBgkqhkiG9w0BAQUFADCBxDELMAkGA1UEBh
WkExFTATBgNVBAgTDFdlc3Rlcm4gQ2FwZTESMBAGA1UEBxMJQ2FwZSBUb3duMR

..... this is an intermediate SSL certificate which
signed the server certificate...

5BjLqgQRk82bFi1uoG9bNm+E6o3tiUEDywrgrVX60CjbW1+y0CdMaq7dlpszRB
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t14EmBxKYw==
-----END CERTIFICATE-----

3. In the administration interface, go to section Definitions> SSL Certificates.

4. Import the modified server certificate by clicking on Import > Import a New Certificate.

NOTE
If you have multiple intermediate certificates, add them one by one to the server certificate file.

Securing Kerio Phone with SSL certificates

For more information about securing Kerio Phone, see the Securing Kerio Phone with SSL certificates section in the
Provisioning forKerio Phone topic.

4.6.3 ConfiguringNAT

Kerio Operator is behind NAT and phones are on the Internet

1. In the administration interface, open section Network> General.

2. In the NAT support section, enable NAT by checking the option.

3. Enter the public address which should be used in SIP protocol messages.

4. For phones in the same private network as Kerio Operator, create an appropriate IP address group in section Con-
figuration > Definitions> IPAddressGroupswith all addresses on which phones communicate in your private net-
work. Thus, the PBX will communicate with phones within the network directly.

5. (Optional) You can also limit the RTP port range. Each call requires 4 ports for communication.

6. Also, map the following ports from firewall to Kerio Operator. It is usually necessary tomap a port range for RTP (accord-
ing to the specified interval).

TCP+UDP/5060

TCP/5061

UDP/443

TCP+UDP/3478

TCP+UDP/3479
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Screenshot 56: Kerio Operator is behind NATand hardware phones are in the Internet

Kerio Operator is on the company network and hardware phones are behind NAT

Firstly, configure NAT for Kerio Operator.

The scenario in figure bellow requires only one minor configuration in the PBX settings:

1. In the administration interface, open the Extensions section.

2. Select the extension of the user whose phone is in a private network.

3. In the Edit extension dialog, go to tab Advanced.

4. Check the Extension isbehindNAT option.

Screenshot 57: Kerio Operator is in the company network and hardware phones are behind NAT
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Kerio Operator is behind NAT and hardware phones are on the Internet

Firstly, configure NAT for Kerio Operator.

If the telephone is in the Internet (not behind NAT), Kerio Operator does not require special configuration.

WARNING

Phones which are in the Internet cannot be managed in section Provisioned Phones.

4.7 Server settings
This section contains information about:

4.7.1 Language settings in Kerio Operator 263

4.7.2 Configuring Built-in DHCP server in Kerio Operator 268

4.7.3 Configuring parameter 66 in DHCP server in Kerio Control 270
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4.7.19 Using paging groups and services 301
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4.7.21 Configuring Click to Call in Kerio Connect client 304

4.7.22 Configuring Remote FTP/SFTP Storage 305
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4.7.1 Language settings in Kerio Operator

Languages in Kerio Operator are:

Application language — language for the administration interface and for Kerio Phone.

PBX language — the voice of the PBX. Voice records which are used for communication with users (internal and
external).

You can also change the type of indication tones according to individual countries (read section Changing indication
tones according to countries).

Changing the application language

The language for the administration and softphone interfaces can be set in the Adminmenu in the right top corner of
the of the application window.

Changing the language of the PBX

You can change the default language of the PBX in the administration interface in section Configuration > Advanced
Options> Telephony.

There, you can also upload new language version or different voice records of the same language (for example, less
formal records).

When setting language, bear in mind the following rules:

Default language set in section AdvancedOptions> Telephonyhas lower priority than settings of individual users
in section Users. If users do not have any language set, the default one is used.

Default language set in section AdvancedOptions> Telephonyhas lower priority than settings for interfaces for
incoming calls (section Call Routing). The language set for the interface of incoming calls has lower priority than files
uploaded to call queues (see screenshot below). If no language is set, the default one is used. The same goes for call
queues.
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How to change the language for individual users

Thomas Punchline, the network administrator at Live And Let Laugh Inc, faces the following problem: New employee
has arrived in the company. Alessandra G. Uffaw has moved from the Bliss Seekers Land to the Happy People Republic
and cannot speak the Happish language. She complains she can’t understand her voicemail. Thomas has to switch the
PBX language to the Cravish language for her. Do you need to solve a similar problem? Check the following example:

1. In the administration interface, go toConfiguration > Users.

2. In the user’s settings, go to tab General and change the Phone language.

How to change the PBX language for a group of users

Thomas was instructed to create a new interface in Kerio Operator and change its language to the Cravish. He has to
create a new interface for incoming calls and set a language for this interface. He called his VoIP service provider and
purchased new phone numbers for the employees whowill communicate with foreign customers. And how he
configured Kerio Operator?

1. In the administration interface in section Configuration > Call Routing , add a new route for incoming calls.

2. Connect it to the provider, open the edit dialog by clicking on the route in table Interfacesand routing of incoming
calls.

3. Select a language on tab Advanced.

4. Select a country on tab Advanced. Each country has different standards for indication tones during calls (e.g. beeps,
ringing tones, etc.).
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Setting adifferent language for a call queue

If you wish to change the language for call queues, not for the entire route, go to section Configuration > CallQueues.

NOTE
Language files used in call queues has automatically higher priority than language set for incoming calls.

How to add a new language to the PBX

If the language sets (voice records) provided in Kerio Operator do not satisfy your needs, you can download or buy
different language sets and import them to the PBX. You can download the language sets (free or paid), for example, in
the following sites:

http://www.voip-info.org/

http://downloads.asterisk.org/

You can extract any language set archive and create your own voice records (provided you keep the file structure).

To add a new language:

1. In the Kerio Operator administration interface, go toConfiguration > AdvancedOptions> Telephony.

2. Next to the Default phone language field, click Configure.

3. In the Voice Promptsdialog box, click Add.

4. Type a name of the voice prompt.

5. Select a language syntax.

6. Click Upload and select your sound package.

http://www.voip-info.org/wiki/view/Asterisk+sound+files+international
http://downloads.asterisk.org/pub/telephony/sounds/
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7. Click OKand click Close.

8. In the Default phone language field, select the new language.

9. Click Apply.

Changing indication tones according to countries

Each country has different standards for indication tones during calls (e.g. beeps, ringing tones, etc.).

You can change the settings in the administration interface.

To select a default country for your PBX, go toConfiguration > AdvancedOptions> Telephony.
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Example

Live And Let Laugh Inc has the following configuration:

Joan Giggle, receptionist and operator, uses extension 100 and wishes the phone to communicate with her in the
Happish language.

Brian Snigger, receptionist and operator, uses extension 200 and is satisfied with the default language, which is Eng-
lish.

Phoney VoIP, an interface for incoming calls, is configured in Kerio Operator with the default language — English.
This interface is operated by Brian Snigger.

Telephium VoIP, an interface for incoming calls, is configured in Kerio Operator for communication with customers
from the Bliss Seekers Land (in Cravish). This interface is operated by Joan Giggle.

The default language in Kerio Operator is English.

Voicemail is enabled and the extension for accessing the voicemail is 50.

Scenario 1:

When Brian Snigger calls Joan Giggle (200 > 100) or when Brian Snigger calls the voicemail (200 > 50), the automatic
announcements are in English.

Scenario 2:

When Joan Giggle calls Brian Snigger (200 > 100) or when Joan Giggle calls the voicemail (200 > 50), the automatic
announcements are in Happish.

Scenario 3:

Customers calling via the Phoney VOIP interfaces will hear announcements in the default language (English).

Scenario 4:

Customers calling via the Telephun VOIP interfaces will hear announcements in Cravish.
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4.7.2 Configuring Built-in DHCP server in Kerio Operator

Kerio Operator includes a built-in DHCP server. There are deployment scenarios in which it is useful to have a separate
DHCP server for VoIP devices:

In larger networks, youmay need a LAN segment dedicated to voice traffic.

In smaller networks, the router/firewall sometimes does not support the DHCP option 66 for automatic provisioning
of phones.

WARNING
DHCP server is disabled in the default mode so that it does not collide with your existing DHCP server.

Configuring DHCP server

The built-in DHCP server must have a static IP address:

1. In Kerio Operator administration interface, go to the Networksection.

2. Select a network interface and click Edit.

3. In the Interface Propertiesdialog, switch configuration toUse the following configuration and type a new static IP
address, mask and gateway.

4. Check EnableDHCPserver.

5. Click OK to save the settings.

Kerio Operator will derive the configuration of the DHCP server from the values you set for the interface’s IP address,
network mask, and gateway. The DHCP server sends option 66 to Kerio Operator’s own address with every address lease.

Assigning IP addresses

Kerio Operator generates the range of IP addresses from a configured mask of a network interface and assigns these
addresses automatically.

Example:
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The configured IP address for a network interface is 192.168.62.1

The configured mask is 255.255.255.0

The gateway has the address 192.168.62.254

In this example, the range of IP addresses is 192.168.62.2— 192.168.62.253.

Example — LAN segment is dedicated to voice traffic

In our example, you have LAN and you need to add an other network interface as a special telephony segment.

Screenshot 58: DHCP is running in the particular segment —scheme

You need to configure two interfaces in Kerio Operator administration interface:

1. Go to section Configuration > Network> General.

2. Configure interfaces as displayed bellow.



KerioOperator 4 Settings |270

Screenshot 59: DHCP is running in the particular segment

4.7.3 Configuring parameter 66 in DHCP server in Kerio Control

The DHCP protocol assigns IP addresses. Apart from these addresses you can also send additional parameters via the
DHCP protocol. Parameter 66 configures the TFTP server address.

How to set parameter 66 in Kerio Control

1. In the administration interface, go to section DHCPserver.

2. If you use the automatically generated scopes, use Clickto configure scopesmanually.

3. Select a scope and open its settings (the Edit Scope dialog).

4. Click on the Add button.

5. Add parameter 66.

6. Enter a public IP address through which Kerio Operator communicates.

4.7.4 Configuring server date, time and time zone in Kerio Operator

Time Settings

Correct time and time zone settings of your PBX are necessary for correct configuration of telephone communication,
time ranges and logs. If the time zone is not set properly, log messages or call history may contain confusing information.
Therefore Kerio Operator is automatically synchronized with an NTP server.

WARNING
Do not change the settings unless you have a good reason.

NTP (Network Time Protocol) is a protocol for synchronizing time in your computer with time of the NTP server.

NOTE
Time and time zone settings on this tab refer to the administration interface time. It is the server time. Kerio Phone
will display the time zone using the computer settings. If users are in a different zone to Kerio Operator, logs in call
history will be displayed in users' time zone.
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Configuring synchronization with NTP

1. In the administration interface, go to section AdvancedOptions> General.

2. Select the Keep synchronizedwith NTPservers. Date and time can be set manually but it is better to use an NTP
server which provides information about the current time and allows automatic management of the firewall's system
time.

3. Kerio Technologies offers the following free NTP servers for this purpose: 0.kerio.pool.ntp.org, 1.kerio.pool.ntp.org,
2.kerio.pool.ntp.org and 3.kerio.pool.ntp.org.

4. Click Apply.

Screenshot 60: AdvancedOptions—date and time settings

Configuring time zone

1. In the administration interface, go to section AdvancedOptions> General.

2. Select a time zone from the Server time zone list.

3. Click Apply.

The current date and time will be changed according to the new time zone.

4.7.5 Configuring standard phone interfaces

You can connect Kerio Operator to your provider using hardware cards.

You can use the card distributed with Kerio Operator Box series 3000 or you can use your own card and connect it to your
Kerio Operator server.

Supported cards

Kerio Operator supports the following cards:

PRI card — The number of concurrent calls varies depending on whether you have a contract with an American or
European provider:

T1 (in the USA) allows 23 concurrent calls.

E1 (in the EU) allows 30 concurrent calls.

BRI card — Has four ports, each of which can operate two concurrent calls.

FXO card — Has four ports each of which can operate only one call at a time.

For a specific list of supported cards, see the Supported Phone Cards section on the Kerio website.

http://www.kerio.com/support/kerio-operator#techspecs
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Prerequisites

Before you configure an interface, you need to know:

Telephone number (or numbers) from your telephone provider

(PRI/BRI only) Which ISDN type to use for communication. This usually differs by your location: for example, EuroISDN
for the EU, Nation ISDN Type 2 for the USA, and so on)

Whether your provider requires overlap dialing.

Whether the provider sends or requires whole or abbreviated telephone numbers. Formore information, refer to
Mapping external and internal numbers (page 197).

At least one internal extension defined in Kerio Operator (for example, the extension of an employee who redirects
the calls).

Configuring interfaces

After connecting a card, configure the interface:

1. In the administration interface, go to the section Configuration > Call Routing. The Interface and routing of incom-
ing calls table shows one of the following, depending on your card:

PRI card: one standard telephone interface

BRI or FXO card: four interfaces (one for each of the four ports)

2. Double-click an unconfigured interface. The configuration wizard opens.

3. Type a name for the interface (for example, your provider's name). The name must not contain spaces or special char-
acters and must be unique.

One ormultiple numbers

1. If you acquire one or multiple phone numbers from your provider, type the numbers in the New provider> With
external number field. You can:

Separate individual numbers with commas (for example, 555450, 555451, 555452, and so on)

Type the whole range using - (for example, 555450-555459)

2. Click Next.

3. Select an extension to receive all calls from the provider.

4. (Optional) In the Prefix to dial out field, type a prefix for outgoing calls. Kerio Operator uses the prefix to route calls to
your provider. This prefix can be same for other providers. Formore information, refer to Working with prefixes for
outgoing calls (page 203).

5. Click Next.

6. (PRI and BRI only) Select the Switch type in the dialog box:

If you are in the EU, select the EuroISDN option

If you are in the USA, select the National ISDN Type 2 option

7. Click Next.
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8. Verify the information in the Summary section. If you need to add more information from your provider select the
Edit detailsof created interface option. Formore information, refer to Configuring additional details for an inter-
face (page 273).

9. Click Finish.

10. Create a rewriting rule to correctly map numbers to internal user extensions.

Interval of numbers

1. If you acquire a trunk with an interval of numbers from your provider, type the numbers in the New provider> With
external number field. Use x in place of the numbers that vary (for example, 555xxx).

2. Click Next.

3. Select an extension to which youwant Kerio Operator redirect all calls to unassigned (unused) extensions.

4. (Optional) In the Prefix to dial out field, type a prefix for outgoing calls. Kerio Operator uses the prefix to route calls to
your provider. This prefix can be same for other providers. Formore information, refer to Working with prefixes for
outgoing calls (page 203).

5. Click Next.

6. (PRI and BRI only) Select the Switch type in the dialog box:

If you are in the EU, select the EuroISDN option

If you are in the USA, select the National ISDN Type 2 option

7. Click Next.

8. Verify the information in the Summary section. If you need to add more information from your provider select the
Edit detailsof created interface option. Formore information, refer to Configuring additional details for an inter-
face (page 273).

9. Click Finish.

10. Create a rewriting rule to correctly map numbers to internal user extensions.

Overlap dialing

Some telephone providers require telephone numbers as a whole, others require the telephone numbers one digit at a
time. Ask your provider about their requirements. Follow these steps to configure the interface:

1. In the administration interface, go to the section Configuration > Call Routing.

2. Select an interface and click Edit. The Edit External Interface dialog opens.

3. Go to Interface Card.

4. Select the Overlap dialing option.

5. Click OK.

Configuring additional details for an interface

To set additional settings in your interface for incoming and outgoing calls:

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Select an interface and click Edit.
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3. On the Interface Card tab, change the interface settings. See the following chapters for details.

4. Click OK.

NOTE

If you select the Edit detailsof the created interface option on the last page of the interface configuration
wizard, this dialog box displays automatically.

Adjusting audio gain for standard phone interfaces

NOTE
New in Kerio Operator 2.4!

To adjust audio gain:

1. In Configuration > Call Routing > Interfacesand routing of incoming calls, select an interface and click Edit

2. Go to the Interface Card tab.

3. Set Rxgain [db].

4. Set Txgain [db].

5. Click OK.
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Configuring Type of number (TON)

NOTE
New in Kerio Operator 2.4!

Some providers send a stripped number with additional information about the type of the number. Kerio Operator can
read these types and assign a prefix to the stripped number.

To configure prefixes for Type of number (TON):

1. In Configuration > Call Routing > Interfacesand routing of incoming calls, select an interface and click Edit.

2. Go to the Interface Card tab.

3. Click Configure next to Type of number (TON).

4. Type the prefixes youwant to set.

5. Click OK.

Increasing sensitivity of the DTMF detection

NOTE
New in Kerio Operator 2.4!
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To enable this option:

1. In Configuration > Call Routing > Interfacesand routing of incoming calls, select an interface and click Edit.

2. Go to the Interface Card tab.

3. Select Increase sensitivityof theDTMFdetection.

4. Click OK.

Mapping of numbers

Formore information, refer to Mapping external and internal numbers (page 197).

4.7.6 Connecting Kerio Operator to directory service

Which directory services are supported in Kerio Operator

Kerio Operator supports the following directory services:

Microsoft Active Directory

Apple Open Directory

What is the connection used for

In practice, mapping accounts from a directory service provides the following benefits:

Easyaccount administration

Apart from the internal database of user accounts, Kerio Operator can also import accounts and groups from an LDAP
database. Using LDAP, user accounts can be managed from a single location. This reduces possible errors and simplifies
administration.

Online cooperation of Kerio Operatoranddirectoryservice

Additions, modifications or removals of user accounts/groups in the LDAP database are applied to Kerio Operator
immediately.

Using domain nameandpassword for login

Users may use the same credentials for Kerio Phone login and domain login.

WARNING
Mapping is one-way only, data are synchronized from directory service to Kerio Operator. Adding a new user in Kerio
Operator createsa local account — it will not be duplicated into the directory service database.

When creating user accounts in a directory service, ASCII must be used to specify usernames. If the username
includes special characters or symbols, user may not be able to login to Kerio Phone or the administration interface.

If you disable users in Microsoft Active Directory, they are also disabled in Kerio Operator (they will not be able to
login to Kerio Phone, make or receive calls with their extensions).

If you disable users in Apple Open Directory, they stay enabled in Kerio Operator.

Phone extensions can be managed in a directory service (if available) or locally in Kerio Operator. Select the most
convenient option.

Connecting to a directory service

Tomap users from a directory service:
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Connect to directory service in section Integration > DirectoryService.

Activate users.

All information about directory services can be found in the Config log.

Microsoft Active Directory

In the administration interface, go to Integration > DirectoryService.

1. Check the Mapuseraccounts fromadirectoryservice option and select your directory service type.

2. In the Domain name field, enter the name of your Microsoft Active Directory domain — the domain name is then
copied in other necessary fields.

3. In the Hostname field, enter the DNS name or IP address of the Microsoft Active Directory server. If you have a backup
server, enter its name in the Secondaryhostname filed.

4. In the Username and Password fields, enter the authentication data of a user with at least read rights for Microsoft
Active Directory database. Username format is user@domain.

5. Within the communication of the Microsoft Active Directory database with the PBX, sensitive data may be transmitted
(such as user passwords). For this reason, it is recommended to secure such traffic by using SSL. To enable LDAPS in
Microsoft Active Directory, it is necessary to run a certification authority on the domain controller that is considered as
trustworthy by Kerio Operator.

6. The rest of the items in the dialog are completed automatically. Do not change them unless you have a special reason
to do so. These items are Microsoft Apple Open Directory domain name and Kerberos Realmwhich has tomatch the
Microsoft Active Directory domain name, written in capital letters.

Apple Open Directory

In the administration interface, go to Integration > DirectoryService.

1. Check the Mapuseraccounts fromadirectoryservice option and select your directory service type.

2. In the Domain name field, enter the name of your Apple Open Directory domain — the domain name is then
copied in other necessary fields.

3. In the Hostname field, enter the DNS name or IP address of the Apple Open Directory server. If you have a backup
server, enter its name in the Secondaryhostname filed.

4. In the Username and Password fields, enter the authentication data of a user with at least read rights for Apple Open
Directory database. Username format is:uid=root,cn=users,dc=domain,dc=tld.

5. Within the communication of the Apple Open Directory database with the PBX, sensitive data may be transmitted
(such as user passwords). For this reason, it is recommended to secure such traffic by using SSL. To enable LDAPS in
Apple Open Directory, it is necessary to run a certification authority on the domain controller that is considered as trust-
worthy by Kerio Operator.

6. The rest of the items in the dialog are completed automatically. Do not change them unless you have a special reason
to do so. These items are Apple Open Directory domain name and Kerberos Realmwhich has tomatch the Apple Open
Directory domain name, written in capital letters.

Activating users from a directory service

Once the mapping is set, select individual users and map them to the PBX. This is how tomap users:

1. Open the Configuration > Users section.

2. Click Import > Import fromaDirectoryService.
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3. In the dialog, select all users you wish tomap (you can also add users later) and click Next.

4. If users in the directory service have phone extensions assigned, you can either keep them or disable them. If you dis-
able them, you have to assign new extensions. You can do it, for example, while changing your dial plan.

5. Click on Finish. Activated users are displayed in section Configuration > Users.

NOTE
Only extensions in attributes telephoneNumber (Microsoft Active Directory, Apple Open Directory) and
otherTelephone (Microsoft Active Directory) can be mapped (are displayed). If you create special attributes in
a directory service for your phone numbers, you will not be able tomap such extensions.

4.7.7 Connectingmultiple Kerio Operators

In Kerio Operator, you can connect multiple Kerio Operator servers. This enables you to directly reach remote phones by
their extensions for free and send or receive external calls through a relay server.

The section below describes how to connect these two servers:

The main server, which has internal extensions 100 — 199

The branch server, which has internal extensions 300 — 399

NOTE

For more information about routing of calls between Kerio Operator servers and the PSTN, see Routing calls
between multiple Kerio Operators and the PSTN.
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Prerequisites

Before the start of the configuration, you need:

Two Kerio Operator servers up and running

Extension schemes for both phone networks, each of which has a unique set of extensions

Both servers with public IP addresses or connected to the same network with a VPN tunnel

Connecting servers

On each Kerio Operator server, add a SIP interface for the other server.

1. In the administration interface, go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Click Add SIP interface. The Add SIP Interface dialog box opens.

3. Type a name for the interface and select Linkto anotherPBX (without an external number).

4. Click Next.

5. In the Prefix to reach the otherPBX field, type the appropriate number:

On the main server, type the prefix 3 (the first digit of each extension on the branch server)

On the branch server, type the prefix 1 (the first digit of each extension on the main server)

6. Click Next.

7. In the Domain (IPaddress/hostname) field, type the domain or the IP address:

On the main server, type the IP address of the branch server.

On the branch server, type the IP address of the main server.

8. Disable the Required to registeroption.

9. Click Next.

10. Verify the information in the Summary section.

11. Click Finish.

After the configuration of interfaces, Kerio Operator creates incoming and outgoing routes that use configured prefixes.
These routes do not rewrite any numbers. Make test calls between the connected servers to reach their extensions.

Example of a test call

Call number 305 from extension 110 on the main server:

1. The user with an extension 110 dials number 305.

2. Kerio Operator on the main server recognizes the prefix 3 and routes the call to the branch server.

3. The call arrives at the branch server and rings on the 305 extension.
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4.7.8 Routing calls betweenmultiple Kerio Operators and the PSTN

NOTE
Redesigned in Kerio Operator 2.4!

Learn how to:

Reach the public switched telephone network (PSTN) from your connected Kerio Operator servers

Route incoming calls from the PSTN to your branch servers

NOTE

For more information about connecting multiple Kerio Operator servers, see Connecting multiple Kerio Operators.

The sections below use the following example:

Two connected Kerio Operator servers up and running:

The main server, which has internal extensions 100 — 199

The branch server, which has internal extensions 300 — 399

Outgoing calls from the branch server to the PSTN go through the main server.

Incoming calls from the PSTN to the branch server go through the main server.

The prefix for outgoing calls to the PSTN is 0.

External numbers from the SIP provider have the format 555 5xxx.



KerioOperator 4 Settings |281

Calling to the PSTN through the main server

To call to the PSTN via the interface of the main server:

Configure the interface on the main server.

Create an outgoing route on the branch server.

In the administration interface of the main server:

1. Go toConfiguration > Call Routing > Interfacesand routing of incoming calls.

2. Double-click the interface for the branch server.

3. Go to the Advanced tab.

4. Select the Allow incoming calls to use outgoing routesoption.

5. Click OK.
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In the administration interface of the branch server:

1. Go toConfiguration > Call Routing > Routing of outgoing calls.

2. Click Add.

3. Type the prefix for outgoing calls of the main server (0 in our example)

4. Select the interface of the main server.

5. Click OK.

Make a test call to reach a number in the PSTN from the branch server.

Example of a test call

Call 555-9999 from extension 305:

1. The user with an extension 305 dials the number 0-555-9999.

2. Kerio Operator on the branch server recognizes the prefix 0 and routes the call to the main server.

3. The call arrives at the main server.

4. Kerio Operator on the main server recognizes the prefix 0 and strips the prefix off.

5. The main server routes the call to the SIP provider.
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Routing incoming calls from the PSTN to the branch server

To route incoming calls to the branch server:

If you have separate numbers, use speed dial extensions

If you have a trunk of numbers, rewrite called numbers tomatch the internal extensions of the branch server

Using speed dial extensions

To use speed dial extensions:

1. Create a speed dial extension (9305 in the example) that dials an extension of the branch server (305 in the
example). For more details, see Creating and using speed dial.

2. Go toCall Routing and double-click the interface for the branch server.

3. Go to the Advanced tab.

4. (Optional) To enable users to return calls, selectDo not substitute the calling numberwhen forwarding callsand
click OK. This option also displays the caller ID of the caller instead of the number of the speed dial extension.

5. Double-click the number from your provider that youwant tomap.
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6. In the Route incoming calls to field, select the speed dial extension and click OK.

7. Repeat steps 1—6 for all extensions youwant tomap to the branch server.

From now on, Kerio Operator uses the speed dial extension for all incoming calls that reach the external number and
routes the call to extension 305 of the branch server.

Make a test call to reach an extension on the branch server.

Example of a test call

Call 555-5305 from 555-9999:

1. Caller dials the number 555-5305.

2. The call arrives at the main server.

3. Kerio Operator routes the call to the 9305 extension and then to305.

4. The main server recognizes the prefix 3 and routes the call to the branch server.

5. The call arrives at the branch server and rings on the 305 extension.

Using number rewriting

To rewrite called numbers from your trunk and route them to the branch server:

1. In the administration interface of the main server, go toConfiguration > Call Routing > Interfacesand routing of
incoming calls.

2. Double-click the interface for the branch server.

3. Go to the Advanced tab.



KerioOperator 4 Settings |285

4. (Optional) To enable users to return calls, selectDo not substitute the calling numberwhen forwarding callsand
click OK. This option also displays the caller ID of the caller instead of the number of the speed dial extension.

5. Double-click the interface for your provider.

6. Go to the Advanced tab.

7. Enable the Allow incoming calls to use outgoing routesoption.

8. Double-click the trunk of numbers to verify that Kerio Operator rewrites the called number correctly.

9. Click OK.

After configuring the interface, make a test call to reach an extension on the branch server from the PSTN.

Example of a test call

Call 555-5310 from 555-9999:

1. Caller dials the number 555-5310.

2. The call arrives at the main server.

3. Kerio Operator matches the call to a SIP interface and strips off the first four digits of the number.

4. The call automatically uses the outgoing route with the prefix 3 and arrives to the branch server.

5. The call rings on the 310 extension.

4.7.9 Creating andusing speeddial

Speed dial is a shortcut for phone numbers (for both the internal extensions and external phone numbers).
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Adding speed dial

Before you begin creating speed dial, select a numerical range youwill use. Speed dial must be different from current
extensions. Generally, it is convenient to create speed dial so that they will not coincide with your dial plan in future.

1. Open SpeedDial.

2. Click Add.

3. In the Add SpeedDialdialog box, type a speed dial in the Speeddial extension field.

4. In Dial number, type the callee's phone number including the prefix for outbound calls.

5. Click OK.

Configuring speed dial with DTMF

The speed dial with DTMF (Dual-tone multi-frequency signaling) is intended for calling special services like long
distance phone service providers. If you need to place a call via such a service, you usually need:

provider's number (usually it is a toll-free number that starts with 800: 800555333)

user ID (78901234)

PIN (8808)

a number youwant to call (011420111222333)

# character — denotes the end of the number and starts the call.

When you set the speed dial with DTMF, the number of steps is shortened to dialing the speed dial extension followed
by the number youwant to call: 89011420111222333

Configuring speed dial with DTMF

1. In the administration interface, go to SpeedDial.

2. Click Add.

3. In the Add SpeedDialdialog box, type a speed dial in the Speeddial extension field. In our example it is 89.

4. In Dial number, type the provider's access number including the prefix for outbound calls.

5. SelectDTMF tonesare enabled. Once you enable DTMF, the speed dial behaves as a dial-out prefix.

6. In the DTMFprefix field, type the access code and PIN. Your provider's IVR systemmay require a pause between typ-
ing the access code and PIN. Therefore use the w character for a half second pause. In our example it is
78901234w8808.

7. In the DTMF suffix field, type #

8. Click OK.
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Screenshot 61: Add SpeedDial dialog

What is happen if you use the speed dial 89?

Youwant to call the number 011420111222333.

To place the call, you dial: 89011420111222333. The service will dial the access number 800555333 and once the call is
connected, the following DTMF digits are sent:

789012348808 011420111222333 #

4.7.10Creating ringing groups

You can use ringing groups tomake calls ring simultaneously on multiple extensions.

Adding new ringing groups

1. In the Kerio Operator administration interface, go to RingingGroupsand click Add.

2. In the Group extension field, type the extension number for the group.

3. Add extensions youwant to ring simultaneously to the table.

4. (Optional) To redirect the call to another extension when no one answers the phone, select Fall backto another
extensionwhen the group isnot responding and set a timeout and destination extension.

5. (Optional) If you don't want to display the answered call as missed on other phones in the group, go toAdvanced
tab and selectDo not displaymissed callson the phones.

6. Click OK.
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4.7.11Customization of voice sets

This summary provides information on how to customize/change voice sets in Kerio Operator.

The Internet provides many sources of localized and customized basic sounds and voice prompts. Voice sets for various
languages can be found at http://www.voip-info.org. However, it is recommended to use voice sets present in Kerio
Operator than downloading them from the Internet, as it may not include all of the prompts used by Kerio Operator.

To customize voice sets:

1. Log in to Kerio Operator administration. Formore information, refer to Logging into Kerio Operator Admin-
istration (page 19).

2. Go to the SystemHealth dialog, hold the shift key and click Tasks. You should see an option to enable SSH.

3. Log in to your systemwith an SSH client (using root and your admin password).

4. Go to /var/lib/asterisk/sounds.

5. Download the directory of sounds youwill use as a base (e.g. en_GB).

6. Modify the .gsm sound files using any compatible sound editor.

7. Compress the folder.

8. Back in the Admin Console, open AdvancedOptions> Telephony.

9. Click Configure next toDefault phone language option and upload the voice sets.

Once you upload a voice and sound set, you can use it for Kerio Operator, individual interfaces or individual users. For
more information, refer to Language settings in Kerio Operator (page 263).

4.7.12Customizing the Kerio Phone login page

Adding your custom logo

To change a logo of your login page:

http://www.voip-info.org/wiki/view/Asterisk+sound+files+international
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1. In the administration interface, go toConfiguration > AdvancedOptions> Login Page.

2. Select the Use custom logo on login page option.

3. Click Change and locate the new logo file. The logomust be in the PNG format. The recommended maximum size is
325 x 80 pixels.

4. Click Apply to save your settings.

Configuring your custom button style

To change a style of a button:

1. In the administration interface, go toConfiguration > AdvancedOptions> Login Page.

2. Select the Use custombutton style option.

3. Type a color's hex value for Text color (for example,#ffffff).

4. Type a color's hex value for Background color (for example,#669900).

5. Click Apply to save your settings.

Adding your custom text

To add a text to your login page:

1. In the administration interface, go toConfiguration > AdvancedOptions> Login Page.

2. Select the Add the following text to the page (supportsHTML) option.

3. Type your text (for example, In case of emergencyissues, call 555-1234).
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4. Click Apply to save your settings.

4.7.13Distinctive ringing support

Kerio Operator supports setting different ring tones for different types of calls (external calls, internal calls or ringing
groups).

Configuring strings Kerio Operator

NOTE
New in Kerio Operator 2.5!

By default, Kerio Operator uses the following strings for the Alert-Info header:



KerioOperator 4 Settings |291

operator-external (calls from an interface)

operator-queue (calls from a call queue)

operator-group (calls to a ringing group)

To configure different ring tones for your SIP interfaces, call queues and ringing groups, change the default string in SIP
"Alert-Info"header:

1. Go toCall Routing, or CallQueues, or RingingGroups.

2. In Call Routing, double-click a SIP interface. In CallQueuesor RingingGroups, double-click an extension.

3. Switch to the Advanced tab.

4. In SIP"Alert-Info"header, change the default string.

5. Click OK.

Configuring telephones (example: snom 360)

1. Go to web administration of your telephone.

2. Go to Setup> Preferences

3. Find the alert-info settings.

4. Set different ringers for different alert-info strings (see screenshot).

5. Save the settings.

For testing purposes: Try tomake a call from an external telephone number, from an internal extension and to ringing
group.
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Screenshot 62: Customising Alert-Info strings

4.7.14 Fax support in Kerio Operator

Using fax in Kerio Operator

Kerio Operator supports:

T.38 protocol

Fax-to-email

PDF-to-fax

T.38 support

T.38 is a protocol for realtime transmission of fax over IP.

Kerio Operator uses T.38 by default. Ask your provider whether they support this protocol. If not, read section Myprovider
does not support T.38.

Connecting a faxmachine to Kerio Operator

1. Connect your fax machine to an Analog Telephone Adapter device (ATA — for example, Cisco SPA 112).

2. Assign one of Kerio Operator extensions to the ATA device.

Fax machine is connected to the network. You can send and receive faxes.
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Configuring an ATA device

You can use various ATA devices. Each device has different settings. The following must be configured:

1. enable T.38

2. set faxpassthru to ReInvite

NOTE

Phone provisioning in Kerio Operator sets these variables automatically.

Receiving faxes to a user's email address

You can enable fax-to-email service for any extension. Kerio Operator then sends all incoming faxes to the user’s email
address as PDF attachments.

WARNING

In the administration interface, define SMTP relay in section AdvancedOptions> General so that your Kerio
Operator can send emails.

In the administration interface:

go toUsersand enter an email address for each user.

go to Extensionsand enable option Forward incoming faxes to user'saddress for the particular user's extension.

Configuring fax detection (CNG signal)

A CNG signal is the fax machine sound youmay hear when there is a fax machine connected to the other end of line.
Kerio Operator can detect the signal and start receiving faxes automatically.

1. In the administration interface, go to Extensions.

2. Double-click a selected extension.

3. On tab Advanced, select:
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Dial extension, wait foranswer, detect CNG — PBX dials an extension, waits for an answer and then starts
detecting the CNG signal. User has to answer a call first in order to receive faxes. When a fax tone is detected,
the call will be taken over by Kerio Operator.

Answer, detect CNG, dial extension — PBX answers a call first, then detects the CNG signal and imme-
diately dials an extension. If users don't answer the phone, a fax mail is received and users have amissed call on
their phone display. This option is good for occasional fax transmissions.

Answer, detect CNG,wait 3.5 seconds, dial extension— Extension is dialed after a 3.5 seconds delay
which is used to detect faxes. There will not be any missed calls shown on the phone's display. Regular calls will
be automatically answered and will be followed by a 3.5 second delay of silence. This option is good for more
frequent fax usage.

Answer, detect CNG,wait 3.5 seconds (ringing tone), dial extension— the PBX will generate a ringing
tone instead of waiting in silence. This option is also good for more frequent fax usage and may be less con-
fusing to human callers.

4. Save the settings.

Receiving all faxes to a specific email address

Kerio Operator can send all incoming faxes to a single email address.

1. Go to PBXServices.

2. Open Receive faxmessages.

3. Type email address in the Send received faxesbyemail to field.

Kerio Operator will send all incoming fax messages to the specified email address.

My provider does not support T.38

WARNING
Fax support without T.38 is not reliable. Using codecs G.711 A-law/U-law instead of T.38 is a workaround.

If your SIP provider does not support T.38, you have to solve these issues:

Enable codecs G.711 A-law/U-law for the transmission. High compression codecs would distort signal.

Reduce the speed on your fax machines (if supported).
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Enabling G.711 A-law/U-law codecs for the interface

1. Login to the administration interface.

2. Go to Configuration > Call Routing.

3. Click the provider's interface.

4. Click the Codecs tab.

5. Move G.711A-law and G.711U-law to the Selected codecs table.

6. Move G.711A-law and G.711U-law codecs up in the table.

NOTE
Moving G.711 A-law/U-law codecs up in the table can cause bandwidth consumption.
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7. Click OK.

Fax messaging now uses codecs G.711 A-law/U-law.

Disabling the T.38 support

Although your SIP provider supports T.38 protocol, youmay experience some difficulties in communication. The solution
is to disable the support for the T.38 protocol:

1. In the administration interface, go toConfiguration > AdvancedOptions.

2. On the Telephony tab, click Configure... next to the SIPConfiguration.

3. UnselectUse T.38 standard for faxing.

Formore information, refer to My provider does not support T.38 (page 294).

Sending PDF to fax

For more information refer to Sending PDF to fax in Kerio Phone.

4.7.15Hosting Kerio Operator

In some situations, it may be preferred to deploy Kerio Operator at a remote site, or data center, as these locations may
offer better bandwidth, reliability, and consolidated management. This topic addresses the considerations when
deploying Kerio Operator outside of the local network.

http://go.gfi.com/?pageid=operator_help#cshid=1230
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Phone Provisioning

When Kerio Operator is deployed on the same network as the IP phones, the provisioning process can be handled
automatically through DHCP. However, if Kerio Operator is remote, the phones typically must be configured manually.
Consider pre-configuring the phones at a convenient location before deployment at the remote site. For ongoing
maintenance of the phones, it will be necessary to use the web administration of the phones, which will require access
to the remote network. We've found Snom, Yealink, and Linksys phones to offer the best options for web configuration
and remote management. For added security, automatic provisioning should be disabled from the dialog in the web
administration, located under Provisioned Phones > Phone Provisioning.

With the introduction of the Kerio Phone mobile app, configuration frommobile devices is quite easy, and ideally suited
in case Kerio Operator is in a hosted, or remote environment. Formore information, refer to Provisioning of Kerio
Operator Softphone for mobile devices (page 176).

Network Configuration

Because Kerio Operator includes a built-in firewall, it's not necessary to incorporate an external firewall. If possible, Kerio
Operator should be assigned an Internet routable IP address to avoid network address translation, as this can cause a
variety of call quality, or connectivity type issues. In many cases, the phones will be connecting through NAT, and there is
an option in the extension properties to account for this. Formore information, refer to Configuring NAT (page 260).

Bandwidth

When Kerio Operator is remote to the phone network, it means that local calls between extensions will be routed
through the Internet. It's important to take this into consideration when evaluating the bandwidth requirements for a
remote network of phones. A typical phone call may consume about 80 kbps, although some codecs may consume less
bandwidth. For locations with limited bandwidth, consider setting GSM as the preferred Codec for those extensions
provisioned on that network. Formore information, refer to Bandwidth used by the different codecs (page 209).

Security

In a hosted scenario, Kerio Operator is typically accessible directly over the Internet (unless access is restricted through
VPN). It's therefore necessary to pay close attention to the security settings related to Kerio Operator. Formore
information, refer to Securing Kerio Operator (page 255).

4.7.16 Setting optional call recording

Call Recording

Call recording is subject to special laws in many countries and may not be legal in your jurisdiction, or may require notice
to the other party of the call.

In Germany and maybe in other countries you have to give callers (your customers) an option to continue without having
their call recorded. This topic helps youwith the following simple settings:

Creating two call queues, one with call recording, the second without recording.

Preparing voice prompt (something like "This call is recorded ..."). How to easily create voice files you can find out in
Using PBX services topic.

Creating simple auto attendant script which allows your customers to choose call queue without call recording.

Recorded calls backup.
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How to create and configure call queues

1. In the administration interface, go to section Configuration > CallQueues.

2. Open the AddCallQueue dialog and enter the extension number for the new queue on tab General (for example
400).

3. Description could be Calls are recorded.

4. Click on Record calls.

5. Set other parameters according to the Configuring call queues topic.

6. Open the AddCallQueue dialog again and enter another extension number on tab General (for example 401).

7. Description could be Calls are not recorded.

8. Set remaining parameters just as the first call queue.

9. Do not click on Record calls.

NOTE
Agents need to logged to both queues.

Now, you have two equal call queues. One of them is recorded and the other is not recorded.

How to create auto attendant script for two call queues

1. In the administration interface, go toConfiguration > Auto Attendant Scripts.

2. Click Add.

3. Enter script extension (for example 500).

4. In the Edit Menu dialog, click Edit.

5. Add some description (script for recorded and unrecorded call queues).

6. Select prepared announcement (for example: "This phone call will be recorded. If you do not want recording your
call, please, press 1 and wait for the connection.")

7. SetDefault action toDial extension numberand enter extension of the call queue with call recording.

8. Create a new row by clicking on Add.

9. Key is set to 1.

10. SetAction toDial extension numberand specify the extension of the call queue without call recording.

11. Click OK.
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Formore information, refer to Configuring auto attendant scripts (page 231).

Saving recorded calls

Kerio Operator can automatically backup recorded calls:

locally — default settings

at a remote storage

Saving recorded calls at a remote FTP/SFTP storage

1. Configure a FTP or SFTP server for storing the backup. Formore information, refer to Configuring Remote
FTP/SFTP Storage (page 305).

2. In administration interface, go to Status> RecordedCalls, click Settings.

3. Select Save to remote storage.

4. Select a type to FTP/SFTP.

5. Verify the FTP/SFTPURL.

6. Click Test Connection.

4.7.17 Setting outgoing calls constraints in Kerio Operator

Youmay want to limit some or all outgoing calls for a variety of reasons. For example, should an outside party obtain the
username and password of one of your employees, they could use your PBX for international calls—possibly involving
fraud and costing youmoney. It is therefore critical to have calls to external networks well configured.

You can set outgoing call constraints to prevent these types of attacks.
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Restricting the length of individual outgoing calls

To set the maximum call duration:

1. In the administration interface, go toConfiguration > Security.

2. SetMaximumduration of each outgoing call. The recommended value is 2 hours.

Restricting the number and length of outgoing calls

You can limit all outgoing calls by creating special rules in the section Configuration > Security in table Outgoing calls
constraints.

The default rule limits the number of outgoing calls to 50 per hour and total call duration to 2 hours per day.

Example

A manufacturer in the United States sells and primarily has contacts just in the U.S. and Canada, but has a factory in
Mexico. Management wants to limit calls to other countries.

1. In the administration interface, open Configuration > Securityand click Add.

2. Type a rule name, such as Constraints for Mexico).

3. In the Applyto these outgoing calls section, selectAll except listed and click Add.

4. Add the calling prefixes as a single string:

For local calls: 9 (outside line)

For U.S. and Canada: 91 (outside line + 1 preceding the area code)

For Mexico: 901152 (outside line + 011 for international call + 52 for Mexico's country code)

5. Define the conditions: SetMaximumcalls count to10 per hour and Maximum total callsduration to 1 hour a day.

6. When the conditions are met, Kerio Operator can send a warning email or block all outgoing calls.

We recommend creating:

One soft rule with lower limits that sends warning messages via email.

Another rule with higher limits that blocks the PBX.

WARNING
If the limits are reached and the PBX is blocked, no one will be able tomake calls to the restricted prefixes. However,
an administrator can unlock the PBX in section Configuration > Security. We recommend making a thorough
analysis of your calls before setting restrictions so that the PBX is not blocked by standard operations.

In addition to these settings, you can also configure similar rules for specific users or groups of users. Formore
information, refer to Disabling outgoing calls to certain countries or regions (page 217).

4.7.18 Tips for Apple iPad

This topic provides a few useful tips for a better administration user experience on Apple iPad.

Screen orientation

It is recommended that iPad is held in the landscape mode while working with the Kerio Administration interface. For
viewing longer dialog boxes, hold the device in the portrait mode.

Tree of sections
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To get more space to view the section content, hide the tree of sections on the left.

Pop-upmenu

To open context menu (e.g. in logs), tap the screen with two fingers at a time.

Sort bycolumns

Select the column and tap to set sorting or open amenu.

Editing table values

First, select a table row. To change the value, single-tap the particular spot.

Logs

If you use search, you can go to the previous or next occurrence by using the arrow buttons.

Log pages can be scrolled by dragging with fingers. The more fingers you use, the faster the page scrolls.

NOTE
If you have Multi-Touch allowed on iOS 5, you can use up to three fingers for log scrolling.

4.7.19Using paging groups and services

Paging, also known as intercom or public address, enables Kerio Operator users to broadcast a message to a user or a
group using a phone's speakers. Phones included in the paging group or service answer the call automatically, and
activate the loud speaker.



KerioOperator 4 Settings |302

WARNING

Paging works with phones that support auto-answer functionality.

The paging group is a group of users to whom you can make a call with using loud speaker.

The paging service is a prefix for paging. You dial the prefix + an extension to page a particular user.

Configuring paging groups

1. In the Kerio Operator administration interface, click Paging.

2. Click AddGroup.

3. Type the paging group extension.

4. To add members to the group, click Add.

5. (Optional) Check Page only idle extensions. Paging does not interrupt active calls.

6. (Optional) Check Beepwhen the call isestablished. Your phone beeps when all phones from the paging group are
connected.

7. Select audio transfer strategy: Select onlyto the receiving party to broadcast the message without giving paging
group members ability to answer. Select in both directions to enable two-way communication.

8. (Optional) To enable call recording, select Record Calls.

9. Click OK.

If you want to check your configuration, dial the group extension and do a test call.

Configuring a paging service

1. Go to the administration interface, and click Paging.

2. Click Add Service.

3. Type Paging service prefix.

4. (Optional) Check Page only idle extensions. Paging do not interrupt active calls.

5. (Optional) Check Beepwhen the call isestablished. Your phone beeps when all phones from the paging group are
connected.

6. Decide, if you want to transfer audio onlyto the receiving party (telephones play the message and users cannot
answer) or in both directions (telephones play the message and users can answer).

7. (Optional) To enable call recording, select Record Calls.

8. Click OK.

If you want to check your configuration, dial the service prefix and an extension and do a test call.

Securing paging

Anyone who knows the extension or whole telephone number of the paging group can use this feature. You can secure
your paging groups and service with Call Permissions. You can create a new call permission group, where paging an
extension or a prefix is denied and add people without permission for using paging:

1. In the administration interface, go toDefinitions> Call Permission Groups.

2. Click Add.
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3. In the Edit Call Permission Group dialog, type a group name (for example Paging).

4. Click Add.

5. In the AddPrefixdialog, type a paging extension or service.

6. Click OK.

7. Go toConfiguration > Extensions.

8. Select the user whowill have paging disabled and click Edit.

9. In the Call permissionsgroupmenu, select the paging rule (in our example it is Paging).

10. Repeat step 9 to disable paging for additional users.

For testing purposes you can add yourself to restricted group called Paging. Try to call the paging group or service.

List of supported and tested phones

Paging was tested by Kerio Technologies with the following telephones:

Cisco SPA508G, SPA525G

Linksys SPA942, SPA922

Polycom IP335, IP650

Well SIP-T38G

Snom 360, 820 and MeetingPoint

4.7.20 Integrating Kerio Connect andKerio Operator

What are the possibilities of Kerio Operator and Kerio Connect integration

There are several posibilities how to integrate Kerio Operator and Kerio Connect:

Integrating voicemail

The integration synchronizes flags which marks whether a voicemail message has been read/played. If youmark a
message as read in Kerio Phone or if the message is marked as read after you hear it on your phone, the message will also
be flagged as read in your mailbox (and vice versa).

If integration with Kerio Connect is set, voicemail messages are not stored in Kerio Operator but in user's Inboxon the
mailserver.

WARNING
Limitation: You can integrate Kerio Connect with a single Kerio Operator only.

Searching the address book on Kerio Connect on provisioned phones

For more information, refer to Accessing company contacts through LDAP on provisioned phones (page 178).

Calling directly from Kerio Connect Client

For more information, refer to Configuring Click to Call in Kerio Connect client (page 304).

Configuring voicemail integration

If you want to set up voicemail integration, follow these steps:



KerioOperator 4 Settings |304

1. Go toConfiguration > Users.

2. In the users' settings, type their email addresses.

WARNING
Use the primary email address (not an alias) — otherwise sending of messages to Inbox will not work.

3. Go toConfiguration > Voicemail > Email.

4. Change the SMTP server settings to Integratewith Kerio Connect.

5. Click Configure and type the DNS name of Kerio Connect.

NOTE
If the IMAP service runs on a nonstandard port in Kerio Connect, enter the server name including the port number
(hostname:12345)

6. Specify the name and password of a user with admin rights for Kerio Connect.

Authentication details are used for the first connection to Kerio Connect and creation of a special account using JSON-
RPC2 API for authentication. Once this special account is created, the PBX drops the administrator's name and password.

NOTE
To synchronize flags between the two servers, Kerio Operator uses protocol IMAP with TLS or IMAPS. If Kerio Connect
is behind firewall, enable at least one service on standard port. The IMAP or IMAPS services need to be allowed on
Kerio Connect server.

Opening ports

If servers are behind a firewall, open the following ports:

143/993

4040

Troubleshooting

If Kerio Connect is protected by firewall, verify that the 143/993 and 4040 ports for the IMAP/IMAPS protocols are open.

The IMAP/IMAPS services must be running in Kerio Connect.

If you cannot connect Kerio Operator with Kerio Connect, consult the following logs:

In Kerio Operator, consult the Warning log for any problems with the IMAP service.

In Kerio Operator, consult the Error log for problems with connection to Kerio Connect’s IMAP server.

In Kerio Connect, consult the Mail log for information about delivered voicemails.

4.7.21Configuring Click to Call in Kerio Connect client

New in Kerio Operator 2.3!

Users of Kerio Connect client can click a contact's phone number to initiate a call from Kerio Operator. By clicking a
number, you can select the registered phone/device to dial from. The selected phone/device will ring. Answer the call
and Kerio Operator will place the outbound call to the dialed number.
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To set up and use the Click to Call feature in Kerio Operator, go to the Configuring a number transformation section.

To set up and use the Click to Call feature in Kerio Connect, go to the Making calls from Kerio Connect topic.

If you want to Click to Call for Kerio Operator plugin for Chrome and Firefox, go to the Using Click to Call for Kerio
Operator plugin for Chrome and Firefox topic.

Configuring a number transformation

Numbers dialed by Click to Call must be in the same format as for usual calls. If you use an outgoing prefix in your
environment, youmust add a number transformation rule to Kerio Operator:

1. In the administration interface, go toIntegration.

2. On the NumberTransformation tab, add the rule for your outgoing prefix (for example 9).

3. Click Add.

4. In the AddNumberTransformation Rule dialog, type dot in the Match number field. Numbers of any length are
matched.

5. In the Addprefix field, add the outgoing prefix (for example 9).

6. Click OK.

Screenshot 63: Rule for outgoing prefix

4.7.22Configuring Remote FTP/SFTP Storage

You can configure a FTP or SFTP server as your remote storage to store data backups and call recordings.

Configuring a FTP server

1. In the administration interface, go to Integration > Remote Storage.

2. Key in the Hostname of the FTP server.

http://go.gfi.com/?pageid=connect_help#cshid=1572
http://go.gfi.com/?pageid=operator_help#cshid=1616.html
http://go.gfi.com/?pageid=operator_help#cshid=1616.html
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3. Key in your FTP serverUsername and Password.

4. Click Test Connection.

Configuring a SFTP server

1. In the administration interface, go to Integration > Remote Storage.

2. Key in the Hostname of the SFTP server.

3. Key in your SFTP serverUsername.

4. Authenticate using your preferred method as described below:

Authenticate using apassword

1. Key in your SFTP server Password.

2. Click Test Connection.

Authenticate using ssh keys

1. Check Use SFTP(SSHFile TransferProtocol).

2. If the public key is already configured on the SFTP server and you have a private ssh key, click Upload Private Key.
Else, click Generate KeyPairs to create new keys for integration. A public key gets downloaded to be configured on the
SFTP server.

NOTE

If you are replacing an existing SFTP server configuration with new a SFTP server, click RemoveKeybefore
uploading or generating a new pair of keys.

3. Click Test Connection.
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5 Troubleshooting
This section helps you fix problems youmight encounter when using Kerio Operator.

5.1 Common issues 307

5.2 Vulnerabilities 313

5.3 USB Tools 313

5.1 Common issues
This section provides solution to various issues:

5.1.1 Troubleshooting connections to SIP providers 307

5.1.2 Troubleshooting call quality issues 310

5.1.3 Browser extensions or add-ons may interfere with Kerio products 311

5.1.4 Cannot play voicemails or audio files in Safari 311

5.1.1 Troubleshooting connections to SIP providers

This topic describes what information youmust acquire from your provider and offers tips on configuring SIP interfaces
in Kerio Operator.

The sections below cover these topics:

SIP servers

Domains

User names

Phone numbers

SIP headers

For more information, refer to Connecting to VoIP service providers (page 25).

For more information, refer to Mapping external and internal numbers (page 197).

SIP SRV records

SRV (service) records are entries in DNS that specify the location of service servers. Some SIP providers have SIP SRV
records defined for their domain name. Asterisk uses SIP SRV resolution for outbound calls.

Tomake outbound calls, youmust add all proxy servers from your provider's SRV records to your Kerio Operator SIP
interface.

To obtain proxies, you can:

Ask your provider directly.

Use a Linux dig command.

Example for nexvortex.com:
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Command:

dig _sip_udp.nexvortex.com SRV

Result:

_sip._udp.nexvortex.com 1800 IN SRV 20 0 5060 px5.nex-
vortex.com.
_sip._udp.nexvortex.com 1800 IN SRV 30 0 5060
px7.nexvortex.com.
_sip._udp.nexvortex.com 1800 IN SRV 10 0 5060 px1.nex-
vortex.com.

To add the proxy servers to the Kerio Operator SIP interface:

1. In the Kerio Operator administration interface, go toConfiguration > Call Routing.

2. Double-click the SIP interface.

3. Go to the SIPDetails tab.

4. Type the names of the proxy servers in the Inboundproxy field.px5.nexvortex.com,px7.nex-
vortex.com, and px1.nexvortex.com in the example above.

5. Click OK.

Domains and usernames

If you have issues related to domain or user names while configuring a SIP interface:

Verify that the Authentication usernames and the SIP name are correct. If you don't get any Authentication username
from your provider, assume that they are the same.

Verify your provider's domain name. Some providers use different terminology, for example, "server name" or "iden-
tifier to be used instead of the host name part of the SIP URI".

Verify that the provider uses the same server name for all SIP server roles (registration, inbound proxy, outbound
proxy). If not, configure the Kerio Operator SIP interface correctly for your provider.

If your provider has multiple SIP servers, type all of them in the Kerio Operator SIP interface.

Phone numbers

Number formats

Before you configure a SIP interface and incoming and outgoing routes in Kerio Operator:

Verify the format of phone numbers your provider uses.

The specific number of digits, for example, 9-digit numbers, 10-digit numbers, and so on. note that some US
providers use 11-digit numbers instead of 10-digit numbers. In that case, the first digit is always 1.

E.164 number format, where numbers start with the + sign followed by a country code (for example,+1 in
the US). This format often requires configured number rewriting for outgoing calls. For example, rewrite dialed
numbers that start with 9 so that the called numbers start with +1 (94084964500 to+14084964500).

Custom number format, where, for example, providers use the international format without the + sign.
Rewrite all national and international numbers to the custom format of the provider.

Verify that the number format for inbound calls and outbound calls is the same. If not, configure number rewriting
correctly for your provider. For example, your provider sends you 10-digit numbers, but requires 11-digit numbers for
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outbound calls. Create an outgoing route that rewrites numbers to 11-digit format.

Phone numbers as identifiers

Your provider can use phone numbers instead of SIP usernames. If you have only a single external number, many
providers use your external number as a SIP username as well.

If you have multiple numbers, your provider:

Uses one of the external numbers as the SIP username.

Gives you a random string or the common part of your external numbers.

Gives youmultiple accounts, each account with a single external number. Create a SIP interface for each account. You
can then assign all interfaces under the same dial-out prefix.

SIP headers

Call setup

When a device initiates a SIP call, it sends the SIP INVITE request. The beginning of the request looks like this:

INVITE sip:13@10.10.1.13 SIP/2.0
Via: SIP/2.0/UDP 10.10.1.99:5060;branch=z9hG4bK343bf628;rport
From: "Test 15" <sip:15@10.10.1.99>tag=as58f4201b
To: <sip:13@10.10.1.13>...

In the request above, extension 15 calls extension 13.

The called number is in the INVITE (Request-Line in the Kerio Operator administration interface) and To headers.

The calling number is in the From header.

After you create a SIP interface, Kerio Operator reads the calling number from the From header and the called number
from the INVITE header by default. Verify which headers your provider requires and change the settings in the Kerio
Operator SIP interface.

Formore information, refer to Connecting to VoIP service providers (page 25).

Example

You have multiple numbers in range 5551200-5551299.

Your username is the common part of your numbers, 55512.

The SIP provider sends 55512 in the INVITE header and the specific number, for example 5551234, in the To header.

For outgoing calls, your provider requires 55512 in the From header and the calling number in the P-Preferred-Identity
header.

Transferring calls

When transferring calls, Kerio Operator can notify the receiving party about the original caller, otherwise the callee
cannot recognize the origin of the call.

Enable the Diversion header on the SIPDetails tab of the SIP interface.

If the Diversion header doesn't work, ask your provider which SIP header to use.
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5.1.2 Troubleshooting call quality issues

When using voice over IP, there are many considerations which can affect the quality of phone calls, and identifying the
source of the issue can sometimes be difficult. This topic is designed to describe the different types of call quality issues,
the general causes, and a likely solution to each type of issue.

Symptom:

One-way, or No Audio

Cause:

Improper NAT settings, or improper handling of SIP/RTP by the firewall.

Solution:

Avoid NAT, Bypass the firewall by connecting Kerio Operator directly to the WAN, and attaching a second network
interface to the local network. Otherwise, verify the NAT settings in Kerio Operator and the connected SIP device.
Configuration details are available in KB topic Configuring NAT. Also check the kerio forums or other resources for known
SIP handling issues with the brand of firewall in front of Kerio Operator. The firewall should be configured to allow
TCP/UDP port 5060 and 5061, and UDP ports 10000 ~ 20000

Symptom:

Garbled, or incomprehensible voice transmission.

Cause:

Bad Codec

Solution:

Identify and remove the bad Codec from the selected codecs in the call route.

NOTE
Troubleshooting tip: During a call, review Status > Calls and check the used Codec. Compare it to calls that don't
have the issue.

Symptom:

Choppy voice quality. Some words or parts of the conversation are lost or cut off.

Causes:

Insufficient or jittery Internet bandwidth.

Local networking issue (bad cable, overloaded switch, bad NIC, overloaded WiFi)

High CPU usage or insufficient hardware resources

Solutions:

Set GSM as the only selected Codec on the call route. Research options for allocating more bandwidth or incor-
porating QoS.
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Update firmware of the phone, replace the cable to the phone, change the Codec of the extension, replace the
phone.

Upgrade hardware to faster storage device (e.g. SSD) or add RAM

NOTE
Troubleshooting tips: Enable extension 81 for the echo test. Dial from various locations and phones to isolate the
conditions under which the choppiness occurs. From a browser on that network, go to pingtest.net and check the
line quality. Check the status > system health tomake sure the CPU/Memory is not overloaded. Check settings for
call recording and logging to ensure reduced File I/O.

Capturing the network communication (packet capture or packet dump):

If the previously mentioned steps were not helpful, it may be necessary to capture the network communication for
analysis. To do this, navigate to Configuration > Network. Select the network interface which is linked to the network
where the issue is observed. Click the 'Packet Sniffer...' button to the right of the interfaces dialog. Start the capture, then
attempt to reproduce the problem. Once the issue has been observed, stop the capture and download the capture file. If
you have an open case with technical support, they may request this file.

5.1.3 Browser extensions or add-onsmay interferewith Kerio products

When you have trouble working with an administration or client interface of Kerio products, you can try to disable or
uninstall all your browser's extensions/add-ons.

Here are some tips on how to do it in the most common browsers:

Google Chrome— Disable your extensions or run the browser in the incognito mode.

Mozilla Firefox— Disable your add-ons or run the browser in Save Mode.

Safari— Turn all extension off.

Internet Explorer— Disable your add-ons or run the browser in NoAdd-onsmode.

5.1.4 Cannot play voicemails or audio files in Safari

What happens

Do you have any problemwith playing voicemails or audio files in Kerio Operator administration or Kerio Phone? Playing
of audio files via HTML5 is not possible when the SSL certificate of the hostname is not trusted.

Where it happens

It happens in:

Safari on Apple Mac OS X systems,

Safari on Apple iPhone,

Safari on Apple iPad,

Safari on Windows.

How to fix it

Use a certificate verified by a Certification Authority, or install a self-signed SSL certificate properly and mark it as trusted
on your device.

http://pingtest.net/
https://support.google.com/chrome/answer/187443?hl=en
https://support.google.com/chrome/answer/95464?hl=en
http://support.mozilla.org/en-US/kb/disable-or-remove-add-ons
https://support.mozilla.org/en-US/kb/troubleshoot-firefox-issues-using-safe-mode#w_how-to-start-firefox-in-safe-mode
https://support.apple.com/kb/PH19287
http://windows.microsoft.com/is-is/internet-explorer/manage-add-ons#ie=ie-10
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WARNING
In Safari on Windows you need a certificate verified by a Certification Authority. Self-signed certificates do not work.

How to set self-signed certificate as trusted on Mac OS X systems

1. Type your Kerio Operator address to the Safari browser. SSL certificate warning appears.

2. Click Show Certificate.

3. Check Always trust.

4. Click Continue.

5. Enter administrator's username and password for authentication.

How to set self-signed certificate as trusted on Apple iPhone and Apple iPad

1. Type your Kerio Phone address to browser. The login window appears.

2. Tap on the Download SSL certificate link.

3. Install the certificate.

NOTE
This certificate will also be used for access to the administration interface too.
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5.2 Vulnerabilities

Vulnerability Description

Bash vul-
nerability CVE-
2014-6271,
CVE-2014-7169
(ShellShock)

The shellshock vulnerability (aka CVE-2014-6271 and CVE-2014-7169) is a security bug affecting Unix-like
operating systems through the Bash shell.
For information on its impact on Kerio products, read Bash vulnerability CVE-2014-6271, CVE-2014-7169
(ShellShock) article.

Linux Glibc vul-
nerability CVE-
2015-7547

A vulnerability in the Linux glibc system library has been found. An attacker can gain root access to the server and
execute a code.
For more details on its impact on Kerio products, read Linux Glibc vulnerability CVE-2015-7547 article.

Linux vul-
nerability CVE-
2015-0235
(GHOST)

There is a vulnerability in Linux glibc system library. An attacker can exploit this vulnerability and gain root access
to your server and execute a code.
For more details on its impact on Kerio products, read Linux vulnerability CVE-2015-0235 (GHOST) article.

OpenSSL vul-
nerability CVE-
2014-0160
(Heartbleed)

The National Institute of Standards and Technology (NIST) has published a vulnerability to OpenSSL 1.0.1. Details
regarding the vulnerability are available from the NIST website. Kerio Operator 2.2.0 up to 2.2.4 used the
affected version of the OpenSSL library. However, a fix is available for Kerio Operator as of version 2.2.5. You can
download this release from the Kerio Website.
For additional information and security precautions, read OpenSSL vulnerability CVE-2014-0160 article.

SSL 3.0 vul-
nerability CVE-
2014-3566 and
POODLE

This vulnerability is a flaw in the protocol design. An attacker that controls the network between the client and
the server can interfere with any attempted handshake offering TLS 1.0 or later and force both client and server
to use SSL 3.0 protocol instead. They can then use other attack techniques (eg. BEAST attack) to decipher
transmitted data.
For information on its impact on Kerio products, read SSL 3.0 vulnerability CVE-2014-3566 (POODLE) article.

5.3 USB Tools
This section provides information about password recovery, factory reset, and diagnosing Kerio Operator hardware
appliances via an USB flash drive.

5.3.1 Restoring the Kerio Operator default configuration using a USB flash-drive 313

5.3.2 Restoring the Kerio Operator Box V series default configuration using a USB flash drive 317

5.3.3 Diagnostic tool for Kerio Operator Box 320

5.3.4 Diagnostic tool for Kerio Operator Box V series 322

5.3.5 Recovering password using USB flash-drive for Kerio Operator 324

5.3.6 Recovering your Kerio Operator Box V series password using a USB flash drive 325

5.3.1 Restoring the Kerio Operator default configuration using a USB flash-drive

Kerio Technologies provides a set of tools for solutions for situations in which it is not possible to connect to Kerio
Operator on a network and administer it through the Kerio Operator Administration web interface.

These tools are designed to run from a USB flash-drive.

For complete system recovery a USB flash-drive with capacity of at least 1 GB is required. For restoring the default
configuration, a capacity of 256 MB is needed.

http://web.nvd.nist.gov/view/vuln/detail?vulnId=CVE-2014-6271
http://web.nvd.nist.gov/view/vuln/detail?vulnId=CVE-2014-7169
https://www.gfi.com/support/products/Bash-vulnerability-CVE-2014-6271-CVE-2014-7169-ShellShock
https://www.gfi.com/support/products/Bash-vulnerability-CVE-2014-6271-CVE-2014-7169-ShellShock
https://www.gfi.com/support/products/Linux-Glibc-vulnerability-CVE-2015-7547
https://www.gfi.com/support/products/Linux-vulnerability-CVE-2015-0235-GHOST
http://web.nvd.nist.gov/view/vuln/detail?vulnId=CVE-2014-0160
http://www.kerio.com/support/kerio-operator
https://www.gfi.com/support/products/OpenSSL-vulnerability-CVE-2014-0160
https://www.gfi.com/support/products/SSL-3-0-vulnerability-CVE-2014-3566-POODLE
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Should any issues arise (for example, if Kerio Operator fails to work even after you perform a complete system recovery)
please contact our technical support.

Restoring default configuration

The factory settings of Kerio Operator can be recovered with the file kerio-operator-factory-reset.

Factory settings recovery includes removal of all configuration data including activation and the statistics database.

This USB tools is designed for a single use so that an operation will not repeat if you restart with the flash-drive still in the
USB port. Once you perform the operation, the content cannot be reused, so the file can be removed from the flash-
drive.

1. Insert a USB flash-drive to your computer (256 MB or larger) into a USB port on your computer.

2. Make sure that only one partition with file system FAT16 or FAT32 (VFAT ) is created on the flash-drive. The USB drive
must not be formatted by file systemNTFS or ext2, ext3, or ext4.

3. Save the kerio-operator-factory-reset file to the flash-drive.

4. Switch off Kerio Operator.

5. Plug the USB flash-drive into one of the USB ports of your Kerio Operator.

6. Switch on Kerio Operator.

7. For factory settings recovery to take effect, Kerio Operator is restarted automatically.

8. To connect to Kerio Operator, set the following TCP/IP parameters on your computer:

IP address:10.10.10.2

Subnet mask:255.255.255.0

9. Use the web browser of the connected computer to enter the following address:
https://10.10.10.1:4021/admin

10. Set the administrator password, login to the product administration and configure Kerio OperatorBoxas needed.

WARNING
If the steps above do not work, try another flash-drive. Different Kerio Operator Box models require different USB
drive formats:

Kerio Operator Box 1210, 3210 and 3230 require a USB flash-drive formatted like a floppy disk (not partitioned).

Kerio Operator Box 1220 requires a flash-drive formatted with amaster boot record (MBR). USB drives with floppy-
type formatting cannot connect to Kerio Operator Box, but can be reconfigured to work. See Formatting USB flash-
drive with MBR below.

Complete system recovery

Kerio Operator can be completely recovered with the kerio-operator-rescue file. Within the system recovery, all
configuration data including activation and the statistics database will be completely rewritten. Therefore the device will
have to be reactivated and reconfigured for further use.

Before applying complete system recovery, it is highly recommended to retest connection to Kerio Operator after
attempting for restore of the factory settings.

http://support.kerio.com/
http://download.kerio.com/dwn/kerio-operator-factory-reset.bin
http://download.kerio.com/dwn/kerio-operator-factory-reset.bin
http://download.kerio.com/dwn/kerio-operator-rescue.img
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Preparing flash-drive for system recovery

For complete system recovery, Kerio Operator Box first needs to introduce operating system fromUSB drive. File kerio-
operator-rescue is an image of an installation drive and must be saved directly on the physical device (similarly as in
case of burning ISO images on CD). Please follow the instructions according to your client system.

Microsoft Windows

1. Mount the USB flash-drive to your computer. If necessary, back up files saved on the drive. The flash-drive data will be
rewritten completely!

2. Download and unpack Image Writer (it does not require installation).

3. Download file kerio-operator-rescue.

4. In application ImageWriter, look up this file, select your flash-drive and click on Write.

5. Remove the drive securely and unplug it from your computer.

Linux

1. Mount the USB flash-drive to your computer. If necessary, back up files saved on the drive. The flash-drive data will be
rewritten completely!

2. Download file kerio-operator-rescue.

3. Run the terminal (console).

4. Use command sudo fdisk -l to detect the USB flash-drive name (e.g./dev/sdb).

5. Save the kerio-operator-rescue file to the USB flash-drive using command:sudo dd if=rescue.img
of=/dev/sdx bs=1M and replace rescue.img with the real file name and /dev/diskX with the real appli-
ance. It is necessary to enter the physical device (e.g./dev/sdx), not only a partition (e.g./dev/sdx1).

6. Use command sudo sync to guarantee finishing of all drive operations.

7. Unplug the USB drive from your computer.

Mac OSX

1. Mount the USB flash-drive to your computer. If necessary, back up files saved on the drive. The flash-drive data will be
rewritten completely!

2. Download file kerio-operator-rescue.

3. Run the terminal (Applications> Utilities> Terminal).

4. Use command sudo diskutil list to detect the USB flash-drive name (e.g./dev/DiskX).

5. Use command sudo diskutil unmountDisk /dev/diskX to unmount the drive.

6. Save file kerio-operator-rescue to the USB flash-drive by using command: sudo dd if=rescue.img of=/dev/Disk1
bs=1m and replace rescue.img with the real file name and /dev/diskX with the real appliance.

7. Unplug the USB drive from your computer.

Kerio Operator Box device system recovery

1. Switch off Kerio Operator Box.

2. Plug the USB flash-drive into one of the USB ports of your Kerio OperatorBox.

3. Start the Kerio Operator Box and wait for a sound signal.

4. To connect to Kerio Operator, set the following TCP/IP parameters on your computer:

http://download.kerio.com/dwn/kerio-operator-rescue.img
http://download.kerio.com/dwn/kerio-operator-rescue.img
http://win32diskimager.sourceforge.net/
http://download.kerio.com/dwn/kerio-operator-rescue.img
http://download.kerio.com/dwn/kerio-operator-rescue.img
http://download.kerio.com/dwn/kerio-operator-rescue.img
http://download.kerio.com/dwn/kerio-operator-rescue.img
http://download.kerio.com/dwn/kerio-operator-rescue.img
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IP address:10.10.10.2

Subnet mask:255.255.255.0

5. Use the web browser of the connected computer to enter the following address:
https://10.10.10.1:4021/admin

6. Set the password, login to the product administration and configure Kerio OperatorBoxas needed.

Recovering USB flash-drive for further use

Special partitions are now created on the USB flash-drive and part of the space is unused. To reuse the drive again as an
external desk for other purposes, remove all drive partitions, create one or more new partitions and reformat the drive by
an appropriate file system.

Please follow the instructions according to your client system.

Microsoft Windows

1. Run the Command Line.

2. Enter command diskpart. On Windows Vista and Windows 7 confirmation of running the application under
administration account can be required.

3. Use command list disk to show the list and look up the number of the physical disk.

4. Enter command select disk 8 (replace number 8 by the number of the corresponding disk).

5. Use command clean to remove all created partitions.

6. Create a new disk partition by using the following commands, as listed:

create partition primary
select partition 1
format fs=fat32 label="USB Flash"
exit

Linux

Use graphical tool GParted or command fdisk.

Mac OSX

Use system tool Disk Utility (Application > Utilities> DiskUtility).

Formatting USB flash-drive with MBR

1. Connect the USB flash-drive to a computer with Windows operating system.

2. Run the Command Line.

3. Enter command diskpart. On Windows Vista and Windows 7 confirmation of running the application under
administration account can be required.

4. Use command list disk to show the list and look up the number of the physical disk.

5. Enter command select disk 8 (replace number 8 by the number of the corresponding disk).

6. Use command clean to remove all created partitions.

7. Create a new disk partition by using the following commands, as listed:
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create partition primary
select partition 1
format fs=fat32 label="USB Flash" quick
exit

5.3.2 Restoring the Kerio Operator BoxV series default configuration using a USB flash drive

Kerio Technologies provides a set of tools for solutions for situations in which it is not possible to connect to Kerio
Operator on a network and administer it through the Kerio Operator Administration web interface.

You can upgrade the system in your Kerio Operator V series box with a USB flash drive.

You need a flash drive with the capacity of at least 1 GB to run the tools. For restoring the default configuration, 256 MB
suffice.

If you have any issues after using the tools, for example, if Kerio Operator fails to work even after you perform a complete
system recovery, please contact our technical support.

Restoring the default configuration

Recovering to factory settings includes removal of all configuration data including activation and the statistics database.

This USB tool is designed for a single use so that the operation does not repeat if you restart with the flash drive still in
the USB port. You can remove the files from the flash drive after the upgrade.

1. Insert the flash drive into a USB port on your computer (256 MB an more).

2. Make sure that only one partition with the FAT16or FAT32 (VFAT) file system is created on the flash drive. The USB
disk must not be formatted by the NTFS, ext2, ext3, or ext4 file systems.

3. Download and save the kerio-operator-factory-reset file to the flash drive.

4. Switch off Kerio Operator.

5. Plug the USB flash drive into a USB port of your Kerio Operator box.

6. Switch on the Kerio Operator box.

7. Kerio Operator restarts automatically.

8. To connect to Kerio Operator, set the following TCP/IP parameters on your computer:

IP address: 10.10.10.2

Subnet mask: 255.255.255.0

9. In your web browser, type this URL:https://10.10.10.1:4021/admin

10. Activate the product, login to the product administration interface and configure Kerio Operator as needed.

Running a complete system recovery

During the complete system recovery, all configuration data, including activation and the statistics database, is
completely rewritten. This means that youmust reactivate and reconfigure the device afterwards.

IMPORTANT

Before doing a complete system recovery, restore the default configuration and then retest the connection to
Kerio Operator.

http://www.kerio.com/support
http://download.kerio.com/dwn/kerio-operator-factory-reset.bin
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Preparing a flash drive for a complete system recovery

For a complete system recovery, youmust save the installation disk image directly to the physical device.

Microsoft Windows

1. Insert the flash drive into a USB port on your computer (1 GB an more).

NOTE
All data on the flash drive will be completely overwritten.

2. Download and unpack Image Writer (it does not require installation).

3. Download the kerio-operator-rescue file.

4. In Image Writer, find the file, select your flash drive and click Write.

5. Eject the flash drive securely and remove it from your computer.

Linux

1. Insert the flash drive into a USB port on your computer (1 GB an more).

NOTE
All data on the flash drive will be completely overwritten.

2. Download the kerio-operator-rescue file.

3. Run the terminal (console) in the super-user mode (for example, using the su or sudo -s command depending
on your Linux distribution).

4. Use the command fdisk -l to detect the USB flash drive name (for example,/dev/sdx).

5. Save the kerio-operator-rescue file to the flash drive using the following command:dd if=rescue.img
of=/dev/sdx bs=1M and replace rescue.img with the real file name and /dev/sdx with the actual
device name. Youmust type the physical device (for example,/dev/sdx), not a partition (for example,
/dev/sdx1).

6. Use the sync command to ensure all disk operations finish.

7. Eject the USB drive safely and remove it from the USB port.

Mac OSX

1. Insert the flash drive into a USB port on your computer (1 GB an more).

NOTE
All data on the flash drive will be completely overwritten.

2. Download the kerio-operator-rescue file.

3. Run the terminal:Applications> Utilities> Terminal.

4. Use the sudo diskutil list command to detect the USB flash drive name (for example,/dev/diskX).

NOTE
The drive name is case sensitive.

http://win32diskimager.sourceforge.net/
http://download.kerio.com/dwn/kerio-operator-rescue.img
http://download.kerio.com/dwn/kerio-operator-rescue.img
http://download.kerio.com/dwn/kerio-operator-rescue.img
http://download.kerio.com/dwn/kerio-operator-rescue.img
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5. Use the sudo diskutil unmountDisk /dev/diskX command to unmount the flash drive.

6. Save the kerio-operator-rescue file to the USB flash drive using the following command:sudo dd if=re-
escue.img of=/dev/disk1 bs=1m and replace rescue.img with the real file name and
/dev/diskX with the actual device name.

7. Eject the flash drive securely and remove it from your computer.

Kerio Operator Box system recovery

1. Switch off Kerio Operator.

2. Plug the USB flash drive into a USB port of your Kerio Operator Box.

3. Switch on Kerio Operator.

4. To connect to Kerio Operator, set the following TCP/IP parameters on your computer:

IP address: 10.10.10.2

Subnet mask: 255.255.255.0

5. In your web browser, type this URL:https://10.10.10.1:4021/admin

6. Activate the product, login to the product administration interface and configure Kerio Operator as needed.

Recovering the USB flash drive for further use

The recovery file creates partitions on the USB flash drive. To reuse the USB drive for other purposes, you need to remove
all disk partitions, create new partitions, and reformat the disk for your file system.

Microsoft Windows

1. Click Start and in the Search field type cmd.exe to open the CommandPromptwindow.

2. In the command line, type diskpart. Youmay need to confirm that you have administration rights.

3. Type list disk to display the list of drives and look up the number of the physical USB drive.

4. Type select disk X (replace X with the number of the corresponding disk).

5. Type clean to remove all partitions.

6. Create a new disk partition by typing the following commands in the order listed:

create partition primary
select partition 1
format fs=fat32 label="USB Flash" quick
exit

Linux

Use the graphical tool GParted or the command fdisk.

Mac OSX

Use the system tool Disk Utility:Application > Utilities> DiskUtility.

Formatting a USB flash drive with MBR

1. Click Start and in the Search field type cmd.exe to open the CommandPromptwindow.

2. In the command line, type diskpart. Youmay need to confirm that you have administration rights.

http://download.kerio.com/dwn/kerio-operator-rescue.img
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3. Type list disk to display the list of drives and look up the number of the physical USB drive.

4. Type select disk X (replace X with the number of the corresponding disk).

5. Type clean to remove all partitions.

6. Create a new disk partition by typing the following commands in the order listed:

create partition primary
select partition 1
format fs=fat32 label="USB Flash" quick
exit

Related articles

Formore information, refer to Recovering your Kerio Operator Box V series password using a USB flash drive (page
325).

5.3.3Diagnostic tool for Kerio Operator Box

Kerio Technologies provides diagnostic tool for diagnose hardware problems with the Kerio Operator Box, which elicits
crucial information for the Kerio Technologies technical support. The tool is designed for use from a USB flashdisk.

You need a USB flasdisk with capacity of at least 256 MB.

The diagnostics tool is designed for a single use to avoid unexpected repetition of the operation upon the next restart in
case that the flashdisk has not been dismounted. This implies that once you perform the operation, the disk content
cannot be used again and the files can be removed.

Using a diagnostic USB tool

NOTE
Kerio Operator uses the same diagnostic tool as Kerio Control. For diagnostics, use the kerio-control-
usbdiag file.

If you need the USB diagnostic tool, download and use the diagnostic tool.

Creating diagnostic flashdisk

The diagnostic tool is an image of an installation disk and must be saved directly on the physical device (similarly as in
case of burning ISO images on CD). Please follow the instructions according to your client system.

Microsoft Windows

1. Mount the USB flashdisk to your computer. If necessary, back up files saved on the disk. The flashdisk data will be
rewritten completely!

2. Download and unpack Image Writer (it does not require installation).

3. Download file the diagnostic tool file.

4. In application ImageWriter, look up this file, select your flashdisk and click on Write.

5. Remove the disk securely and unplug it from your computer.

http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://win32diskimager.sourceforge.net/
http://download.kerio.com/dwn/kerio-control-usbdiag.img


KerioOperator 5 Troubleshooting |321

Linux

1. Mount the USB flashdisk to your computer. If necessary, back up files saved on the disk. The flashdisk data will be
rewritten completely!

2. Download the diagnostic tool file.

3. Run the terminal (console).

4. Use command sudo fdisk -l to detect the USB flashdisk name (e.g./dev/sdb).

5. Save the diagnostic tool file on this device by using the following command:

sudo dd if=usbdiag.img of=/dev/sdx bs=1M

Replace string with:

usbdiag.img by the real file name and /dev/sdx by the real device. It is necessary to enter the physical device
(e.g./dev/sdx), not only a fragment (for example,/dev/sdx1).

6. Use command sudo sync to guarantee finishing of all disk operations.

7. Unplug the USB disk from your computer.

Mac OS X

1. Mount the USB flashdisk to your computer. If necessary, back up files saved on the disk. The flashdisk data will be
rewritten completely!

2. Download the diagnostic tool file.

3. Run the terminal (Applications> Utilities> Terminal).

4. Use command sudo diskutil list to detect the USB flashdisk name (e.g./dev/diskX or
/dev/DiskY— watch the letter case).

5. Use command sudo diskutil unmountDisk /dev/diskX to unmount the disk.

6. Save the diagnostic tool file on the USB disk by using the following command:

sudo dd if=usbdiag.img of=/dev/disk1 bs=1m

Replace string with:

usbdiag.img by the real file name and /dev/diskX by the real device.

7. Unplug the USB disk from your computer.

Using diagnostic flashdisk

1. Switch off Kerio Operator Box.

2. Plug the USB flashdisk into one of the USB ports of your Kerio Operator Box.

3. Switch on Kerio Operator Box.

4. Approximately after twominutes Kerio Operator Box beeps three times. This means that the operating system has
been introduced and the diagnostic test has just been started. If the device does not beep within the following 10
minutes, the test has failed. In such case switch off the device, unplug the USB flashdisk and send diagnostic inform-
ation the

Kerio Technologies
technical support (see below).

http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://download.kerio.com/dwn/kerio-control-usbdiag.img
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5. The test starts with 10 beeps and runs for about 60 minutes — a 40-minute memory test and a diagnostic test. If you
want to skip the memory test, press any key during the ten-beep interval. Once the test is finished, Kerio Control Box
starts beeping every 30 seconds.

6. Switch off Kerio Operator Box and unplug the USB flashdisk.

Test results processing

Plug the USB flashdisk to your computer again. There is a partition called

KerioDiag
on the disk. This partition includes the file with test results.

Please send this file to the Kerio Technologies technical support and possibly provide a description of the non-standard
behavior of your Kerio Operator Box.

Recovering USB flashdisk for further use

Formore information, refer to Recovering USB flash-drive for further use (page 316).

5.3.4Diagnostic tool for Kerio Operator BoxV series

Kerio Technologies provides a tool for diagnosing hardware problems with the Kerio Operator Box NG series. This tool
collects crucial information for the Kerio Technologies technical support. It is designed to be run from a USB flash drive.

You need a USB flash drive with a capacity of at least 256 MB.

The diagnostic tool is designed for a single use so that the operation will not repeat if you restart with the flash drive still
in the USB port. Once you perform the operation, the content cannot be reused, so the files can be removed from the
flash drive.

Creating the diagnostic flash drive

NOTE
Kerio Operator uses the same diagnostic tool as Kerio Control. For diagnostics, use the kerio-control-
usbdiag file.

The diagnostic tool is an image of an installation disk and must be saved directly on the physical device. Follow the
instructions for your client system below.

Microsoft Windows

1. Insert the flash drive to your computer (256 MB or larger) into a USB port on your computer.

NOTE
All data on the flash drive will be completely overwritten, so be sure to save any files you need elsewhere.

2. Download and unpack Image Writer (it does not require installation).

3. Download the diagnostic tool file.

4. In ImageWriter, find the file, select your flash drive and click Write.

5. Eject the flash drive securely and remove it from your computer.

Linux

1. Insert the flash drive into a USB port on your computer.

http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://win32diskimager.sourceforge.net/
http://download.kerio.com/dwn/kerio-control-usbdiag.img
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NOTE
All data on the flash drive will be completely overwritten, so be sure to save any files you need elsewhere.

2. Download the diagnostic tool file.

3. Run the terminal (console).

4. Use the command sudo fdisk -l to detect the USB flash drive name (e.g.,/dev/sdx).

5. Save the diagnostic tool file on the flash drive using this command:sudo dd if=usbdiag.img
of=/dev/sdx bs=1M (replace usbdiag.img with the real file name and /dev/sdx with the actual device
name). Youmust enter the physical device (e.g.,/dev/sdx), not the partition (e.g.,/dev/sdx1).

6. Use the command sudo sync to ensure that all disk operations finish.

7. Eject the flash drive securely and remove it from your computer.

Mac OSX

1. Insert the flash drive into a USB port on your computer.

NOTE
All data on the flash drive will be completely overwritten, so be sure to save any files you need elsewhere.

2. Download the diagnostic tool file.

3. Run the terminal:Applications> Utilities> Terminal.

4. Use the command sudo diskutil list to detect the USB flash drive name (e.g.,/dev/diskX or
/dev/DiskY).

NOTE
This is case sensitive.

5. Use the command sudo diskutil unmountDisk /dev/diskX to eject the flash drive.

6. Save the diagnostic tool file on the USB flash drive using this command:sudo dd if=usbdiag.img
of=/dev/disk1 bs=1m (Replace string usbdiag.img with the real file name and /dev/diskX with the
real device).

7. Eject the flash drive securely and remove it from your computer.

Using the diagnostic flash drive

1. Switch off Kerio Operator Box.

2. Plug the USB flash drive into one of the USB ports of your Kerio OperatorBox.

3. Switch on Kerio Operator Box to run the diagnostic test. The diagnostic test may take some time (approximately 60
minutes).

4. Switch off Kerio Operator Box and eject the USB flash drive.

Test results processing

Reinsert the flash drive into the USB port.

Find the partition called KerioDiag on the flash drive. It contains the file with test results.

http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://download.kerio.com/dwn/kerio-control-usbdiag.img
http://download.kerio.com/dwn/kerio-control-usbdiag.img
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Send this file to Kerio Technologies technical support, and optionally provide a description of the nonstandard behavior
of your Kerio Operator Box.

Recovering USB flash drive for further use

To reuse your flash drive, you will need to reformat it to remove the partitions. Formore information, refer to Restoring
the Kerio Operator Box V series default configuration using a USB flash drive (page 317).

Related articles

Formore information, refer to Recovering your Kerio Operator Box V series password using a USB flash drive (page
325).

For more information, refer to Restoring the Kerio Operator Box V series default configuration using a USB flash
drive (page 317).

5.3.5 Recovering password usingUSB flash-drive for Kerio Operator

Kerio Technologies provides a tool for password recovery. The tool is designed for use from a USB flash-drive.

For password recovery a USB flash-drive with capacity of at least 256 MB will do.

The password recovery tool is designed for a single use to avoid unexpected repetition of the operation upon the next
restart in case that the flash-drive has not been dismounted. This implies that once you perform the operation, the disk
content cannot be used again and the files can be removed.

Creating and using a password recovery tool

Forgotten administration password can be recovered by using file kerio-operator-password-reset.

Follow these instructions:

1. Mount the USB flash-drive to your computer.

2. Make sure that only one fragment with file system FAT16or FAT32 (VFAT) is created on the flash-drive. The USB disk
must not be formatted by file systemNTFS or ext2 / ext3 / ext4.

3. Save file kerio-operator-password-reset to the flash-drive.

4. Switch off the Kerio Operator.

5. Plug the USB flash-drive into the USB port.

6. Switch on Kerio Operator.

7. In your web browser, open the Kerio Operator Administration.

8. Activation wizard opens in the browser. As the product has already been activated, the wizard will require a new
administration password.

Now you can login as user Admin with a new password.

http://download.kerio.com/dwn/kerio-operator-password-reset.bin
http://download.kerio.com/dwn/kerio-operator-password-reset.bin
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WARNING
If it does not work, try another USB flash-drive.

Details of the known issue: There are two formats of USB flash-drives (the first type uses MBR as a boot sector, the
second one is formatted as a floppy). Each format is eligible for different type of hardware device:

Kerio Operator Box 1210, 3210 and 3230 — if the USB flash-drive is formatted as a floppy. The second type
which uses MBR cannot connect to Kerio Operator Box.

Kerio Operator Box 1220 — if the USB flash-drive uses MBR as a boot record, you can use it directly. The second
type which is formatted as a floppy cannot connect to Kerio Operator Box. If you want to use it, format the USB flash-
drive according to the following steps: Formatting USB flash-drive with MBR.

5.3.6 Recovering your Kerio Operator BoxV series password using a USB flash drive

You can recover your password for the administration interface with a USB flash drive.

You need a flash drive with the capacity of at least 256 MB.

The password recovery tool is designed for a single use so that the operation does not repeat if you restart with the flash
drive still in the USB port. You can remove the files from the flash drive after the upgrade.

Creating and using a password recovery tool

To recover a lost administration password:

1. Insert the flash drive into a USB port on your computer.

2. Make sure that only one partition with the FAT16or FAT32 (VFAT) file system is created on the flash drive. The USB
disk must not be formatted by the NTFS, ext2, ext3, or ext4 file systems.

3. Download and save the file kerio-operator-password-reset to the flash drive.

4. Switch off Kerio Operator.

5. Plug the USB flash drive into a USB port of your Kerio Operator box.

6. Switch on Kerio Operator.

7. When the Kerio Operator Engine starts up, open the Kerio Operator administration interface in a browser. The activ-
ation wizard opens.

8. In the activation wizard, create a new password for the admin account.

Related articles

Formore information, refer to Restoring the Kerio Operator Box V series default configuration using a USB flash
drive (page 317).

http://download.kerio.com/dwn/kerio-operator-password-reset.bin
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6Glossary

A

Analog telephone adapter
A device for connecting analog devices to a digital or voice over IP network.

ATA
Analog telephone adapter - A device for connecting analog devices to a digital or voice over IP network.

B

Basic Rate Interface
An ISDN channel intended for small systemswhich achieves up to 128kbps data rate.

BLF
Busy Lamp Field - A set of indicators that monitor the current state (online, offline, busy, on a call) of a
phone extension.

BRI
Basic Rate Interface - An ISDN channel meant for small enterprise systems to obtain upto 128kbps data
rate.

BusyLampField
A set of indicators that monitor the current state (online, offline, busy, on a call) of a phone extension.

C

Cacti
Monitoring tool based on SNMP.

call routing
A process for routing of incoming and outgoing calls between internal extensions, PBX, and for example
PSTN.

Caller ID
A service that provides information about caller's number.

Clickto dial
An action that requests a real time connection via phone call.

Codecs
Programs used in streaming media and audio/video conferencing that encodes or decodes digital data
streams and signals.

CPE
Customer-premises equipment - Provider's devices that are physically located on the customer's premises.
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CRM
Customer Relationship Management - Strategies and technologies for managing and analyzing customer
relationships.

Customer-premisesequipment
Provider's devices that are physically located on the customer's premises and are connected to a tele-
communication channel of the provider.

CustomerRelationshipManagement
Strategies and technologies for managing and analyzing customer relationships.

D

DECT
Digital Enhanced Cordless Telecommunications - Cordless telephone systems.

DHCP
Dynamic Host Configuration Protocol - A protocol that automatically gives IP addresses and additional
configuration to hosts in a network.

Digital EnhancedCordlessTelecommunications
Cordless telephone systems.

DTMF
Dual-tone multi-frequency signal - Tone generated by the telephone or fax device when dialling while
communicating with the telephone line provider.

Dual Tone -Multi Frequency
The tone generated by the telephone (or fax) device when dialling. This is used for communicating with
the telephone line provider.

Dynamic Host Configuration Protocol
A protocol that automatically gives IP addresses and additional configuration to hosts in a network.

E

Euro-ISDN
An Integrated Services Digital Network (ISDN) standards as developed by European Telecommunications
Standards Institute (ETSI).

F

File TransferProtocol
A protocol for tranferring computer files from a server.

FTP
File Transfer Protocol - A protocol for tranfering computer files from a server.
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H

hardware appliance
Kerio Operator installed and delivered with standardized and tested hardware box.

I

Internet telephonyservice provider
A type of a service provider that provides communication via Internet. The communication is based on
Voice over Internet Protocol (VoIP).

IPPBX
A Private Branch Exchange system that connects telephone extensions through internet and provides
additional audio and video communication features.

ISDN
Integrated services digital network - A technology enabling digital transmission of data and voice signals
over a telephone network.

ITSP
Internet telephony service provider - A type of a service provider that provides communication based on
Voice over Internet Protocol (VoIP).

K

Kerio OperatorApp forSalesforce
An application based on Call Center that integrates Kerio Operator and Salesforce.

Kerio OperatorSoftphone
A softphone app for Android or iOS.

Kerio Phone
A softphone available as a native desktop or web-based application.

L

LDAP
Lightweight Directory Access Protocol enables users to access centrallymanaged contacts.

Lightweight DirectoryAccessProtocol
Lightweight Directory Access Protocol enables users to access centrallymanaged contacts.

M

MasterBoot Record
A type of a boot sector.
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MBR
Master Boot Record - A type of a boot sector.

MyKerio
A web-based application for monitoring and managing appliances of Kerio products.

N

NAT
Network address translation - A method that remaps IP addresses by changing network address inform-
ation.

Networkaddress translation
A method that remaps IP addresses by changing network address information.

P

PBX
Private Branch Exchange - System that connects telephone extensions and switches calls.

prefix
Country codes, area codes, a number, or a set of numbers that are dialed before the telephone numbers.

PRI
Primary Rate Interface - An Integrated Services Digital Network channel for large enterprise systems to
obtain higher speed than Basic Rate Interface.

PrimaryRate Interface
An ISDN channel meant for large enterprise systems to obtain higher data transfer rate than Basic Rate
Interface.

PSTN
Public switched telephone network - A global telecommunications network that operates the traditional
telephony system.

Public switched telephonenetwork
A global telecommunications network that operates the traditional telephony system.

Q

QoS
Quality of service - Network's ability to obtain maximum bandwidth and manage other network per-
formance elements like latency, error rate and uptime.

S

Secure SocketsLayer
A protocol that ensures integral and secure communication between networks.
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Service record
Service record is a record in DNS that specifies the location of server for individual services.

Session Initiation Protocol
A communication protocol used for voice and video calls in Internet telephony or private IP telephone
systems.

SimpleNetworkManagement Protocol
A protocol for gathering and organizing information about devices in IP networks, and changing devices
behavior.

SIP
Session Initiation Protocol - A communication protocol used for voice and video calls in Internet tele-
phony or private IP telephone systems.

SIP interface
An external interface used for connecting to SIP providers.

SIPpassword
A password for authenticating provided by a SIP provider.

SIPProvider
A telecommunications company that provide telephony services based on Voice over Internet Protocol.

SIPtrunk
Wide range of external numbers provided by a SIP provider.

SIPusername
An username for authenticating provided by a SIP provider.

SMTP
Simple Mail Transport Protocol - An internet standard used for email transmission across IP networks.

SNMP
Simple Network Management Protocol - A protocol for gathering and organizing information about
devices in IP networks, and changing devices behavior.

SoftwareAppliance
A special operating system designed to be installed on a computer.

SRVrecord
Service record is a record in DNS that specifies the location of server for individual services.

SSL
Secure Sockets Layer - A protocol that ensures integral and secure communication between networks.



KerioOperator 6Glossary |331

T

Telecommunicationsservice provider
A type of a service provider that provides telephone and other services.

TFTP
Trivial File Transfer Protocol - A simple protocol for transferring files.

Trivial File TransferProtocol
A simple protocol for transferring files.

TSP
Telecommunications service provider - A type of a service provider that provides telephone and other ser-
vices.

U

UDP
User Datagram Protocol - Ensures packet transmission.

URL
The Uniform Resource Locator is the address of a web page on the world wide web.

UserDatagramProtocol
Ensures packet transmission.

V

Virtual Appliance
Pre-configured Kerio Operator virtual machine image for VMware.

Voice over Internet protocol
A digital telephone system that uses the internet as the transmission medium, rather than the PSTN.

VoIP
Voice over Internet protocol - A digital telephone system that uses the internet as the transmission
medium, rather than the PSTN.

VoIPPhone
A device that works on principles of VoIP.

W

webRTC
Set of communication protocols enabling real-time communication over peer-to-peer connections.
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7 Legal Notices

7.1 Trademarks and registered trademarks
Aastra® is registered trademark of Aastra Technologies Limited.

Active Directory® is registered trademark of Microsoft Corporation.

Cisco® and Linksys® are registered trademarks of Cisco Systems, Inc.

Digium® is registered trademark of Digium, Inc.

Firefox® is registered trademark of Mozilla Foundation.

Grandstream® is a registered trademark of GrandstreamNetworks, Inc.

Internet Explorer® is registered trademark of Microsoft Corporation.

Polycom® is registered trademark of Polycom, Inc.

Safari™ is registered trademark of Apple Inc.

Salesforce® and Salesforce.com® are registered trademarks of salesforce.com, Inc.

SJphone® is registered trademark of SJ Labs, Inc.

snom® is registered trademark of snom technology AG.

snom® is registered trademark of snom technology AG.

Wireshark® is registered trademark of Wireshark Foundation.

X-Lite is a software phone developed by CounterPath Corporation with registered trademark of CounterPath®.

7.2 Used open source software
This product contains the following open-source libraries:

adapter.js

Shim to insulate apps from spec changes and prefix differences.

Copyright (c) 2014, The WebRTC project authors. All rights reserved.

Appliance OS Sources

Kerio Operator devices are based on open software from various resources. For detailed information on conditions of
each particular software used in the product, refer to acknowledgments.

To download the source package, go to http://download.kerio.com/archive/.

asterisk

Asterisk - An open source telephony toolkit.

Copyright © 1999 - 2012 Digium, Inc. and others.

http://download.kerio.com/archive/
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AudioContext-Polyfill

Polyfill for AudioContext and its parties on Web Audio API.

Copyright © 2013 - 2014 Shinnosuke Watanabe

coturn

coturn TURN server project

Copyright © 2011, 2012, 2013 Citrix Systems

Heimdal Kerberos

Heimdal is an implementation of Kerberos 5, largely written in Sweden. It is freely available under a three clause BSD style
license (but note that the tar balls include parts of Eric Young's libdes, which has a different license). Other free
implementations include the one fromMIT, and Shishi. AlsoMicrosoft Windows and Sun's Java come with
implementations of Kerberos.

Copyright © 1997-2000 Kungliga Tekniska Hogskolan (Royal Institute of Technology, Stockholm, Sweden). All rights
reserved.

Copyright © 1995-1997 Eric Young. All rights reserved.

Copyright © 1990 by the Massachusetts Institute of Technology

Copyright © 1988, 1990, 1993 The Regents of the University of California. All rights reserved.

Copyright © 1992 Simmule Turner and Rich Salz. All rights reserved.

jsonrpccpp

C++ framework for json-rpc (json remote procedure call)

Copyright © 2011-2014 Peter Spiess-Knafl

Kerio Asterisk Module

The Kerio Asterisk Module extends the functionality of the Asterisk PBX tomatch Kerio Operator needs. It is distributed
and licensed under GNU General Public License version 2. The complete source code is available at:

http://download.kerio.com/archive/

Copyright © 2010 Kerio Technologies s.r.o

© Copyright 2000-2006 T.I.P Group S.A. and the IBPP Team (www.ibpp.org).

libcurl

Libcurl is a free and easy-to-use client-side URL transfer library. This library supports the following protocols: FTP, FTPS,
HTTP, HTTPS, GOPHER, TELNET, DICT, FILE and LDAP.

Copyright © 1996-2008, Daniel Stenberg.

libiconv

Libiconv converts from one character encoding to another through Unicode conversion.

Copyright © 1999-2003 Free Software Foundation, Inc.

Author: Bruno Haible

Homepage: http://www.gnu.org/software/libiconv/

http://download.kerio.com/archive/
http://www.gnu.org/software/libiconv/
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The libiconv library is distributed and licensed under GNU Lesser General Public License version 3.

Kerio Operator includes a customized version of this library. Complete source codes of the customized version of libiconv
library are available at:

http://download.kerio.com/archive/

libmbfl

libmbfl is a streamable multibyte character code filter and converter library. The libmbfl library is distributed under LGPL
license version 2.

Copyright © 1998-2002 HappySize, Inc. All rights reserved.

The library is available for download at:

http://download.kerio.com/archive/

libopus

Opus is a high-quality audio codec developed in cooperation among Xiph.org, Broadcom, and Microsoft (Skype). The
codec is standardized in RFC 6716. The reference implementation of the codec is licensed under a 3-clause BSD-style
license. The copyright and patent licenses for the Opus algorithm are automatically granted to everyone and do not
require application or approval. The patent licenses are included below together with the BSD-style license.

Copyright © 2011-2014 Opus contributors

libxml2

XML parser and toolkit.

Copyright © 1998-2003 Daniel Veillard. All Rights Reserved.

Copyright © 2000 Bjorn Reese and Daniel Veillard.

Copyright © 2000 Gary Pennington and Daniel Veillard

Copyright © 1998 Bjorn Reese and Daniel Stenberg.

nginx-nchan

Fast, horizontally scalable, multiprocess pub/sub queuing server and proxy for HTTP, long-polling, Websockets and
EventSource (SSE), powered by Nginx. https://nchan.slact.net/

Written by Leo Ponomarev (slact) 2009-2015.

nginx-upload-module

A module for nginx web server for handling file uploads using multipart/form-data encoding (RFC 1867).
http://www.grid.net.ru/nginx/upload.en.html

Copyright © 2006, 2008, Valery Kholodkov

OpenLDAP

Freely distributable LDAP (Lightweight Directory Access Protocol) implementation.

Copyright © 1998-2007 The OpenLDAP Foundation

Copyright © 1999, Juan C. Gomez, All rights reserved

Copyright © 2001 Computing Research Labs, New Mexico State University

http://download.kerio.com/archive/
http://download.kerio.com/archive/
https://nchan.slact.net/
http://www.grid.net.ru/nginx/upload.en.html
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Portions Copyright © 1999, 2000 Novell, Inc. All Rights Reserved

Portions Copyright © PADL Software Pty Ltd. 1999

Portions Copyright © 1990, 1991, 1993, 1994, 1995, 1996 Regents of the University of Michigan

Portions Copyright © The Internet Society (1997)

Portions Copyright © 1998-2003 Kurt D. Zeilenga

Portions Copyright © 1998 A. Hartgers

Portions Copyright © 1999 Lars Uffmann

Portions Copyright © 2003 IBM Corporation

Portions Copyright © 2004 Hewlett-Packard Company

Portions Copyright © 2004 Howard Chu, Symas Corp.

OpenSSL

An implementation of Secure Sockets Layer (SSL v2/v3) and Transport Layer Security (TLS v1) protocol.

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/).

This product includes cryptographic software written by Eric Young.

This product includes cryptographic software written by TimHudson.

PHP

PHP is a widely-used scripting language that is especially suited for Web development and can be embedded into
HTML.

Copyright © 1999-2006 The PHP Group. All rights reserved.

This product includes PHP software, freely available from http://www.php.net/software/

php-ev

ev provides interface to libev library - high performance full-featured event loop written in C.

Copyright © 2012,2013,2014 Ruslan Osmanov <osmanov@php.net>

PHP-JWT

A simple library to encode and decode JSON Web Tokens (JWT) in PHP, conforming to RFC 7519.

Copyright © 2011, Neuman Vong

pjproject

Asterisk fork of PJSIP

Copyright © 2003-2008 Benny Prijono <benny@prijono.org>

Copyright © 2008-2011 Teluu Inc. (http://www.teluu.com)

ScoopyNG

This product includes software developed by Tobias Klein.

Copyright © 2008, Tobias Klein. All rights reserved.

http://www.openssl.org/
http://www.php.net/software/
http://www.teluu.com/
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SIP.js

A simple, intuitive, and powerful JavaScript signaling library http://sipjs.com

Copyright © 2014 Junction Networks, Inc. http://www.onsip.com

tftpd

TFTP daemon. TFTP is a simple protocol used for file transmission.

Copyright © 1983 Regents of the University of California. All rights reserved.

uwsgi

uWSGI application server container http://projects.unbit.it/uwsgi

Copyright © 2009-2014 Unbit S.a.s. <info@unbit.it>

WAVPlayerProject

WAV player.

Denis KolyakoMay 28, 2007, see http://etcs.ru/copyright/

zlib

General-purpose library for data compressing and decompressing.

Copyright © 1995-2005 Jean-Loup Gailly and Mark Adler.

http://sipjs.com/
http://www.onsip.com/
http://projects.unbit.it/uwsgi
http://etcs.ru/copyright/
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